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For information about the 
Zuelke Automated Credit 
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Note

Customer Support 
does not provide 
assistance on your 
backup procedures.
OrthoTrac Practice Management Software

troduction

thoTrac, a Sensei product, uses the Microsoft Windows 
erating system. See the OrthoTrac online help for more 
ormation. 

re-Training Contact Information

 you prepare to use the software, you will work with our trainers 
d members of the Implementations, Conversions, 
nfigurations, and Electronic Services teams.

plementations

member of the Implementations team will call you to schedule 
d then confirm training dates and times and to provide the 
rdware requirements and an overview of the installation. He or 
e will also interview you in preparation for training.

ectronic Data Conversion

ou transfer data electronically, a member of the Conversions 
m will help you with the following things:

• Submit data for a test conversion.

• Answer questions about how you use your software.

• Install a test conversion.

• Sign a document stating that you are aware of what will 
be converted.

• Submit data for a final conversion at least four days prior 
to the start of training.

Configurations

A member of the Configurations team will c
customize your software by having you com
worksheets and by setting up your procedu
schedule.

Electronic Services

A member of the Electronic Services team 
up services to submit claims and statemen
send credit card transmissions.

Training

Your trainer will review the training agenda
you on the software.

Backing Up Data

For OrthoTrac users, back up your data ev
have a backup for each day of the week, w
off-site. Keep your backups in a fire-resista

For OrthoTrac Hosted users, your data is ba
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OrthoTrac Practice Management Software

sson 1
nderstanding the Software

is lesson includes:

• Using the Main Menu 

• Using the Lookup Window 

• Using the Patient Chart 

 open the OrthoTrac software:

On your desktop, double-click the OrthoTrac Software icon. 
When the software opens, the main menu and the Staff Login 
window are displayed. 

Note:  If you have more than one data set, the Select Data 
Set window is displayed first. Select a data set and 
click OK.

The main menu and the Staff Login window are displayed.

Select your name from the User Name list, or enter your user 
ID, and type your password in the Password field.

3 Click OK. If you have a To Do list or sta
are displayed.

4 Click Close. The main menu is display

To close the OrthoTrac software:

1 Close any open windows in the softwa

2 Click the close button in the upper-righ
menu.

Using the Main Menu

After opening the OrthoTrac software, the m
across the top of your screen. When you h
name of the feature is displayed.  

Table 1 on page 2 shows the main menu b



ows the menu bar options:

Backup
 Extraction
etup

nables you to access the same features
n using the main menu buttons.

bles you to access the reports available in
categories:

ible Party
e
l
neous

racking
low

tabase Files—When prompted to exit the
 after making a change, select Copy

INK Launch Virtual
Agent

f Login Personal To Do Items

 Buttons  (Continued)
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The following list sh

• File

• Prepare 
• Satellite
• Printer S
• Exit

• Functions—E
available whe

• Reports—Ena
the following 

• Patient
• Respons
• Schedul
• Financia
• Miscella
• Charting
• Patient T
• Patient F

• Options

• Copy Da
software

Table 1 Main Menu Buttons 

Open Patient Chart Quick Add

Schedule 
Appointment

Patient Checkout

Financial Functions Insurance Functions

Word Processing Collections Activity

Contact Experts Referrals

Patient Flow Office Expert

Maintenance/Set-up Roladdress

Checklist Timeclock

Note

Some of these features 
are also accessed with 
the function buttons.

TeleVox T.L

Staf

Staff Mail

Table 1 Main Menu
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 comma, and then the 
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 for John Smith, type 

Open Patient Chart
OrthoTrac Practice Management Software

Database Files to update the information for that 
computer.

• Environment—Enables you to configure a single 
workstation for multiple databases, set paths for 
folders, and select settings for several areas of the 
software.

• Charts—Select from a list of all charts currently open. 
Close All—Enables you to close all open charts.

• Help

• OrthoTrac Help—Accesses the online help.

• What’s New Video–Enables you to view a video of 
new features to the software.

• Carestream Dental Institute–Accesses the online 
training website, which offers courses for the 
software.

• Contact Us–Accesses the Carestream Dental 
website, which provides ways for you to contact us.

• OrthoTrac on the Web—Accesses the OrthoTrac 
software website.

• System Requirements on the Web—Accesses the 
system requirements for the OrthoTrac software.

• Install Adobe Reader–Installs the Adobe software 
so you can read the online documentation.

• Launch Virtual Agent–Accesses Cassidy, 
OrthoTrac's virtual agent, for answers to your 
Support questions.

• About OrthoTrac—Enables you to access your 
software version number and important system data.

Using the Lookup Window

The lookup window enables you to sort thr
doctors, and so on. The following OrthoTra
window shows the basic functions of the lo

To access the OrthoTrac Patient Lookup w
Patient Chart button on the main menu.

Accessing Records

You can access records using search meth

Search by First or Last Name

Type a full or partial first or last name in the
the name, and click OK. 

Search by Partial Last Name/Partial Firs

Type the first few letters of the last name, a
first few letters of the first name in the sear
name, and click OK. For example, to search
“Sm, Jo.” 



nt Chart 

ient chart from the following areas: 

a patient using the OrthoTrac Patient 
ow

a new patient

ient Flow module

rting module

y schedule

ct expert report
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Search by Combined Middle Name/Last Name

To differentiate between patients with the same first and last 
name, you can configure the software to list a patient’s middle 
name or middle initial before the last name in lists. 

Search by Patient or Responsible Party

Type a patient’s or the responsible party’s first, middle, last, or 
common name; account #; phone #; e-mail address; insured ID; 
or Social Security number. Highlight the name and click OK.

Adding and Removing Records

To add a record from the lookup window, click Add New. 

To remove a record from the lookup window, select the record, 
click the red X, and provide a reason for removing the record. Then 
click OK and Yes.

Printing Labels

To print an individual mailing label, chart label, or appointment 
label using a stand-alone label maker:

1 In the lookup window, select the name for which you want to 
print a label and click Print Label. The Individual Label 
window is displayed.

2 Select the type of label to print.

3 Make changes to the appearance of the label, if necessary, by 
selecting from the drop-down lists in the Font and Size fields 
and by clicking the Bold, Italic, and Underline buttons.

4 Select an option from the drop-down list in the Selected 
Printer field, or click Setup to display the Print Setup window 
and change the options for the printer.

5 Click OK.

Using the Patie

You can access a pat

• After finding 
Lookup wind

• After adding 

• From the Pat

• From the Cha

• From the dail

• From a conta
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Table 2 shows the patient chart buttons.

Table 2 Patient Chart Buttons 

Patient Information Schedule Appointment

Financial Functions Claims

Word Processing
 
Snapshot

Charting Patient Tracking

Database Fields Orthodontic Imaging

Patient Checkout OrthoTrac

Patient Lookup



ndor to the Roladdress

odontic supply company gives you a 
o you save the information in the software?

oladdress:

ess button on the main menu. The 
ow is displayed. 

he Roladdress Card window is displayed.

t the bottom of the window.

, type the name of the business.

ld, double-click on <Add Address>. The 
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6 of 6  OrthoTrac Practice Management Software Initial Training Workbook (OR250-15)

Skill Sharpeners

Exercise 1—Verify an Appointment Time

A patient’s mother calls the office and tells you that her daughter 
has a scheduled appointment sometime next week, but she has 
misplaced the appointment ticket. How can you help her?

To find a patient’s scheduled appointment:

1 On the main menu, click the Open Patient Chart button. The 
OrthoTrac Patient Lookup window is displayed.

2 Type the patient’s name and highlight it. 

3 Click View Appointment. The Appointments window is 
displayed, showing current appointment information for the 
patient.

Exercise 2—Find the Last Patient Viewed

You are working in a patient chart and have to take a phone call to 
schedule an appointment. After finishing the call, you attempt to 
return to the patient chart you were working in, but you realize that 
instead of minimizing the patient chart window for the first patient, 
you closed it. Now you can’t remember the name of the patient 
whose chart you were working in. What can you do?

To view a list of the last five patient records you worked with:

1 From the main menu, click the Open Patient Chart button 
and click Recent Patients.

2 Click the name of the patient whose file you want.

Exercise 3—Add a Ve

A sales rep for an orth
business card. How d

To add a card to the r

1 Click the Roladdr
Roladdress wind

2 Click Add New. T

3 Click Business a

4 In the Name field

5 In the Address fie
Edit Address win

6 Type the address

7 In the Phones fie
Number>. The A

8 Type the phone in

9 In the Comment f
Add Comment w

10 Type a comment 

11 Click OK.

Tip

To add multiple 
comments to a 
roladdress card, 
double-click the text 
in the Comment field 
and click Add. Type 
additional comments 
and click OK.
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You cannot delete a 
carrier to which a 
patient or responsible 
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attached.
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sson 2
sing Maintenance Functions

is lesson includes:

• Adding New Carriers 

• Setting Up Carrier Coverage 

• Adding Employers 

• Setting Up the Financial Estimator 

• Adding Outside Doctors 

• Setting Up Patient Flow Options 

• Adding Calendar Days Using Schedule Maintenance 

dding New Carriers

ring the conversion process, you might need to verify or add 
rrier information. As you add new patients, you add insurance 
rriers and employers. Use the carrier maintenance function to 
d, update, and delete carriers. 

 add a carrier: 

Click the Maintenance/Set-up button and select Carrier 
Maintenance. The OrthoTrac Carrier Lookup window is 
displayed. 

Click Add New. The Carrier Maintenance window is 
displayed. 

The Carrier Maintenance window has 

• Carrier Information
• Employer Information
• Claim Information
• Comments



ormation

ion:

 the mouse to position the cursor in the 
ld and select Manual or Electronic. 

 type the five-digit ID number found in the 
yer field is inactive if you are submitting claim 
the carrier.

ice field, type NOCD, unless different in the 
aims Office field is inactive if you are 
orms manually to the carrier.

Auth field, select Yes or No.

n of Treatment field, select an option from 
t. The default is Range, but you can select 
 options:

r does not require continuation of treatment 

onth—Carrier accepts the last day of the 

e—Carrier requires the date of banding.

er accepts the date you select or the first 
nth.

rrier requires the date on which the patient is 
ffice.

 field, select an option from the drop-down 
cy field indicates how often an insurance 
continuation of treatment claim to be filed.
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Adding Insurance Carrier Information

To add carrier information:

1 Type the carrier’s information in the appropriate fields.

If the carrier already exists, click Import Carrier Info to import 
the name, address, and phone number.

2 Select an option in the Release field.

3 Select an option in the Assign field to specify the assignment 
of benefits.

Adding Employer Information

To add employer information:

1 Press Tab or click in the Employer field. Press Enter or 
double-click in the field to display the OrthoTrac Employer 
Lookup window.

2 Type the employer name and press Enter. If the employer is 
already in the list, the name is selected. Click OK to attach the 
employer to the carrier. 

Note:  Click Change to edit the data for an employer. If the 
employer is not in the list, click Add New.

3 In the Deductible field, type the amount the patient must pay.

4 In the Max Amount field, type the dollar amount of the 
patient’s maximum benefit (yearly or lifetime) minus the 
deductible.

5 In the Group ID field, type the unique identification number for 
the insurance carrier/employer.

6 In the Percent field, type the percentage that the carrier pays.

7 In the Maximum Age field, type the maximum age of a patient 
for whom the insurance provides orthodontic benefits. 

Adding Claim Inf

To add claim informat

1 Press Tab or use
Process Claim fie

2 In the Payer field,
Payer List. The Pa
forms manually to 

3 In the Claims Off
Payer List. The Cl
submitting claim f

4 In the Allow Pre-

5 In the Continuatio
the drop-down lis
from the following

• None—Carrie
claims.

• Last Day of M
month.

• Banding Dat

• Range—Carri
day of the mo

• Specific—Ca
seen in the o

6 In the Frequency
list. The Frequen
carrier requires a 

Tip

Be consistent when 
entering the insurance 
company name. 
Different spellings can 
result in problems 
when you use the bulk 
payment feature.
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then make a global 
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do not apply to carriers 
you have locked.
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7 In the Cont Tx Override field, type the continuation of 
treatment code for carriers that require a different code from 
the ADA continuation of treatment code; otherwise, leave this 
field blank. 

8 In the Combine Description of Services field, select Yes to 
combine monthly amounts within a billing period into one date 
of service entry or No to itemize each month within the billing 
period.

9 To add additional reference information about a carrier, use 
the Comments field.

10 Click OK. 

Setting Up Carrier Coverage

After you have added a new insurance carrier, you can set up the 
amount of coverage the carrier pays for each procedure. Charges 
are attached to your procedure codes, and you can enter the total 
amount the carrier pays and the amount for which the patient is 
responsible.

To enter carrier coverage:

1 In the OrthoTrac Carrier Lookup window, select the carrier 
and click Change. The Carrier Maintenance window is 
displayed.

2 Click Coverage. 

The Insurance Coverage window is di

3 Click the Lock icon in the right corner o
status of the carrier to Locked or Unlo

4 Select the coverage type for the carrie
following options:

• Variable—The carrier pays differen
different procedures; for example, 
80% for exams, 50% for treatmen

• Fixed—The carrier pays the same p
procedures; for example, 50%. If y
the percentage amount, and the so
amount to all procedures.

5 Select the first procedure code that yo
carrier and type information in the follo

• ADA—The ADA code assigned to 

• Fee—The doctor’s charge, posted 
party’s ledger.



 Financial Estimator

ntract proposals to responsible parties, you 
cial Estimator. To set up the estimator:

ance/Setup icon and select Financial 
nance. The Financial Estimator 
dow is displayed. 

sh Discount and the Preferred Down 
l fields, click Change and enter the amounts.

M
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• Ins—The amount printed on the insurance claim, which is 
the maximum amount the carrier pays. This amount can 
never be more than the doctor’s fee.

• Coverage—The percentage of the charge the carrier 
actually pays. If you selected Fixed and typed a 
percentage, the Coverage column is automatically 
populated and cannot be changed.

6 Click OK.

Adding Employers

In the OrthoTrac software, you typically link employers with 
insurance carriers. If you are adding carriers and employers, you 
can perform both operations from the Carrier Maintenance 
window. However, if you need to add only an employer or make a 
change to an employer’s demographic information, you can use 
the employer maintenance function. 

To add an employer:

1 Click the Maintenance/Set-up button and select Employer 
Maintenance. The OrthoTrac Employer Lookup window is 
displayed.

2 Click Add New. The Add New Employer window is displayed.

3 In the Employer field, type the employer name.

4 In the Phone field, double-click <Add New Phone Number> 
and type the employer’s phone information. Use the 
drop-down list to select WK Work. Click OK.

5 In the Address field, double-click <Add Address> and type 
the employer’s address information. Click OK.

6 Click OK.

Setting Up the

Before you present co
must set up the Finan

1 Click the Mainten
Estimator Mainte
Maintenance win

2 To change the Ca
Payment % Tota

3 Click OK.

Note

To change employer 
information, select the 
employer in the 
OrthoTrac Employer 
Lookup window, click 
Change, make your 
changes, and click OK.

aintenance/Set-up
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Note
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Referral Lookup 
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Adding Referral Sources

Use the other referral sources function to track referrals from 
outside of your practice, as well as business generated by the 
telephone directory, a website, a street sign, and so on. 

To add referral sources:

1 Click the Maintenance/Set-up button and select Other 
Referral Sources. The OrthoTrac Other Referral Lookup 
window is displayed.

2 Click Add New. The Other Referral Sources window is 
displayed.

3 From the Referral Type options, select Individual for a person 
or Business for a source such as the Internet or phone book.

4 In the Salutation field, use the drop-down list to select a 
salutation.

5 Double-click in the Name field and type the referral’s name. 

6 In the Address field, double-click <Add Address> and type 
the referral’s address. 

7 In the Phone field, double-click <Add N
and type the referral phone information

8 In the Birthday field, type the birth date

9 In the Formal field, type the full first na
example, William.

10 In the Informal field, type the nickname
example, Bill.

11 Double-click in the Comment field and

12 Click OK.

Adding Outside Doctors

The outside doctor information function en
information for doctors with whom you hav
your practice. The software also uses this i
various letters and reports.

To add outside doctors:

1 Click the Maintenance/Set-up button 
Doctor Information. The OrthoTrac O
window is displayed.

2 Click Add New. 



formation section, complete the following 

ss
ted

 field, double-click <Add Comment> and 

ient Flow Options

 options, click Maintenance/Set-up and 
ow Options. 

ptions

options:

 Flow Options window. The Display Opts 
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The Outside Doctor Information window is displayed. 

3 In the General Information section, complete the following 
fields:

• Salutation
• Name
• Degree
• Specialty—This field is required.

4 In the Professional Information section, complete the 
following fields:

• Phone
• Hours
• Office Address
• Office Manager

5 In the Personal In
optional fields:

• Home Addre
• Year Gradua
• School
• Spouse
• Birthday

6 In the Comments
type a comment. 

7 Click OK.

Setting Up Pat

To set up Patient Flow
then select Patient Fl

Setting Display O

To set up the display 

1 Open the Patient
tab is displayed. 

Note

If a doctor has more 
than one office or if 
several doctors have 
the same last name, 
you must enter an 
identifier in the Name 
field.

Note

To change outside 
doctor information, 
select the doctor in the 
OrthoTrac Outside 
Doctor Lookup 
window, click Change, 
make your changes, 
and click OK.

Maintenance/Set-up
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if they have not 

 Large Pictures (x10) 
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Note

The patient display 
options lock patients 
out of all functions 
except checking in.

Note

The locations and 
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displayed across the 
top of the Patient Flow 
grid. 
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2 In the Select display type and background image section, 
select from the following options:

• Staff - Photographic Display—To check in and move 
patients, click-and-drag the patient’s picture to the 
appropriate location.

• Staff - Text-Based Display—To check in and move 
patients, click-and-drag the patient’s name to the 
appropriate location.

• Patient - Photographic—When patients check 
themselves in on the lobby computer, they select their 
picture.

• Patient - Non-Photographic—When patients check 
themselves in on the lobby computer, they select the 
letter that corresponds to their last name on the letter 
keypad and then select from the list of names.

• Patient - Name Entry—When patients check themselves 
in on the lobby computer, they type their names on the 
letter keypad or in the Enter your last name field, and 
then click Sign In.

3 Click Choose Background and navigate to the folder 
containing the background you want to be displayed on the 
lobby computer. You can change the dimensions and color of 
the background.

4 In the Refresh Display every field, select the number of 
seconds to refresh the display. The default setting is 30, but it 
is recommended that you set this field to 10.

5 In the Instructions sections, leave the default instructions or 
type new instructions to be displayed in the Check-In 
windows of the lobby computer.

6 In the Display Patients Starting from
want patients to be displayed in the Pa
Non-Photographic Check In window 
checked in.

7 In the Picture Size section, select Use
if you want large pictures to be display
Check In windows. 

8 Click OK.

Setting Location Options

To set up location options:

1 In the Patient Flow Options window, c

2 In the Locations/Colors section, selec
that you want to include in the grid. 

3 Use the drop-down arrows to select id
each location. 

4 Select the destinations you want to inc



-In Messages

g tab to set up the following types of 

rocedure

rid

w Options window, click the Grid Setup 

tient Flow Grid, you can click a column 
e the size and order of the column.

lds to Display section, select the fields you 
 the Patient Flow window.

rt Order, use the drop-down list to select 
sort the grid.

Not

It is 
that
sec
Ref
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5 In the Schedule Offices and Chairs section, select the 
offices you want to see in Patient Flow. Click the drop-down 
arrows to select the number of chairs in each office.

6 Click OK. 

Setting General Options

To set general options:

1 In the Patient Flow Options window, click the General Opts 
tab. 

2 Set the patient time constraints.

3 Set the office time constraints.

4 In the Warning information system section, set the method 
and parameters of warnings.

5 Set the remaining options.

6 Click OK.

Setting Up Check

Use the Check-In Ms
messages: 

• Financial
• Promise Due
• Scheduled P

Setting Up the G

To set up the grid:

1 In the Patient Flo
tab. 

2 In the Sample Pa
header and chang

3 In the Choose Fie
want to display in

4 In the Default So
how you want to 

e

recommended 
 you set 10 
onds as the 
resh time.

Note

Changes made on the 
Grid Setup tab are 
specific to each 
workstation.
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 Schedule 

enance window are 
chedule; however, you 
edule. 

ce/Set-up button and 
hedule Maintenance 

ays instruction 

layed.

Important
The Light Bar Opts tab 
is not available if you 
do not use the Charting 
module.

Note

Use the Welcome Scrn 
tab to type the greeting to 
patients on the Welcome 
Screen.

Important
Days must be added to 
the calendar before 
appointments can be 
scheduled on those 
days.
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5 In the Misc Options section, select the options you want.

6 To restore the default settings, click Restore to Defaults.

7 To change the font, style, and size, click Change Grid Font.

8 Click OK.

Setting Light Bar Options

To set Light Bar options:

1 In the Patient Flow Options window, click the Light Bar 
Opts tab.  

2 In the Light Bar Doctors section, add, change, and remove 
doctors. Double-click a doctor’s name to change it; 
double-click an assigned color to change it.

3 In the Chair Setup section, enter the amount of chairs to 
display on the Light Bar. Double-click a chair to change it. 

4 If you do not want to display the Light Bar, select the Do not 
display Light Bar on this workstation option.

5 Select an option to display patient names on the Light Bar.

6 Click OK.

Adding Calendar Days Using
Maintenance

Most of the settings in the Schedule Maint
made when you are initially setting up the s
can use this window to add days to the sch

To add days to the schedule:

1 On the main menu, click the Maintenan
select Schedule Maintenance. The Sc
window is displayed. 

2 Click Add Days. The Add Calendar D
window is displayed. 

3 Click the window. The calendar is disp



signments

ation of office, standard, and doctor for days 
 you attempt to change one of these options 
, a message is displayed, alerting you that 

the process.

lect a standard, office, and doctor for a 
y to select another doctor before clicking 
message is displayed.

:

change the doctor for the days you have 
 then click Assign.

eep your original selections and then click 
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4 Select an office, standard, and doctor using the drop-down 
lists at the top of the window.

You can assign only one combination of location, standard, 
and doctor at a time.

5 Select the days to which you want the standard to apply:

• To assign a standard to a calendar day, click the day. 
When a day is selected, it is highlighted in blue. 

• To assign a standard to multiple days, click the 
corresponding letter of the day at the top of the month. 
For example, to assign a specific standard to every 
Wednesday in a specific month, click W at the top of the 
month. 

• To assign a standard to a specific day for all months 
displayed in the Add Calendar Days window, click the 
corresponding button on the Quick Click Bar. For 
example, to assign a specific standard to all Fridays 
displayed in the window, click F on the Quick Click Bar. 

6 Click Assign.

7 Repeat this process until all calendar days are added.

Changing Day As

If you select a combin
on your schedule and
before clicking Assign
you did not complete 

For example, if you se
number of days and tr
Assign, the following 

You have two options

• Click Yes to 
selected and

• Click No to k
Assign.
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Skill Sharpeners

Exercise 1—Add a Referral Source

Your office has mailed out flyers promoting your practice and 
offering a free initial exam. How do you add the flyers as a referral 
source in the software so you can track the potential business the 
flyers generate?

To add a referral source:

1 Click the Maintenance/Set-up button and select Other 
Referral Sources. The OrthoTrac Other Referral Lookup 
window is displayed.

2 Click Add New. The Other Referral Sources window is 
displayed.

3 In the Referral Type section, click Business.

4 In the Company field, type Free Initial Exam Flyers or 
something similar.

5 In the Comment field, type any additional information; for 
example, the month the flyers were mailed.

6 Click OK. You can now select Free Initial Exam Flyers as a 
referral source when adding new patients or when running 
referral reports.

Exercise 2—Add an Insurance Carrier and
a Patient

You have added a patient who has an insur
in your database. You must add the carrier
attach the carrier to the patient. How do yo

In this example, assume that your office pro
manually.

To add an insurance carrier to the software
to a patient:

1 In the patient chart, click the Patient In
Patient Information window is display

2 Double-click the responsible party nam
bottom of the Patient Information win
Party Information window is displayed

3 Click in the Carrier field and click <Ad
Carrier Lookup window is displayed.

4 Click Add New. The Carrier Maintena
displayed.

5 In the Carrier Name field, type the nam
carrier. 

6 In the Address field, double-click <Ad
the Edit Address window and type the
claims should be sent.

7 In the Phone field, double-click <Add N
to display the Add Phone Number win
carrier phone number, extension, and t

8 In the Contact field, type the name of t
the insurance company.



on of Treatment field, select an option from 
t. When generating continuation of 
 the date for the Description of Service is 
s setting. 

m the following options:

r does not require continuation of treatment 

onth—Carrier accepts the last day of the 

e—Carrier requires the date of banding.

er accepts the date you select or the first 
nth. This is the default option.

rrier requires the date on which the patient is 
ffice.

 field, select an option from the drop-down 
w often an insurance carrier requires a 
atment claim to be filed. 

Override field for carriers that require their 
tinuation of treatment; otherwise, leave this 

 field, double-click <Add Comment> to 
omment window and type additional 
 a carrier, if necessary.

 the Carrier Maintenance window.

 the OrthoTrac Carrier Lookup window. 
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9 In the Release field, select either Signature on File or None 
to indicate whether authority was granted to release patient 
dental information to the insurance company.

10 In the Assign field, select an option to indicate the 
assignment of benefits.

11 In the Employer field, do the following: 

• Press Enter or double-click to display the OrthoTrac 
Employer Lookup window. 

• Type the employer name in the top field and press Enter. 

• If the employer is already in the list, the name is 
selected. Click OK to attach the employer to the 
carrier. 

• If the employer is not in the list, click Add New to 
display the Add New Employer window and 
complete the information.

12 In the Deductible field, enter the amount the patient must pay.

13 In the Max Amount field, enter the dollar amount of the 
patient’s maximum benefit (yearly or lifetime) minus the 
deductible. 

14 In the Group ID field, enter the unique identification number 
for this insurance carrier/employer. 

15 In the Percent field, enter the amount that the carrier pays; for 
example, 50%. 

16 In the Maximum Age field, enter the maximum age of a 
patient for whom the insurance provides orthodontic benefits. 

17 In the Continuati
the drop-down lis
treatment claims,
determined by thi

You can select fro

• None—Carrie
claims.

• Last Day of M
month.

• Banding Dat

• Range—Carri
day of the mo

• Specific—Ca
seen in the o

18 In the Frequency
list to indicate ho
continuation of tre

19 Use the Cont Tx 
own code for con
field blank. 

20 In the Comments
display the Add C
information about

21 Click OK to close

22 Click OK to close
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23 If the carrier you just added has assigned an Insured ID 
number to the patient, click in the Carrier field and select the 
name of the carrier. The Insurance Carrier window is 
displayed.

24 Type the Insured ID number in the field and click OK.

25 Click OK to close the Responsible Party Information 
window and add the carrier to the patient chart.

26 Click OK to close the Patient Information window.

27 Click the Patient Lookup button to close the patient chart 
and select another patient.
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sson 3 
dding Patients

is lesson includes:

• Adding New Patients 

• Using Quick Add 

dding New Patients

hen adding a new patient, add information about the patient and 
 responsible party, if the patient is not self-responsible. The 

lds displayed in red must be completed to add the record to the 
tabase. 

ding Patient Information

 add a patient:

Click the Open Patient Chart button. The OrthoTrac Patient 
Lookup window is displayed.

Search for the name of the person you want to add, in case he 
or she is already in the database. If you do not find the name 
using the lookup window, click Add New. The Patient Add 
window is displayed.

3 In the column on the left, complete as m
Press Tab to move from field to field. 

4 In the center column, use the drop-dow
fields. 

Depending on your office setup, some
active. You must complete the Locatio
fields, displayed in red.



dical alert and select whether you want to 
 the comment after opening the patient’s 
K to save the alert and close the window, or 
nter another medical alert. The comment is 

h a red background on the patient chart.

the drop-down list and select Add Family. 
c Relative Lookup window is displayed.

me of the relative you want to add and click 
Family Relationship window is displayed.

s from the drop-down lists to indicate how 
lated. Click OK.

 not on the list, click Add New. 
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5 In the column on the right, complete the following fields:

• Dentist—Type the name of the patient’s dentist in the 
Dentist field or use the drop-down list to select a name. 

When you press Tab to move to another field, the 
software asks if you want to assign the dentist as a 
referral source. If not, click Select Referrals. The Patient 
Referred by window is displayed.

When you select the referral source, a lookup window is 
displayed, which enables you to search for the name of 
the referral. Select the name of the referral source. If the 
name is not on the list, click Add New to add the name.

• Referral Date—Enter the referral date in mm/dd/yy format.

• Comments—Click <Add Comment>. The Add 
Comment window is displayed.

Enter your comment and select whether you want to 
acknowledge the comment after opening the patient’s 
chart. Click OK to save the comment, or click Add to 
enter another comment. The comment is displayed with a 
blue background on the patient chart.

• Medical Alert—Click <Add Medical Alert>. The Add 
Medical Alert window is displayed.

Enter the me
acknowledge
chart. Click O
click Add to e
displayed wit

• Family—Use 
The OrthoTra

Select the na
OK. The Set 

Select option
the two are re

OR

If the name is

Tip

When the referral is a 
sibling that is an 
existing patient, select 
Patient instead of 
Sibling. Then select 
the name from the 
patient record.
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The Add Relative window is displayed.

Complete the fields in the Add Relative window and click 
OK. The Set Family Relationship window is displayed.

Select options from the drop-down lists to indicate how 
the two are related. Click OK.

Using the Database Fields Function

The database fields function enables you to
information that is not already tracked by th
account balance, a hobby, the school atten
information, and so on. This information is r
experts. 

To add patient interests to the patient char

1 Click Database Fields. The Database
displayed.

2 Select the question type from the drop
Question field and press Tab. The Ans
active.

3 Use the drop-down list in the Answer 
answer, or select <Add New Option> 
The Add Options window is displayed

4 Type an answer in the field and click N
answers, or click OK to add the answe
window. 



and use the drop-down lists to select the 
 financial information for the responsible 

sponsible Party—Select this option if the 
 self-responsible. This fills in the patient 
 the responsible party fields.

ss—Deselect this option if the responsible 
ifferent address than the patient. 

ame—Deselect this option if the responsible 
ifferent last name. 

 Phone—Deselect this option if the 
arty has a different home phone number.

elect from a list of insurance carriers for the 
arty. If you enter more than one insurance 
Rank Ins. Co.> to designate a primary and 

mpany.
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5 Scroll to the bottom of the drop-down list to select the answer 
you just added and press Tab. The Date field is populated 
with the current date, and you can select a new question, if 
necessary.

6 Click OK.

Using the Clear Button

If you have entered patient information in error, click Clear to 
remove all of the information you have entered in the window.

Using the Family Tree Button

Click Family Tree to open the Show Family Tree window. This is 
a view-only window that enables you to see all of the family 
members you have associated with this patient.

Adding Responsible Party Information

When you add a new patient, you must add at least one 
responsible party. You can add multiple responsible parties, if 
necessary.

To add responsible party information:

1 After completing the Patient tab, click the Responsible Party 
1 tab or press Tab. The Patient Add— Responsible Party 1 
window is displayed.

2 Type information 
demographic and
party:

• Patient is Re
patient will be
information in

• Same Addre
party has a d

• Same Last N
party has a d

• Same Home
responsible p

• Insurance—S
responsible p
carrier, click <
secondary co
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Tip

Use the data in the 
center of the window 
and the bar graph at 
the bottom of the 
window to gauge how 
busy your office is on a 
particular day.

Quick Add
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3 If necessary, click the Responsible Party 2 tab to add a 
second responsible party. Select Options > Add Another 
Responsible Party Page to add up to two additional pages.

4 Click OK. If you have configured the software so you can 
assign patient numbers manually, the Next Patient Number 
window is displayed. Enter the next patient number and click 
OK. The patient chart is displayed.

If you have configured the software to assign a patient 
number automatically, the patient chart is displayed. 

Using Quick Add

The quick add feature is the most common method of adding a 
patient. Available on the main menu, quick add is typically used to 
set up appointments for new patients who are on the phone. 

The search method used by the quick add feature depends on the 
method you have selected to perform searches when scheduling. 

To add a patient using the quick add feature: 

1 On the main menu, click the Quick Add button. If you have 
more than one location, the Schedule Office window is 
displayed. 

2 Select the appropriate office location. The Appointment 
Search window is displayed.

3 Select an available appointment time fr
it once. 

4 Click one of the buttons at the bottom 

• Statistics
• View Day 
• Schedule
• Options

5 In the Patient Add window, type the p
pressing Tab to move from field to field
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6 Click OK. The Appointment Details window is displayed.

OR

If the OrthoTrac Patient Lookup window is displayed, type 
the name of the new patient to confirm that the patient is not 
already in the software. If the patient is not in the list, click Add 
New to display the Patient Add window and enter the patient 
information, pressing Tab to move from field to field.

Click OK. The Appointment Details window is displayed.

7 Click OK.
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Skill Sharpener

Exercise 1—Add a New Patient 

A new patient comes to your office. You want to create a record 
and add the necessary information about the patient.

To add a patient:

1 Click the Open Patient Chart button. The OrthoTrac Patient 
Lookup window is displayed.

2 Search for the name of the person you want to add, in case he 
or she is already in the database. If you do not find the name 
using the lookup window, click Add New. The Patient Add 
window is displayed. 

3 In the column on the left, complete as many patient 
demographic fields as you can. Press Tab to move from field 
to field. 

4 In the center column, use the drop-down lists to populate the 
fields. 

5 In the column on the right, complete the following fields:

• Dentist—Type the name or use the drop-down list to 
select a dentist’s name. 

• Referral Date—Enter the referral date in mm/dd/yy format.

• Comments—Click <Add Comment> or press Enter 
when <Add Comment> is selected. The Add Comment 
window is displayed.

• Medical Alert—Click <Add Medical Alert>. The Add 
Medical Alert window is displayed.

• Family—Use the drop-down list an
The OrthoTrac Relative Lookup w

• Select the name of the relative
click OK. The Set Family Rela
displayed.

• Select options from the drop-d
how the two are related. Click

OR

• If the name is not on the list, cl
Relative window is displayed.

• Complete the fields in the Add
click OK. The Set Family Rela
displayed.

• Select options from the drop-d
how the two are related. Click
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sson 4
hanging Patient Information

is lesson includes:

• Updating Patient Information 

• Ranking Responsible Parties 

• Adding Responsible Parties and Linking Relatives 

pdating Patient Information 

 access the Patient Information window, on the main menu, 
ck the Open Patient Chart button, or in a patient’s chart, click 
 Patient Information button. 

To add details to the Patient Information 

1 To update information, click in a field a
information or use a drop-down list to s

2 Use the Family Members panel at the
to:

• Add or delete responsible parties 

• View and update responsible party
information.

3 Click OK.

Ranking Responsible Parties

When you add a patient to the software, yo
responsible party for that patient, but you c
necessary. The software ranks the respons
that you enter them; for example, the first p
the second is 2, and so on. To change the 
parties, use the ranking feature.



ble Parties

party:

rt, click the Patient Information button to 
t Information window. 

 Member. The Add Family Member 
ed.

ble Party and click OK. The OrthoTrac 
ty Lookup window is displayed.

 the name you want to add and click OK. 

 in the list, click Add New. 

sible Party window is displayed. 
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To rank responsible parties:

1 In the patient chart, click the Patient Information button to 
display the Patient Information window. The Family 
Members section is displayed.

2 Click Edit Financial Ranking. The Edit Financial Ranking 
window is displayed.

3 Click a name and select from the drop-down list.

4 Click OK.

Adding Responsible Parties and Linking 
Relatives

If you need to add additional responsible parties to a patient chart, 
link family members, or add family members for reference or 
reporting purposes, click Add Family Member.

Adding Responsi

To add a responsible 

1 In the patient cha
display the Patien

2 Click Add Family
window is display

3 Select Responsi
Responsible Par

4 Search the list for

OR

If the name is not

The Add Respon
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If you need to add 
additional insurance 
companies to a patient 
chart or need to rank 
insurance companies, 
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<Rank Ins. Co.> from 
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5 Complete the information in the window. 

6 To enter a customized salutation, click Salutation. The 
Custom Salutations window is displayed. Enter a Formal 
and Informal salutation in the fields. Click OK.

7 Click OK. The Responsible Party Information window is 
displayed. 

8 Select the Relationship for the family member. The 
Financially Resp field defaults to No, as long as one 
responsible party is already financially responsible. 

Use the buttons at the bottom of the window to enter specific 
information for this responsible party.

9 Click OK.

Adding Relatives

To add a relative:

1 In the patient chart, click the Patient Information button to 
display the Patient Information window. 

2 Click Add Family Member. The Add Family Member 
window is displayed.

3 Select Relative and click OK. The Ort
Lookup window is displayed.

4 Search the list for the name you want t

OR

If the name is not in the list, click Add N
window is displayed.

5 Complete the fields in the window and
View/Change Relative window is disp



f referral and click OK. Depending on the 
u select, a lookup window is displayed, 
elect the referral source from the list. If the 
he list, you can add the referral. 

se Button

 edit the patient’s interests—for example, 
bbies—in the Database Fields area, click 
ase Fields section is displayed.
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6 Use the drop-down list in the Relationship field to select the 
relationship for this relative.

7 Click OK.

Viewing/Editing Responsible Party or Relative 
Information

To view or edit the personal information for a responsible party or 
relative:

1 Click the name of the person in the Family Members panel 
whose information you want to view.

2 Edit or view the information, and click OK.

Adding Referrals

The Patient Referrals window contains information about the 
patient’s doctor, the referring doctor, doctors to whom the patient 
has been referred, and patients that have been referred to your 
practice by the patient. 

To enter referral information for a patient:

1 Click Add Referral. The Patient Referral by window is 
displayed. 

2 Select the type o
type of referral yo
enabling you to s
referral is not on t

3 Click OK.

Using the Databa

If you need to view or
schools, sports, or ho
Add Field. The Datab

Note

Adding a family 
member using this 
method does not make 
the family member a 
patient, but adds him 
or her to the software 
for reference 
purposes.
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Skill Sharpeners

Exercise 1—Add a Family Member

You want to add information about a patient’s family member for 
reference purposes.

To add a family member:

1 In the patient’s chart, click the Patient Information button. 
The Patient Information window is displayed.

2 Click Add Family Member. The Add Family Member 
window is displayed.

3 Click Relative and OK. The OrthoTrac Family Lookup 
window is displayed.

4 Click Add New. The Add Relative window is displayed.

5 Type the name, address, zip code, and relationship and click 
OK.

6 Click OK.

Exercise 2—Add a Responsible Party

A patient’s mother, who has been the responsible party, calls your 
office to say that she will no longer be paying for her son’s 
treatment and that the child’s grandmother is taking over the 
payments. How do you add the patient’s grandmother as a 
responsible party? 

To add a responsible party to a patient record:

1 In the patient chart, click the Patient Information button. The 
Patient Information window is displayed.

2 Click Add Family Member. The Add Family Member 
window is displayed.

3 Select Responsible Party and click O
Responsible Party Lookup window is

4 Search the list for the name you want t
the name is not on the list, click Add N
Responsible Party window is displaye

5 Complete the information in the windo
Responsible Party Information windo

6 In the Relationship field, select the res
relationship to the patient. 

7 In the Send Letters field, select the typ
should be sent to this responsible part

8 In the Recv Stmt field, select Yes, so t
receives a statement.

9 In the Carrier field, select the responsi
carrier, if applicable.

10 In the Financial Resp field, select Yes

11 Complete the Risk Code, Late Chg, a
your office uses these features.

12 Use the buttons at the bottom of the w
additional information for this responsib

13 Click OK.
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Exercise 3—Change the Address of the Responsible Party 

A patient’s mother calls to tell you that she has had a change of 
address. The woman is the responsible party for her son, and the 
change of address affects her son as well. What do you need to 
do to update the responsible party information?

To change the information for a responsible party:

1 On the main menu, click the Open Patient Chart button. The 
OrthoTrac Patient Lookup window is displayed.

2 Type the patient’s name and click OK. The patient’s name is 
selected, and the chart is displayed.

3 In the Family Members panel at the bottom of the window, 
click the responsible party name. The Responsible Party 
Information window is displayed.

4 Double-click in the Address field. The Edit Address window 
is displayed, and the existing address information is selected. 

5 Type the new information and click OK. The Change Address 

message window is displayed.

6 Click Yes and OK.
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sson 5 
cheduling Appointments

is lesson includes:

• Scheduling Appointments from the Patient Chart 

• Scheduling Appointments from the Main Menu 

• Scheduling Sibling Appointments 

• Canceling Appointments 

• Changing Patient Appointments Using the Clipboard 

• Using Cut and Paste Scheduling 

• Scheduling Recalls 

• Using Scheduling Reports 

cheduling Appointments from the Patient 
hart

 schedule an appointment from a patient's chart:

Click the Open Patient Chart button. The OrthoTrac Patient 

Lookup window is displayed. 

Select a patient and click OK.

3 Click the Schedule Appointment butt
Summary window is displayed.



ppointments that are available eight weeks 

 appointments that are available ten weeks 

ment type or procedure code from the Find 
andard. A list of available appointment times 

ections, click Edit Settings. The Searching 
played.

 fields:

e dates
se times
ys
irs
 slots

hing. A list of available times is displayed 
ria. 
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4 Click Schedule Appointment. The View Schedule window 
is displayed. 

5 For practices with multiple locations, select the offices you 
want to display from the Schedule Offices standard.

6 Select the doctors who are available to see the patient from 
the Schedule Doctors standard.

7 To include all available appointment times in your search, skip 
to step #8. Otherwise, select one of the following time 
intervals from the Find Appointments standard:

• 4w—Display appointments that are available four weeks 
from now.

• 6w—Display appointments that are available six weeks 
from now.

• 8w—Display a
from now.

• 10w—Display
from now.

8 Select an appoint
Appointments st
is displayed.

9 To refine your sel
for window is dis

10 Select from these

• Search thes
• Between the
• On these da
• In these cha
• Search open

11 Click Start Searc
based on the crite
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12 Click an appointment time.

The appointment information is displayed, including the 
patient name, the date, time, chair, type, time units, and any 
associated comments. In this window, you can:

• Select the color of the appointment

• Select the procedures associated with the appointment

• Access the OrthoTrac Patient Lookup window

• View sibling appointments

Confirming Appointments

To confirm a patient appointment:

1 In a patient chart, select Functions > Schedule 
Appointment. The Appointment Summary view is 
displayed.

2 Click next to the appointment you want to confirm. The 
Confirm Appointment window is displayed.

3 After calling the patient to confirm the appointment, click 
<click to add note>. Type a comment in the window and 
press Enter. The Confirm Appointment window closes. 

4 If you need to change a confirmed app
unconfirmed, click next to the appointm
the Confirm Appointment window. De
Appointment as Confirmed.

Scheduling Appointments fro
Menu

To schedule an appointment from the main

1 Click the Schedule Appointment butt
Schedule window is displayed. 

2 You can use the panes to the left of th
appointment time based on specific cr
the following panes are available:

• Schedule Offices
• Schedule Doctors
• Find Appointments

OR

You can click a doctor's name on a sp
calendar and access the schedule boo
mode.

3 Click an appointment in the schedule b
Patient Lookup window is displayed. 

4 Select a patient and click OK. The app
displayed, including the name, date, tim
units, and any comments. 

In this window, you can:

• Select the color of the appointmen

• Select the procedures associated
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• Access the OrthoTrac Patient Lookup window

• View sibling appointments

5 Click OK. The appointment is scheduled.

Scheduling Sibling Appointments

To schedule an appointment for a sibling without opening the 
sibling’s chart:

1 Schedule an appointment for the first patient using the View  
or Zoom view.

2 While still in the Schedule window in the patient chart, click 
an appointment type or chair. The Appointment Details 
window is displayed.

3 Click Sibling. The Sibling Appointments window is 
displayed.

Note:  To use the Sibling button, siblings must first be linked 
in the Patient Info section of the patient chart.

4 Select the sibling and click OK. The sibling name is displayed 
in the Appointment Details window, along with the 
appointment type you selected.

5 Click OK.

Canceling Appointments

To cancel a patient appointment:

1 In the patient chart, click the Schedule Appointment button. 
The Appointment Summary window is displayed. 

2 In the Appointments section, click the red X next to the 
appointment you want to delete. The Cancel Appointment 
window is displayed.

3 Select an option 
appointment. 

4 Deselect Copy A

Changing Patie
Clipboard

To change a patient’s
appointment to the cli
appointments to the c

• In a patient c

• In the View o

To change a patient a
clipboard:

1 In the patient cha
Appointment Su

2 In the Appointme
appointment you 
window is display

chedule
ppointment
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If you have selected the Default Clipboard Open option in 
Schedule Maintenance, the Copy Appointment to 
Clipboard option is selected, and the appointment is placed 
on the clipboard, or you can select Copy Appointment to 
Clipboard. 

3 Select an option to identify why the change is being made and 
click OK. The Schedule Calendar is displayed. 

4 Click the name of the doctor and the date. The View or Zoom 
mode is displayed with the appointment information on the 
clipboard. 

5 Click-and-drag the appointment inform
clipboard to the new appointment time
Appointment Details window is displa

The Was option is automatically select
shows details of the original appointme

6 Click Paste. The appointment informat
the new appointment.   

7 Click OK.

To change an appointment from the View o

1 Click the Schedule Appointment butt
Schedule window is displayed. 

2 Select the location, doctor, and specifi
Zoom view of the day is displayed.

3 Find the appointment you want to chan
appointment to the clipboard. The app
changing is displayed in gray.
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4 Select the new day in the schedule. Click-and-drag the 
appointment from the clipboard into the new appointment 
time. The Appointment Details window is displayed. 

The Was option is automatically selected, and the window 
shows details of the original appointment. 

5 Select a reason to indicate why the appointment is being 
changed. 

6 Click Paste. The appointment information is transferred into 
the new appointment.   

If the appointment change is within the same day, you can drag 
the appointment directly from the current time into the new time 
and chair. 

Using Cut and Paste Scheduling

The Appointment Details window enables you to quickly transfer 
information from an existing appointment to the appointment you 
are scheduling by using a feature called cut-and-paste scheduling.

Information can be transferred from the patient’s last missed 
appointment, from the patient’s next Charting appointment, from 
the treatment plan, or when changing an appointment. 

Transferring Information from a Missed 
Appointment

To transfer information from a patient’s most recent missed 
appointment:

1 Click an appointment slot in the Schedule window in the View 
or Zoom mode. 

2 In the patient’s Appointment Details window, click Last. 

3 Click Paste. The 
new appointment

4 Make any change

5 Click OK.

Transferring Info

To transfer informatio
treatment card:

1 Click Schedule A
is displayed. 

2 Select an appoint
displayed, includi
units, and any com

3 Select the Charti
the details of the 
treatment card. 

4 Click Paste. The 
new appointment

5 Make any necess
information.

6 Click OK to sche
you would like to 
No if you would li
in Charting to vie

7 Click Close twice

Note

If the appointment type 
in the upper section of 
the Appointment 
Details window differs 
from the appointment 
type in the lower 
section, you must have 
Override Pre-Block 
security permission to 
transfer information.
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Transferring Information from a Treatment Plan

To transfer appointment information for the next treatment plan 
appointment:

1 Begin scheduling an appointment by clicking Schedule 
Appointment. The View Schedule window is displayed.

2 In the TxPlan Detail standard, the procedure information for 
the next appointment is displayed. Click Find Appointment. 
The View Schedule window displays a list of appointment 
times corresponding to the procedure type. Select an 
appointment time. The appointment information is displayed, 
including the name, date, time, chair, type, time units, and any 
comments.

3 Select the TxPlan option. The window expands, showing the 
details of the Next Appointment section of the patient’s 
treatment card. 

4 Click Paste. 

5 Click OK. 

6 Click Close twice. 

Rescheduling Two Appointments 

To reschedule and transfer information from two appointments:

1 Cancel both appointments; then open the Schedule window 
in View or Zoom mode.

2 To reschedule the first appointment, click Last. See 
“Transferring Information from a Missed Appointment” on 
page 40 for more information.

3 To reschedule the second appointment, click Was. See 
“Changing Patient Appointments Using the Clipboard” on 
page 38 for more information.

Scheduling Recalls

The recall feature enables you to track pati
back in your office for several months or a y
used for patients who need the first availab
patients who missed an appointment and n

Recall appointments are not real appointm
them on your schedule appointment book. 
you create a computerized tickler file to hel
your recall patients. Then you can produce
cards for a specific month so that you can 
patients.

To schedule a patient recall:

1 In the patient chart, click the Schedule
and then click Schedule Appointment
window is displayed, showing the Rec

2 Select a time option or Alpha. Enter a 
and then click Add Recall. 

The Alpha and Type fields allow up to
characters; the Comment field is limite

3 Close the View Schedule window.
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4 Select the Recalls option. The recall appointments are listed.

Using Scheduling Reports

Several reports help you track scheduled appointments. The 
following scheduling reports are available:

• Available Appointments
• Scheduled Appointments
• Daily Schedule—List Format and Schedule Format
• Daily Collections
• NoShow 
• Future Procedures 
• Recall reports (Recall Labels, Recall List, Recall Cards)

Available Appointments

The Available Appointments report generates a list of appointment 
types available on a day or range of days and includes the doctor's 
name and office. You can search for all appointment types or 
specific appointment types, and you can run the report for all 
offices or a specific office. This report enables you to monitor 
productivity from day to day and displays the openings in your 
schedule.

Scheduled Appo

The Scheduled Appo
appointments for a da
are the appointment d
name, type, and statu
appointment types or 

Daily Schedule—

The List Format repor
appointment on the d
office, with the doctor
You can print a report
sort the report by pati
time. You can also ha
print in the first colum
are printed at the bott
progress reviews due
confirmed.

You can also print the
number for the patien
report.

Daily Schedule—S

The Schedule Format
for the dates selected
office, with the doctor
You can print a sched
include the patient’s f
number, and message
type or primary proce
color.
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Daily Collections

The Daily Collections report generates a list of patients scheduled 
on a particular date or range of dates with their balances. You can 
include all accounts, all non-zero, credit balance, and 30+, 60+, 
or 90+ days on the report. You should run this report before 
patients arrive.

NoShow Report

The NoShow report generates a list of patients who did not show 
up for their appointments. To archive schedule days from the 
calendar, the report should be run for each day, at the end of the 
day, or on the morning of the next day. The report archives 
no-shows and puts no-show patients on the recall list.

Printing the NoShow Report and Archiving the Day

When you print the NoShow report, the patient’s appointment is 
changed from Scheduled to No Show in the Appointment 
Summary window, schedule statistics are updated, and the day is 
archived.

To print the NoShow report and archive the day:

1 At the end of the day, select Reports > Schedule > NoShow 
Report. The No-Show Report window is displayed.

2 Type the date for which you want to run the report and select 
the report options.

3 Click Print. The software displays a message, asking if you 
want to print days with zero no-shows. Click Yes or No. The 
No-Show Report window is displayed.

4 Select from the following options:

• Post No-Show Letters—Select this option to specify a 
no-show letter to post or to cancel posting the letter for 
each patient. 

• Archive Patient Flow Totals—Ensu
selected so Patient Flow totals are

• Put Patients on “NSHW” Recall L
to store the patient information on 
Recall list. 

5 Click Yes to archive the selected dates
report. 

6 Select the No-Show letter you want to
To send a recall letter, select No-Show
letter, select No-Show-2. If you do not 
a particular patient, click Cancel. 

7 Click OK.

Future Procedures

The Future Procedures report generates a 
are linked to appointment codes for future 
You can include all procedures or selected
the list by procedure or in chronological ord

You can use this report to keep assistants 
about upcoming procedures for a single da
report includes a summary page that enabl
the totals on certain procedures for a spec
can also use this report to help in maintaini
can determine how many bandings, applian
on, are scheduled for the future and order 
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Recall Reports

Recall reports enable you to print a list of patients with recalls in a 
specific month and year or with a specific alpha recall code. You 
can also print labels or recall cards for these patients.

Printing the Recall List

To print the recall list:

1 Select Reports > Schedule > Recall List. The Print Recall 
List window is displayed. 

2  In the Recall Date section, select an option:

• Select Month/Year and type the month and year for 
which you want to print a recall list. Select Include Open 
Recalls, if appropriate.

• Select Alpha and type the alpha code for which you want 
to print a recall list.

• Select All Alpha Recalls to print a recall list for all alpha 
recalls.

3 In the Location se
location.

4 In the Recall Type
recall type. 

5 Select Include Ad

6 In the Doctor sec

7 Click Print.

Printing Recall Label

Use the recall labels f
cards.

To print recall labels:

1 Select Reports >
Mailing Labels w

2 In the Recall Date
by default. Type t
print recall labels,
which you want to

3 In the Recall Type
recall types or a s

4 In the Location se
locations or a spe

5 In the Doctor sec
patients of all doc

6 Click OK.

Note

Open recalls are 
recalls in previous 
months that have not 
been canceled. 

Note

You must use Avery 
5161 double-column 
laser printer labels.
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Printing Recall Cards

You can print recall cards for patients with recalls in a specific 
month and year or a specific alpha recall code. 

To print recall cards:

1 On the main menu, select Reports > Schedule > Recall 
Cards. The Recall Cards window is displayed.

2 In the Recall Date section, the Month/Year option is selected 
by default. Type the month and year for which you want to 
generate recall cards, or select Alpha and type the alpha 
code for which you want to print recall cards.

3 In the Recall Type section, select whether to print cards for all 
recall types or a specific recall type.

4 In the Location section, select whether to print cards for all 
locations or a specific location.

5 In the Doctor section, select whether to print cards for 
patients of all doctors or a specific doctor.

6 Click OK. The Recall Cards Messages

7 In the Messages section, select a reca
the recall message is displayed at the 
Messages section.

8 Click OK. The Print Setup window is d
printer on which you want to print reca
printer settings, and click OK.

Creating Recall Card Messages

Two default recall card messages are includ
you can create your own messages. 

To create a recall card message:

1 In the Recall Cards Messages window
Add Recall Card Message window is 

2 In the Message Name field, type the n
message.
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3 In the Message Text field, type the text you want to print on 
the recall cards. You can include merge fields in your 
message to insert patient information automatically. A list of 
merge fields can be found in the online help at Help > 
OrthoTrac Help > Recall Card Merge Fields.

4 Click OK.

Editing Recall Card Messages

To edit a recall card message:

1 In the Recall Cards Messages window, select the message 
you want to edit and click Change. The Change Recall Card 
Message window is displayed.

2 In the Message Text field, edit the text.

3 Click OK.

Restarting Recall Card Printing After a Printer Jam

If you are printing recall cards and your printer jams or runs out of 
cards, you do not have to reprint the entire list of patients. 

To continue printing:

1 On the main menu, select Reports > Schedule > Recall 
Cards. The Recall Cards window is displayed.

2 Select the Restart option and type the first five characters of 
the last name printed on the last good card.

3 Click OK.

Using the Future

The Future Procedure
are linked to appointm
You can use this repo
about upcoming proc

The report includes a 
track the totals on cer

To print the Future Pr

1 Select Reports >
Future Procedur

2 Type a start date 

3 Select All Proced

If you chose Selec
displayed. Select
click the arrow bu
window, and click

4 Select Order by P

5 Click OK.

Note

The maximum length 
for a recall message is 
255 characters.
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Printing the Schedule

The software enables you to print the schedule in two formats: list 
format and schedule format. 

Printing the Schedule in List Format

The list format produces a list of patients who have an 
appointment scheduled on a particular date. You can print a report 
for one date or a range of dates and can sort the report by patient 
number, patient name, or appointment time.

To print the schedule in list format:

1 Select Reports > Schedule > Daily Schedule > List Format. 
The Print Daily Schedule window is displayed.

2 Type the date or range of dates for the schedule you want to 
print.

3 In the Sort By section, select the option by which the 
schedule is sorted.

4 In the Print Patient Name as section, select the way the 
patient name should display on the schedule.

5 In the Chairs section, select whether to print all chairs or a 
specific chair.

6 In the Include section, select the options to include on the 
schedule.

7 In the Print First Column as section, select the way the first 
column should display on the schedule.

8 Click Print.

Printing the Schedule in Schedule Form

The schedule format replicates the grid. Yo
for one date or a range of dates and includ

To print the schedule in schedule format:

1 Select Reports > Schedule > Daily S
Format. The Print Daily Schedule win

2 Type the date or range of dates you wa

3 In the Options section, select the optio
schedule should be sorted.

4 Click OK.
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Skill Sharpeners

Exercise 1—Schedule an Appointment from the Patient Chart

Laurie Abbott, an existing patient, calls your office for an 
appointment. She states that it is not an emergency, but she 
would like to come in within the next few days. 

To schedule an appointment from Laurie’s chart:

1 Click the Open Patient Chart button. The OrthoTrac Patient 
Lookup window is displayed. 

2 Type Abbott (the patient’s last name) and press Enter. If there 
is more than one client with that last name, ensure that the 
proper name is selected and click OK. The patient chart is 
displayed. 

3 Click the Schedule Appointment button. The Appointment 
Summary window is displayed.

4 Click Schedule Appointment. The View Schedule window is 
displayed.

5 Select a date during the week when Laurie can come in for an 
appointment. The View or Zoom view of the schedule is 
displayed.

6 Click an open ADJ appointment for a time that Laurie can 
come to the office. The Appointment Details window is 
displayed.

7 If necessary, change the information in the Type or Units 
fields, or type a comment about the patient. Click OK.

8 Click Close.

Exercise 2—Search f
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to say that he is ready
a banding appointmen
morning. How can you
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To search for an appo
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• Access the OrthoTrac Patient Lookup window.

• View sibling appointments

8 Click OK. The appointment is scheduled.

Exercise 3—Cancel an Appointment

A patient calls your office to tell you that he is unable to keep his 
scheduled appointment and he will call you back when he is able 
to reschedule.

To cancel an appointment:

1 In a patient chart, click Schedule Appointment. The 
Appointment Summary window is displayed.

2 Click the red X next to the appointment you want to delete. The 
Cancel Appointment window is displayed.

3 Select an option to identify who is canceling the appointment.

4 Click OK.
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Lesson 6
Understanding the Scheduling Module

This lesson includes:

• Using the Schedule Appointment Calendar 

• Understanding Schedule Views 

• Understanding the Appointment Details Window 

• Understanding the Appointment Summary Window 

Using the Schedule Appointment Calendar

The Schedule Appointment calendar enables you to schedule 
appointments and recalls for your patients and gives you several 
ways to view your upcoming appointments. You can access this 
window from the main menu or from the patient chart.

When you open the Schedule Appointment calendar from within 
the patient chart, you can view recall appointments, sibling 
appointments, treatment plan information, and the next 
appointment.

To access the Schedule Appointment calendar, click the 
Schedule Appointment button, or select Functions > Schedule 
Appointment from the menu bar. 

OR

In the patient chart, click the Schedule Appointment button, and 
then click Schedule Appointment.

When using the Schedule Appointmen
that:

• Active schedule days on the ca
doctors in their corresponding c

• Schedule dates in the past that
archived are displayed in light g

• Archived dates are displayed in

• To view past months, click the l
button. To view future months, c
Today button.
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• At the beginning of each week, a minus or a plus sign is 
displayed, indicating whether the week is in the past or 
the future. A number indicates how many weeks behind 
or ahead of the current week the selected week is. For 
example, +1w indicates that a week is one week after the 
present week, while -3w indicates that the week is three 
weeks before the present week.

• When accessed from the patient chart, the left side of the 
window displays the following standards:

• Schedule Offices
• Schedule Doctors
• Find Appointments
• Patient Name
• Charting Detail
• Recalls

Understanding Schedule Views

There are three ways to view your schedule:

• Week displays a week. 

• View displays a single day. 

• Zoom displays a portion of a specific day. 

In each view, you can toggle between the new and the classic 
style of display by using the New Style Display option in the 
lower-left of the window. 

Viewing the Sche

To use the Week view

1 In the Schedule A
click a provider’s 

2 Click Week. The 
displayed, and yo

3 Click on a day to 

To view appointm
down on a sched

4 Use the buttons a
see more informa

• View—Displa
schedule.

• Zoom—Displ
day.
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• Stats—Displays the Schedule Statistics window.

• Calendar—Displays the View Schedule window.

• Print— Prints a copy of the schedule.

• Close—Closes the Week View window and returns you to 
the patient chart or main menu.

5 Click the reserved time or open time in which you want to 
schedule a patient and click Zoom. The Zoom mode is 
displayed with that time visible.

6 Click the appointment type you want to schedule. The 
Appointment Details window is displayed.

The classic view of the Week mode uses the following symbols:

• Smiley face—Indicates that a patient is scheduled in this 
appointment time.

• Arrows—Indicate that the appointment is more than one 
unit.

• Gray spaces—Indicate blocked-out or closed time.

• Dashed lines (--)—Colored spaces with dashes indicate 
open time.

• Appointment type initials—Indicate what the chair is 
reserved for on the schedule.

• Forward slashes (//)—Indicate that more than one unit of 
time is reserved for this appointment type.

Viewing the Schedule—View

To use the View mode:

1 In the Schedule Appointment window
click View. You can use this view to sc
must have an appointment on a specifi

2 From the patient's chart, select Functio
Appointment. The Appointment Sum
displayed.

3 Click Schedule Appointment. The Vie
is displayed.

4 Click the name of a doctor on the date
The View mode is displayed.

5 To view statistical information about th
name of the doctor on the date and the

The following buttons are available on 

• Zoom—Displays the schedule in Z

• Week—Displays the Week mode s
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• Stats—Displays the Schedule Statistics window.

• Msgs—Displays the Schedule Messages window, where 
you can add or view messages about the schedule.

• Calendar—Displays the View Schedule window.

• Print—Prints a copy of the schedule.

• Close—Closes the Zoom view and returns you to the 
patient chart.

6 Click an appointment block. The appointment information is 
displayed, including the patient name, the date, time, chair, 
type, time units, and any comments. In this window you can:

• Select the color of the appointment.

• Select the procedures associated with the appointment.

• Access the OrthoTrac Patient Lookup window.

• View sibling appointments.

7 Click OK to finish scheduling the appointment. If the 
appointment time was blocked, the software prompts you to 
override the blocked time. Click Yes.

8 Click Close. The patient's chart is displayed.

Viewing the Sche

To use Zoom mode:

1 In the Schedule A
click Zoom to dis

2 Use the scroll bar
within the day. Yo
scroll bar to go to

3 Click an arrow bu
backward or forw

4 Use the buttons a
window to see ad

5 Click an open tim
schedule a patien
displayed.

Note

You must have 
Override Preblock 
security permission to 
override blocked time.

Note

When you move your 
cursor on the grid, the 
appointment time 
column and chair row 
are highlighted to 
indicate your location 
on the grid.
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6 Click Edit Messages to add or change messages. To view all 
messages one at a time, use the scroll arrows.

7 Click on the day of the week and date at the top of the 
schedule to select a different date.

8 Click the location name at the top of the schedule to select a 
different schedule location.

9 Click the doctor name at the top of the schedule to display a 
list of doctors in your practice, enabling you to change the 
schedule doctor.

• Select the new doctor’s name and click OK. A prompt is 
displayed, asking you to confirm the change. Click Yes.

• Open Patient Flow to update all patients scheduled for 
the day with the new doctor.

10 To return to the Appointment Summary window from the 
Zoom view, click Close.

When using the Zoom view, keep the following in mind:

• If you select the current day, the schedule view defaults to 
the current time.

• If you select a day other than the current day, the 
schedule view defaults to the beginning of the day.

• If you use the scroll bar to view a particular time on the 
schedule and then click the navigation buttons to view 
either previous or future schedule days, the view for the 
day starts at the same time.

• Once a patient is on the schedule, procedure codes 
associated with the scheduled appointment are displayed 
under the patient’s name. If a scheduled appointment has 
multiple procedure codes attached to it, the display will 

contain as many codes as possible
of units of the appointment. Proce
visible on single-unit appointments

• When viewing a schedule day that
no-show appointments and compl
view-only and are displayed in gray
appointments are displayed as a s
no-show appointments display a fr
displayed with a border of their ori
color.

Viewing Archived Schedule Days

The Schedule Appointment calendar displa
information:

• Past calendar days that are not ye
light gray.

• Archived calendar days display in 

The amount of detail displayed depends on
you are using:

• Zoom mode—Completed or no-sho
view-only and are displayed in gray
appointments display a smiley face
appointments display a frown. Pati
displayed with a border of their ori
color.

• View mode—Completed or no-sho
view-only and are displayed in gray
past are also displayed in gray. Pa
displayed with a border of their ori
color.
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• Week mode—Completed or no-show appointments are 
view-only and are displayed in gray. Completed 
appointments display a smiley face; no-show 
appointments display a frown. Appointments in the past 
are also displayed in gray.

These shades of gray indicate:

• Light gray—Indicates a completed patient appointment on 
the current day or a day in the past, or any scheduled 
patient appointment on a day in the past.

• Medium gray—Indicates unused schedule blocks (no 
patient appointment was present) on a day in the past.

• Dark gray—Indicates a no-show patient appointment on 
the current day or a day in the past.

Understanding the Appointment Details 
Window

The Appointment Details window displays the date, chair, and 
time you select and enables you to change information about the 
appointment. 

The window contains the following information:

• Patient name
• Date and time of appointment

• Chair #
• Appointment
• Number of un
• Comment 

The buttons at the bot
appointment informati

• Color—Chang
schedule.

• Procs—Displa
view and cha
appointment 

• Patient—Sch
without havin

• Sibling—Sch
current patien
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Understanding the Appointment Summary 
Window

The Appointment Summary window is displayed when you click 
Schedule Appointment from inside a patient’s chart. 

The Appointment Summary window contains information about 
all of a patient’s past, current, and future appointments and 
defaults to currently scheduled appointments, which are displayed 
in the center of the window. No Show and Recall appointments 
are also displayed.

The window contains the following details about the appointment:

• Day
• Date
• Time
• Chair
• Type
• Length

• Office
• Doctor
• Scheduled by
• Comment

Use the scroll bar to view earlier or later ap
category. 

The following options enable you to access
about a patient’s scheduled appointments:

• Confirm Appointment—Click the 
appointment to view contact numb
the confirmation phone call, and m
confirmed. 

• View Day—Click the appointment 
day on which a specific appointme

• Change Comment—Click Add Co
comment that was made when the
scheduled. You can also add a co
appointment.

• Procedures—Descriptions of proc
scheduled, completed, changed, o
appointments are displayed benea
time. Click the description to add o
linked to scheduled appointments.
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Skill Sharpeners

Exercise 1—Change the Scheduling Mode from View to Week 
to Zoom

A patient calls the office requesting an appointment and you want 
to see the upcoming week’s schedule. To change views:

1 In the Schedule Appointment calendar, select a date and 
click a provider’s name. The View window is displayed.

2 Click Week. The appointments on all days in a week are 
displayed.

3 Click on a day to select it. 

4 Use the buttons at the bottom of the Week View window to 
see more information about the schedule.

• View—Displays the View Single Day view of the 
schedule.

• Zoom—Displays the Zoom mode of the schedule for that 
day.

• Stats—Displays the Schedule Statistics window.

• Calendar—Displays the View Schedule window.

• Print— Prints a copy of the schedule.

• Close—Closes the Week View window and returns you to 
the patient chart or main menu.

5 Click the reserved time or open time in which you want to 
schedule the patient and click Zoom. The Zoom mode is 
displayed with that time visible.

6 Click the appointment type you want to schedule. The 
Appointment Details window is displayed.

Exercise 2—Use the 
Information About a

You want to find infor
use the Appointment

1 In the patient’s ch
Appointment Su

In the center of th
the patient’s past
shows and recalls

2 To access more i
appointments, us

• Confirm App
• View Day
• Change Com
• Procedures



 Initial Training Workbook (OR250-15)  59 of 70

Le
U

Th

Se
Es

U

Th
co

sions and have 
 access all of the 
s: 

Important
Before you can use 
the financial 
functions windows, 
you must convert 
your balances.

Adjustments

Ledger

Promises/Collections

 
Claims

Close
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sson 7
sing the Financial Functions Windows

is lesson includes:

• Using the Menu Bar 

• Using the Financial Buttons 

e Working with Contracts for information about the Financial 
timator Setup feature.

sing the Menu Bar

e menu bar at the top of the financial functions windows 
ntains the following options:

• File—Enables you to open a new account, save 
information for the current account, or re-open any of the 
last five accounts you have accessed.

• View—Changes with each financial function you access 
and displays options for the active function. 

• Functions—Provides shortcuts to all financial tasks. 

• Reports—Enables you to print an appointment ticket, 
statement, ledger activity, contract coupons, or any 
promises that have been entered for the current account. 

• Set-up—Enables you to access the Procedure Code 
Maintenance window so you can enter new procedure 
codes or make changes without exiting the financial 
functions window.

Using the Financial Buttons

If you have the appropriate security permis
purchased the additional modules, you can
financial functions with the following button

Charges and 
Payments

Totals

Financial Estimator 
Setup

Contracts and 
Payment Plans

Auto Payments

Post Transactions



on section contains:

 the drop-down list to switch between 
ly members when posting a charge or 

nd Ins Plan—Use the drop-down lists to 
es, post payments, or make adjustments to 
ancially responsible accounts.

tant, and Clerk—Use to indicate who is 
or production and collection activity for a 
action. 

e the drop-down list to select the office in 
rk is done, if different from the patient’s chart 

tus—Use the drop-down lists to change the 
e and status.

nd Medical Alert—Use when accessing any 
tion.

ation is located below the patient 
he information and fields displayed depend 
n you are performing. The fields include: 

Charges for procedures associated with 
pointments are posted automatically when 

atient out. You also use the Procedures 
st charges manually for procedures or 
 are not included in the contract charge.

his section enables you to post patient and 
yments manually. Payments are posted 
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Using the Financial Functions—Charges and 
Payments Window

Post charges and payments in the Financial Functions--- 
Charges and Payments window. 

To access the Financial Functions—Charges and Payments 
window from a patient’s chart, click the Financial Functions 
button. The Financial Functions—Charges and Payments 
window is displayed.

OR

If you are working in another financial window, click the Charges 
and Payments button. The Financial Functions—Charges and 
Payments window is displayed. 

Patient Information

The Patient Informati

• Patient—Use
different fami
payment. 

• Resp Party a
assign charg
any of the fin

• Doctor, Assis
responsible f
specific trans

• Location—Us
which the wo
location. 

• Type and Sta
treatment typ

• Comments a
financial func

Account Information

Patient account inform
information section. T
on the financial functio

• Procedures—
scheduled ap
checking a p
section to po
products that

• Payments—T
insurance pa

Note

The Type and Status 
fields might be 
replaced by Banding 
and Estimate Comp 
date fields, depending 
on the financial 
functions you select.

Financial Functions

Charges and 
Payments
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ode or Click Here for 
dow, and select the 

n the patient and the 
 Charge Amounts” on 

ure, type the comment 
d press Enter.

 to the account:

n to post the charges.

ments” on page 62.

lose button is 

cedure between the 

r to move the cursor to 

e as a dollar amount or 
are enters the 
d. 

other charge.

Note

Remove an incorrect 
charge by selecting 
the procedure and 
pressing Delete.

Note

To split a charge 
amount, an insurance 
carrier must be 
attached to the 
patient/responsible 
party.

Note

Type the amount 
followed by the 
percent sign or a 
forward slash.

Post Transactions
OrthoTrac Practice Management Softwa

automatically against outstanding promises made by the 
responsible party.

• Totals—This tab displays the total balance, patient 
portion, current balance, and aging for a responsible 
party. The combined balances for all insurance carriers 
associated with a patient are displayed below the 
responsible party balances. 

• Overview—This tab gives a financial overview of the 
account. At the top is the amount applied to the ledger at 
the next roll and the responsible party’s billing status and 
discount, if applicable. In the center is the statement 
code, late charge amount, risk code, and roll day. At the 
bottom is the date and amount of the last statement and 
payment made for the account. 

• Auto Payment Information—This information is displayed 
below the Payments section when the Cheques/Drafts 
option is selected from the View menu. This section 
shows the total number of payments, the date the next 
payment is to be posted, and when the last payment is 
scheduled to be posted.

Posting Charges

When you post a charge using a procedure code, the software 
can make changes automatically to the patient account and 
prompt you for additional information, depending on how you set 
up your procedure codes.

To post a charge on a patient account:

1 In the Procedures section of the Financial Functions—
Charges and Payments window, enter the procedure code:

• Type the procedure code for the charge.

OR

• Press the spacebar or click Enter C
List to display the Procedures win
procedure. 

2 In the Procedures section:

• To split the charge amount betwee
insurance company, see “Splitting
page 61.

• To add a comment about a proced
on the line below the procedure an

3 When you are finished adding charges

• Click the Post Transactions butto

• Post a payment. See “Posting Pay

4 Click Close or press Enter when the C
selected.

Splitting Charge Amounts

You can split the amount attached to a pro
responsible party and insurance carrier. 

To split a charge amount: 

1 In the Amount field, press Tab or Ente
the Patient field. 

2 Enter the patient’s portion of the charg
as a percentage. Press Tab. The softw
remaining amount in the Insurance fiel

3 Press Enter or Tab to continue with an



section, select Mail-in Ck from the 
nts list and press Enter.

e number and press Enter.

t amount and press Enter until the Post 
ton is selected and press Enter to save the 
ess Ctrl+S to save and post the transaction.

e OrthoTrac Patient Lookup window is 
 the name of the next patient and repeat the 

ial Functions—Adjustments 

ns—Adjustments window enables you to 
, transfer balances, issue refunds, and post 
ffs. 

ial Functions—Adjustments window, click 
ns button in the patient chart. The Financial 
and Payments window is displayed. Click 
on. The Financial Functions—Adjustments 

nother financial window, click the 
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Posting Payments

You can post a payment immediately after posting charges, or you 
can post a group of payments, such as payments mailed to your 
office.

To post a payment:

1 In the Payments section of the Financial Functions—Charges 
and Payments window, select the payment type you want to 
post. Press Tab or Enter.

2 Type a payment reference number, and press Tab or Enter. 
The cursor moves to the Amount field. 

3 In the Amount field, type the payment amount. If necessary, 
enter the patient and insurance portions. See step 2 in 
“Splitting Charge Amounts” on page 61.

4 Click the Post Transactions button or press Enter when the 
Post Transactions button is selected.

5 Click Close or press Enter when the Close button is selected.

Posting Personal or Mailed-In Checks

To post personal payments made by checks:

1 In any financial function window, press Ctrl+O. The OrthoTrac 
Patient Lookup window is displayed.

2 Select the name of the patient whose payment you want to 
post and click OK. 

OR

If the patient name is not indicated on the check, search for 
the responsible party by clicking the Responsible option. 
Select the responsible party and click OK. 

The Financial Functions—Charges and Payments window is 
displayed.

3 In the Payments 
drop-down payme

4 Type the referenc

5 Type the paymen
Transactions but
transaction. Or pr

6 Press Ctrl+O. Th
displayed. Select
above steps.

Using the Financ
Window

The Financial Functio
correct posting errors
discounts and write-o

To access the Financ
the Financial Functio
Functions—Charges 
the Adjustments butt
window is displayed.

OR

If you are working in a
Adjustments button. 

Adjustments
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 divide money among 
surance carriers. Most 
 only within the family 
responsible party 
ables you to move 
e family account.

 non-contract charges 
ecord; for example, 
et charge, panoramic 

llar amount

ient/responsible party

 in the Financial 
 charges available for 
 of the window.

 default comment is 
d a comment at the 
ult comment and 

rror window is 
 procedure and all 
tment.

Note

You cannot partially 
adjust a charge or a 
payment.
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The Financial Functions—Adjustments window is displayed.

You must enter a comment to indicate why the adjustment is being 
made. In most cases, the software provides a comment with 
details about the adjustment.

Adjustments are classified into the following categories: 

• Transaction Adjustments—Transaction adjustments 
display a list of posted transactions in a grid, enabling you 
to select the transaction that needs adjustment. 
Transaction adjustments reverse the selected entry. If a 
transaction is split, both the responsible party and 
insurance amounts are adjusted automatically. 

• Balance Adjustments—Balance adjustments are not 
related to a specific transaction but, instead, affect the 
patient’s total balance, current balance, or both. Refunds, 
discounts, and write-offs are examples of balance 
adjustments. The adjust aging and location change 
functions are also considered balance adjustments.

• Transfers—Transfers enable you to
patients, responsible parties, and in
transfers allow you to move money
account. The responsible party to 
transfer is the only transfer that en
money to an account outside of th

Making Charge Adjustments

Charge adjustments are used for adjusting
from a patient ledger and patient tracking r
retainer replacement charge, broken brack
x-ray charge, and so on.

Use this adjustment for:

• A charge posted for the wrong do

• A charge posted to the wrong pat

To make a charge adjustment:

1 Select the Charge Adjustment option
Functions—Adjustments window. The
adjustment are displayed in the center

2 Select the charge you want to adjust. A
displayed in the Comment section. Ad
end of this comment, or select the defa
replace it. 

3 Click Posted in Error. The Posted in E
displayed, showing a description of the
accounts that are affected by the adjus

4 Click OK. 



on grid activates the Returned Check 
ntify a payment as a returned check, the 
Adjustments window includes the option to 

djustment for an NSF check:

nt Adjustment option in the Financial 
tments window. The payments available for 
splayed in the center of the window.

nt you want to adjust. A default comment is 
omment section. Add a comment at the 
ent, or select the default comment and 

heck. The Returned Check window is 
g a description of the payment and all 
 affected by the adjustment.

F charge can be changed to a different 
hanged to zero by entering the new amount 
e Amount field.

 responsible party displayed in the window 
SF charge.

ables you to view the balance and aging for 
iew totals in two ways:

onsible Party—Displays tabs for all 
arties and insurance carriers that are linked, 

tient listed in a grid.

nt—Displays tabs for all patients that are 
ach responsible party and insurance carrier 
tely in a grid. 
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Making Payment Adjustments

Payment adjustments are used to correct payments posted to the 
ledger. Use this adjustment when: 

• A payment is posted for the wrong amount.

• A payment is posted to the incorrect patient, responsible 
party, or insurance.

• A check is returned from the bank due to insufficient 
funds.

• A credit card payment is posted in error.

• A payment posting error is found after the daysheet has 
been closed and the deposit has been made. 

To make a payment adjustment:

1 Select the Payment Adjustment option in the Financial 
Functions—Adjustments window. The payments available for 
adjustment are displayed in the center of the window.

2 Select the payment you want to adjust. A default comment is 
displayed in the Comment section. Add a comment at the 
end of this comment, or select the default comment and 
replace it. 

3 Click Posted in Error. The Posted in Error window is 
displayed, showing a description of the payment and all 
accounts that are affected by the adjustment.

4 Click OK.

Making Payment Adjustments for Returned Checks

The Payment Adjustment Input window enables you to make 
standard payment adjustments, as well as adjustments for checks 
returned by the bank due to insufficient funds. Selecting a 
personal check, mail-in check, traveler’s check, or post-dated 

check in the transacti
button. When you ide
Financial Functions—
post an NSF charge. 

To make a payment a

1 Select the Payme
Functions—Adjus
adjustment are di

2 Select the payme
displayed in the C
end of this comm
replace it. 

3 Click Returned C
displayed, showin
accounts that are

4 Click OK. The NS
dollar amount or c
in the NSF Charg

5 Click OK, and the
is assessed the N

Viewing Totals

The totals function en
an account. You can v

• View by Resp
responsible p
with each pa

• View by Patie
linked, with e
listed separa

Note

Bulk insurance 
payments are not 
reversible using the 
payment adjustment 
feature. You must use 
the balance adjustment 
feature to reverse bulk 
payments.
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r window, click the 
hart. The Financial 
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Note

You can enter ledger 
comments only when 
using the View by 
Resp Party option.

Tip

To print a copy of the 
ledger, select Reports 
> Ledger > Patient 
Copy or Reports > 
Ledger > Office 
Copy.

Financial Functions

Totals

Ledger
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Both view options include an All tab that combines the balances 
for the accounts. The account detail grid displays the roll day, risk 
code, balances, and aging for the accounts. The total for each 
aging category is displayed below the account detail grid.

To access the Financial Functions—Totals window, click the 
Financial Functions button in the patient chart. The Financial 
Functions—Charges and Payments window is displayed. Click 
the Totals button. The Financial Functions—Totals window is 
displayed.

OR

If you are working in another financial window, click the Totals 
button. If you have made changes and have not posted them, the 
software displays a message asking you to post the transactions 
before continuing. The Financial Functions—Totals window is 
displayed. 

To view account totals and aging:

1 Click the tabs across the top of the tot
account information for individual patie

2 Select the View by Resp Party option 
containing account information for all r
insurance carriers that are linked.

3 Use the Patient or Resp Party drop-do
another patient or responsible party. Th
depending on how the patients are link

4 Click Close.

Viewing the Ledger

The ledger displays all financial activity for 
view ledger activity in these ways:

• View by Patient—Displays tabs for
linked, with the name of the respon
insurance carrier listed in a grid.

• View by Responsible Party—Displ
responsible parties and insurance 
with the patient names listed in a g

• View by Single Account—Displays
responsible parties and insurance 
patient account.

To access the Financial Functions—Ledge
Financial Functions button in the patient c
Functions—Charges and Payments windo
the Ledger button. The Financial Function
displayed.

OR



d displays the Date, Responsible Party or 
er, Clerk Number, Description, and 

saction. If you are viewing one of the 
play includes columns for Charges and 

 tab, the Charges and Payments columns 
nt and Insurance columns. 

 Current and Total columns, showing the 
ce and total balance after the transaction. 

n is displayed below the account detail grid. 
vidual tab, the totals for the Charges and 
flect all charges and payments posted to the 
the tab selected. On the All Patients tab, 
nt and Insurance columns reflect the 
 patients or all responsible parties.
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If you are working in another financial window, click the Ledger 
button. The Financial Functions—Ledger window is displayed. 

To view ledger information:

1 Click the tabs across the top of the ledger display to view 
account information for individual patients who are linked.

2 Select View by Resp Party to display tabs containing account 
information for all responsible parties and insurance carriers 
that are linked.

Use the Patient or Resp Party drop-down lists to view 
another patient or responsible party. The views vary, 
depending on how the patients are linked in the patient chart.

3 Select View by Single Account to display tabs containing 
account information for all responsible parties and insurance 
carriers for a single patient in the family.

4 Click Close.

The account detail gri
Patient, Doctor Numb
Amount for each tran
individual tabs, the dis
Payments. 

When you use the All
are replaced by Patie

The grid also includes
resulting current balan

A total for each colum
When viewing an indi
Payments columns re
account identified on 
the totals for the Patie
current balance for all
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When you move the cursor over each line, the name of the 
responsible party, insurance carrier, and patient to whom the 
transaction was posted are displayed below the column totals.

If a transaction has been split between a responsible party and 
insurance, (Split) is displayed in the Resp column. To display the 
names of the responsible party and insurance carrier, move the 
cursor over the (Split) indicator.



nsactions button or press Enter.

ss Enter when the Close button is selected.

 Mailed-In Payments

’s mail, you have a stack of checks that need 
n you post the payments quickly and 

r office receives in the mail:

nctions window, press Ctrl + O. The 
t Lookup window is displayed.

f the patient whose payment you want to 
. 

e is not on the check, search for the 
 by clicking the Responsible button. Select 
arty and click OK.

ctions—Charges and Payments window is 

move the cursor to the Payments section.

 from the drop-down payments list and 

e number and press Enter.

t amount and press Enter until the Post 
ton is selected and press Enter or Ctrl + S to 
ion.

he OrthoTrac Patient Lookup window is 
 the name of the next patient and repeat the 
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Skill Sharpeners

Exercise 1—Post Charges and Payments to an Account 
Outside of Checkout

Mary Doe is not scheduled for an appointment but comes into 
your office to purchase a whitening kit. How do you charge her for 
the kit?

To post a charge on a patient account:

1 On the main menu, click the Open Patient Chart button. The 
OrthoTrac Patient Lookup window is displayed.

2 Type Doe and press Enter. 

3 Verify that the correct patient is selected and click OK. The 
patient chart is displayed.

4 Click the Financial Functions button. The Financial 
Functions—Charges and Payments window is displayed.

5 In the Procedures section, type the procedure code for the 
whitening kit, or click Enter Code or Click Here for List to 
display the Procedures window, and select the code from the 
list. 

6 To add a comment about a procedure, type the comment on 
the line below the procedure and press Enter. A green 
checkmark is displayed in the Patient field to indicate that the 
comment will be displayed on the patient ledger.

7 Press Tab or Enter to move to the Payments section and 
select a payment type from the list. Press Tab.

8 Type a payment reference number, if necessary, and press 
Tab. The payment amount is populated automatically. Press 
Tab until the Post Transactions button is highlighted.

9 Click the Post Tra

10 Click Close or pre

Exercise 2—Process

After opening the day
to be posted. How ca
efficiently?

To post payments you

1 In any financial fu
OrthoTrac Patien

2 Select the name o
post and click OK

If the patient nam
responsible party
the responsible p

The Financial Fun
displayed.

3 Press Ctrl + P to 

4 Select Mail-in Ck
press Enter.

5 Type the referenc

6 Enter the paymen
Transactions but
save the transact

7 Press Ctrl + O. T
displayed. Select
above steps.
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Exercise 3—Process a Bulk Insurance Check

You have received a reimbursement check from Doe Brothers 
Insurance that contains payments for several patient claims. How 
do you post the payments accurately, ensuring that the insurance 
check is dispersed properly?

To post a bulk check:

1 Click the Insurance Functions button on the main menu. The 
Insurance Functions menu is displayed. Select Post Bulk 
Payment. The OrthoTrac Carrier Lookup window is 
displayed.

2 Select the insurance company that sent you the check and 
click OK. The Post Bulk Payment window is displayed.

3 In the Reference field, type the reference number from the 
check. Press Enter.

4 In the Check Amount field, type the amount of the check. 
Press Enter.

The Paid column for the first patient in the grid is selected, 
and the Ins Cur and Pat Cur balance is displayed.

5 If the amount displayed matches the amount on the EOB for 
that patient, press Enter. If the EOB lists a different amount, 
type the new amount and press Enter. A dialog box containing 
Patient and Insurance options is displayed.

6 Press Enter or click Apply to apply the check amount to the 
account. To apply the payment to the other account balance, 
select the account and click Apply. A checkmark is displayed 
next to the balance paid.

7 Select the next patient on the list and repeat the above steps.

8 When all payments have been posted 
amount is $0.00, click OK.

9 Click Print to print a report.

Exercise 4—Make a Charge Adjustment

You have posted a charge for a retainer rep
patient’s account. How do you remove the 

To make a charge adjustment:

1 Open the chart for the patient whom yo
click the Financial Functions button. T
Functions—Charges and Payments w

2 Click the Adjustments button. The Fin
Adjustments window is displayed.

3 Click Charge Adjustment. The charge
adjustment are displayed in the center
Functions—Adjustments window.

4 Select the charge you want to adjust.

5 Click Posted in Error. The Posted in E
displayed, showing a description of the
accounts affected by the adjustment.

6 Click OK to post the adjustment and u
indicated in the window.

7 Click the Close button to return to the

8 Click the Patient Lookup button and s
whom you want to post the charge. 

9 In the patient chart, click the Financial
post the charge to the account. Add a c
appropriate charge date, if necessary.



iscount Adjustment

f discount adjustments that enable you to 
ontract or a balance to a patient. This 
ff Discount option. 

ff member is starting treatment, and your 
iscount for staff members. How do you apply 
o-worker’s account?

djustment:

ct for treatment as you typically would.

unctions—Charges and Payments window, 
ents button. The Financial Functions—
dow is displayed.

he account balance information is displayed 
e Financial Functions—Adjustments 

count section, select Staff Discount.

 Adjust box, select whether you want the 
 the responsible party balance or the 
.

mt field, type the amount of the discount 
tage (10/ or 10%) or a negative dollar 
 software calculates the effect on the 
 and aging.
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Exercise 5—Make a Payment Adjustment

You have posted a payment to John Doe’s account, but there are 
two patients named John Doe in your office, and you posted the 
payment to the wrong account. How do you remove the payment 
so you can credit the correct account?

To make a payment adjustment:

1 Open the chart for the patient whom you credited mistakenly 
and click the Financial Functions button. The Financial 
Functions—Charges and Payments window is displayed.

2 Click the Adjustments button. The Financial Functions—
Adjustments window is displayed.

3 Click Payment Adjustment. The payments available for 
adjustment are displayed in the center of the Financial 
Functions—Adjustments window.

4 Select the payment you want to adjust. A default comment is 
displayed in the Comment section. Add a comment at the 
end of this comment, or select the comment and replace it.

5 Click Posted in Error. The Posted in Error window is 
displayed, showing a description of the procedure and all 
accounts affected by the adjustment.

6 Click OK to post the adjustment and update all accounts 
indicated on the window.

7 Click the Close button to return to the patient chart.

8 Click the Patient Lookup button and select the patient for 
whom you want to post the payment. 

Exercise 6—Make a D

There are five types o
give a discount on a c
example uses the Sta

The daughter of a sta
doctor gives a 50% d
the discount to your c

To make a discount a

1 Set up the contra

2 In the Financial F
click the Adjustm
Adjustments win

3 Click Discount. T
in the center of th
window.

4 In the Type of Dis

5 In the Account to
discount to affect
insurance balance

6 In the Discount A
either as a percen
amount (-10). The
account balances
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Important

When you begin 
checking out a 
patient, you must 
complete the 
process, but you do 
not have to post 
transactions or 
schedule 
appointments.

Patient Checkout
OrthoTrac Practice Management Softw

Lesson 8
Checking Patients Out

This lesson includes:

• Posting Procedures and Payments 

• Scheduling the Next Appointment or Recall 

• Printing Tickets, Excuses, or Labels 

• Checking Out Families 

To access patient checkout from the main menu, click the Patient 
Checkout button. The OrthoTrac Patient Lookup window is 
displayed. Select the patient name and click OK. The Financial 
Functions—Charges and Payments window is displayed, if Post 
Procedures or Post Payments is selected in the Checkout 
Options section of the System Options window.

To access patient checkout from the patient chart, click the 
Patient Checkout button. The Financial Functions—Charges and 
Payments window is displayed. Posting Procedures and Pa

To post the procedures and payments r
appointment:

1 In the Procedures section, type the
appointment, or click Enter Code o
display the Procedures window, w
procedures to post. 



 drop-down arrow and select <None>. 

.

ce—If a procedure is set to prompt for a 
ce, the Tooth/Surface window is displayed. 
ropriate tooth numbers or surface 
 the fields.

Charge Contract—A procedure code can 
charge contract and post the first charge 
. When posted, the first charge is applied, 
r entry is written for the visit charge contract. 
 total and current balance increases by the 
mount.

 Next Appointment or Recall

ummary window, schedule the patient’s 
call. 

es when scheduling appointments so that 
cally retrieves the procedures the next time 
t.

s, Excuses, or Labels

e patient’s next appointment or recall, the 
cket window is displayed. 

 your workstation to print appointment 
r, you are prompted to print the labels for the 

intment ticket, excuse, or appointment label, 
/Select Another Patient button to close the 
nd select the next patient.
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2 Enter a ledger comment and press Tab or Enter to move to 
the procedure Amount fields. Change the amounts, if 
necessary. You can split amounts between patient and 
insurance, provided a carrier has been assigned to the 
patient, by typing the amount or percentage (% or /).

3 In the Payments field, select a payment type from the list, type 
a payment reference number, and type the payment amount. 
Type the patient portion and the insurance company portion, if 
applicable.

4 Click the Post Transactions button or press Enter when the 
Post Transactions button is selected.

5 Click Exit or the Close button. 

Procedure Code Prompts

Depending on how you have configured the software, you can 
receive one of the following prompts when you post certain 
procedures:

• Status Change—If the procedure is set to prompt for a 
status change, the Select Status window is displayed.

Click on the new status and click OK. To keep the existing 
status, click Cancel. If the procedure has only one 
associated status, the change occurs automatically.

• Auto-Post Letters—If the procedure is set to 
automatically post letters, a letter icon is displayed next to 
the procedure on the Financial Functions—Charges and 
Payments window. To view the letters that will be posted, 
click the letter icon. The Procedure Letter Assignments 
window is displayed.

• To prevent a letter from being posted automatically, 
click the letter name to display a drop-down arrow. 

• Click the

• Click OK

• Tooth/Surfa
tooth or surfa
Type the app
information in

• Create Visit 
create a visit 
automatically
and no ledge
The patient’s
visit charge a

Scheduling the

In the Appointment S
next appointment or re

Attach procedure cod
the software automati
the patient checks ou

Printing Ticket

After you schedule th
Print Appointment Ti

If you have configured
labels to a label printe
patient.

After printing an appo
click the Close Chart
current patient chart a

Note

To remove an incorrect 
charge, select the 
procedure and press 
Delete.

Tip

When scheduling a 
TxPlan appointment, 
the calendar date 
automatically defaults 
to the targeted date 
range.

Post Transactions
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Checking Out Families

To check out a family:

1 Check out a single family member, posting that person’s 
procedures and payments as usual.

2 Check out another family member by selecting the family 
member’s name from the drop-down list in the Patient field. 
Repeat this process for each additional family member.

3 After you have posted the financial information for all family 
members, close the Financial Functions—Charges and 
Payments window. The Appointment Summary window is 
displayed. The original patient is selected for scheduling. 

4 Transfer information from the patient’s treatment card.

5 Schedule appointments for additional family members by 
selecting an appointment date and time, then clicking Select 
Sibling in the Appointment Details window. 

See Lesson 13—Working with the Patient Flow Module for more 
information.
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Skill Sharpeners

Exercise 1—Check a Patient Out

Susie Doe has come in for her regular adjustment appointment. 
Now she is ready to check out, and she wants to make a payment. 

How do you check Susie out? To check her out:

1 Open Susie’s chart.

2 Click the Patient Checkout button. The Financial Functions—
Charges and Payments window is displayed.

3 In the Procedures section, type the procedure codes for this 
appointment or click Enter Code or Click Here for List to 
display the Procedures window, where you can select 
procedures to post. 

Procedures that were performed today are displayed 
automatically if procedures have been scheduled with the 
appointment.

4 Enter a ledger comment by typing the comment in the 
Procedures section and pressing Tab. 

5 Press the Tab or Enter key to move to the procedure Amount 
fields and change the amounts, if necessary. You can split 
amounts between patient and insurance, provided a carrier 
has been assigned to the patient, by typing the amount or 
percentage (/ or %).

6 In the Payments field, select a payment type from the list, type 
a payment reference number, and type the payment amount. 
Type the patient portion and the insurance company portion, if 
applicable.

7 Click the Post Transactions button or press Enter when the 
Post Transactions button is selected to post the charges and 
payments you have entered.

8 Click Close or pre
The Appointmen

9 Click Schedule A
calendar is displa

10 Click Search. The
is displayed, depe
the Schedule Ma

11 In the Code field,
the arrow buttons
appointment type
Appointment Sea

12 Scroll through the
specific Time/Ch

13 Click Schedule. T
displayed. 

14 In the Comment 

15 Click Procs. The 
procedures that w
and click OK.

16 Click Close to clo

17 Click Close to clo
Print Appointmen

18 Select the option
excuse, or work e

19 Click the Patient 
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Exercise 2—Check a Patient Out Using Information from the 
Charting Module

If your office uses the Charting module, an assistant at chairside 
enters the next appointment date and the procedures that will be 
performed, and the information is displayed at checkout. 

Paul Patient has come in for his regular adjustment appointment. 
To check him out using the Charting module:

1 Open Paul’s chart.

2 Click the Patient Checkout button. The Financial Functions—
Charges and Payments window is displayed.

3 Procedures that were performed today are displayed 
automatically in the Procedures section. Enter any additional 
ledger comments by typing the comment in the Procedures 
section and pressing Tab. 

4 Press the Tab or Enter key to move to the procedure Amount 
fields and change the amounts, if necessary. You can split 
amounts between patient and insurance, provided a carrier 
has been assigned to the patient, by typing the amount or 
percentage (/ or %).

5 In the Payments field, select a payment type from the list, type 
a payment reference number, and type the payment amount. 
Type the patient portion and the insurance company portion, if 
applicable.

6 Click the Post Transactions button or press Enter when the 
Post Transactions button is selected to post the charges and 
payments you have entered.

7 Click Close or press Enter when the Close button is selected. 
The Appointment Summary window is displayed.

8 Click Schedule Appointment. The pro
appointment on the treatment card are
Charting Information window, along w
Appointment calendar.

9 Click Search. The Appointment Types
is displayed, depending on the search m
the Schedule Maintenance window. 

In this example, the schedule is set up 
types.

10 In the Code field, type the appointmen
the arrow buttons or scroll bar to move
appointment types and select the appo
Appointment Search window is displa

11 Scroll through the list of appointment t
specific Time/Chair to schedule. Click
Appointment Details window is displa

12 Click Charting. The window shows the
Appointment section of the patient’s t

13 Click Paste. 

14 Make any necessary changes to the ne
information.

15 Click OK to schedule the appointment.
you, asking if you would like to clear th
Charting module. If this is a one-time ap
this is an appointment type that is repe
Adjustment), click No. The appointmen
Appointment section of the treatment 
to be re-typed for the next appointmen

16 Click Close to close the Schedule Ap
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17 Click Close to close the Appointment Summary window. The 
Print Appointment Ticket window is displayed.

18 Select the options to print an appointment ticket, school 
excuse, or work excuse and click Yes.

19 Click the Patient Lookup button to close the current patient 
chart. 

Exercise 3—Print a Payment Receipt

At the checkout desk, William Doe tells you he needs a receipt so 
he can be reimbursed from his flexible spending account. How do 
you print an individual receipt for William?

To print the payment receipt:

1 After you have checked William out, select Reports > Receipt 
> Payment Receipt in any of the financial functions windows 
in William’s chart. The Payment Receipts window is 
displayed.

2 In the Print Options section, select the option for how the 
receipt should be printed.

3 In the Date Range section, type a date range from which to 
print the receipt, if desired.

4 Click OK.
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sson 9
sing Financial Reports

is lesson includes:

• Processing the Daysheet 

• Printing Month-To-Date Reports 

• Using the Ledger Scan Report 

e financial reports in the software enable you to keep track of 
ur practice’s financial data. The available reports include:

• Balancing Worksheet
• Selected Billing Types
• Statement Code/Late Charge
• Ledger Scan
• Coupon Books
• Contract Summary
• Revenue Projection
• Aged Receivables By
• Auto Payment
• Statements
• Daysheet 
• Roll

e daysheet reports include:

• Process Daysheet
• Quick View Daysheet
• View Archived Daysheets
• MTD Daysheet Report

Processing the Daysheet

The first step in closing the daysheet is to p
transactions. To preview the Daysheet repo

1 On the main menu, select Reports > F
Process Daysheet. The Preview Dep
displayed.

2 To view the responsible party account 
of the window, click on the folder name
you want to view. The responsible part
upper-right side of the window.



ing the Daysheet

 match the payments and all transactions 
you can print and close the daysheet. To 
ysheet:

 the menu bar of the Preview Deposits 
irm that Close Daysheet is selected. 

orts listed above Close Daysheet print 

aysheet of the day, select Print! The 
 a message. Click Yes.

g box, verify that the correct printer is 
k OK. 

eck is intact and no problems are detected, 
lays a Printout OK? message, requesting 
t the daysheet printed properly. Wait until 
inted, and make sure the control number 
er of all reports before answering this 

he daysheet closes, all transactions are 
 daysheet, and daily totals are reset to zero. 

e transactions remain on the daysheet, and 
t closed (although the printout has a control 
sheet Preview window is displayed again. 

e printer for paper jams, orientation, and so 
s on the menu bar and make certain Close 
cted before printing again. 
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3 To view other transactions, such as contracts, adjustments, 
and so on, click View > Transactions on the menu bar. The 
Preview Daysheet Transactions window is displayed.

4 To view the accounts for a particular category, double-click 
the appropriate folder on the left side of the window. If 
subcategories exist, a folder is displayed for each. 
Double-click the name of the subcategory folder to display the 
patient name, reference number, transaction amount, and 
location in the upper-right side of the window. 

The total for the transaction category, including all 
subcategories, is displayed in the lower-right side of the 
window.

Printing and Clos

If the deposit amounts
appear to be correct, 
print and close the da

1 Click Reports on
window and conf

The daysheet rep
automatically. 

2 To print the final d
software displays

3 In the printer dialo
selected and clic

If the Integrity Ch
the software disp
you to confirm tha
the reports are pr
prints in the head
message. 

If you click Yes, t
removed from the

If you click No, th
the daysheet is no
number). The Day
After checking th
on, select Report
Daysheet is sele

Note

All of the daysheet 
reports print by default, 
unless you have 
configured the 
software to exclude 
specific reports.

Important
Verify that the 
daysheet printed 
properly.

Note

If the Trial Balance is 
displayed in the 
daysheet header, the 
daysheet was not 
closed properly and 
must be printed again.
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Printing a Trial Balance Report

If you are not ready to close the daysheet but want a printed copy 
of a report:

1 Click Reports on the menu bar and deselect Close 
Daysheet.

2 Deselect the reports you do not want to print, and select the 
reports you want to print.

3 Click Print! The reports that print display Trial Balance in the 
upper-right corner of the header.

Multi-Month Daysheet

When running a daysheet that contains transactions from multiple 
months, a message is displayed, stating that you need to run the 
Daily Monitors and Totals Summary reports after the daysheet 
has been closed. 

Printing the Daily Monitors and Totals Summary pages of the 
daysheet separately after the current daysheet is closed prevents 
dollar amounts from transactions in previous months from being 
calculated and reported in the Daily Monitors/This Month row 
and in the Totals Summary/Month-to-Date Totals section. 

To print the Daily Monitors and Totals Summary pages for a 
multi-month daysheet:

1 Before closing the daysheet, click Reports on the Preview 
Deposits menu bar and verify that Daily Totals, Daily 
Monitors, and Totals Summary are selected. 

2 Close the daysheet. See “Printing and Closing the Daysheet” 
on page 78.

3 After closing the daysheet, return to th
window, select Reports on the menu b
Totals Summary and Daily Monitors 

4 Click Print!

Viewing the Daysheet

The Quick View Daysheet report enables y
the same functions as Process Daysheet, b
totals for each doctor and office. Several p
integrity check, daily totals, total summary, 
close daysheet, are disabled. 

The Quick View Daysheet option is helpful 
multiple offices, as satellite offices can use
their individual deposit/balance, while the m
daysheet.

Viewing Archived Daysheets

When the daysheet is closed, an archived 
automatically generated. 

To view archived daysheets:

1 From the main menu, select Reports >
> View Archived Daysheets. The View
window is displayed. 

2 Click the calendar buttons to select th

3 Select the daysheet you want to view. 

4 Click View Daysheet. A copy of the da
a PDF file.
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Printing Month-To-Date Reports

You can print monthly reports together or individually, with or 
without accompanying graphs. The Monthly Summary, Monitor 
Recap, and Deposit Recap reports display data for each day on 
which transactions were posted in the selected month. The 
Monthly Totals report corresponds to the Daily Totals page of the 
daysheet and contains amounts for each of the daysheet 
categories and related transaction types.

To print the monthly daysheet reports:

1 On the main menu, select Reports > Financial > Daysheet > 
MTD Daysheet Report. The Monthly Reports window is 
displayed.

2 Deselect the reports you do not want to print. When a report 
is selected, the graph box to the right of the report name is 
active. Use the drop-down list to select the type of graph to 
print with each report or select <None>. 

3 Select Include co
the dollar amount
Summary, Monito

4 To change the Sp
the month and ye

Select Range of 
report. Enter the d

5 If your office has 
enabled. Select A
location from the 

6 If your office has 
enabled. Select A
doctor from the d

7 Click Print. The F
displayed. 

8 Select a print opt

Using the Ledg

The Ledger Scan repo
amounts for a specifie
party. You can select 
and filter the report so
patient’s insurance, re

You can also specify w
and all doctors, or a p
options can be saved
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To use the Ledger Scan report:

1 On the main menu, select Reports > Financial > Ledger 
Scan. The Ledger Scan window is displayed.

2 Type the dates for which you want a report in the fields at the 
top of the window. 

3 In the Available Transactions section, select each 
transaction you want to include in the report by highlighting 
the transaction and clicking the single right-arrow button. 

4 In the remaining sections, select whether you want to 
generate a report By Patient or By Responsible; for All 
Locations or a Single Location; for Patient, Insurance, or 
All; and for All Doctors or a Single Doctor.

5 Click OK and Print.

Saving Ledger Scan Report Settin

After running a Ledger Scan report, you ca
enable you to run the report in the future. To
report settings:

1 After running the report, click Apply. T
window is displayed.

2 Type a name for the report in the field a
name and settings are saved.

To run a report using the same settings
the Previously Saved Settings field a
name from the list.
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Skill Sharpeners

Exercise 1—Print the Daysheet

At the end of a business day, you want to print and close the 
daysheet. To do so:

1 Click Reports on the menu bar of the Preview Deposits 
window and confirm that Close Daysheet is selected. 

The daysheet reports listed above Close Daysheet print 
automatically. 

2 To print the final daysheet of the day, select Print! The 
software displays a message. Click Yes.

3 In the printer dialog box, verify that the correct printer is 
selected and click OK. 

If the integrity check is intact and no problems are detected, 
the software displays a Printout OK? message, requesting 
you to confirm that the daysheet printed properly. Wait until 
the reports are printed, and make sure the control number 
prints in the header of all reports before answering this 
message. 

4 Click Yes. The daysheet closes, all transactions are removed 
from the daysheet, and daily totals are reset to zero. 

Exercise 2—View an Archived Daysheet

You need to view a daysheet from a past date. To view archived 
daysheets:

1 From the main menu, select Reports > Financial > Daysheet 
> View Archived Daysheets. The View Archived Daysheets 
window is displayed. 

2 Select a date range and select the daysheet you want to view. 

3 Click View Daysheet. 
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sson 10
orking with Contracts

is lesson includes:

• Setting Up Contracts 

• Setting Up Contracts with Insurance or Multiple 
Responsible Parties 

• Using the Financial Estimator Setup Window 

e the contracts and payment plans function to set up your 
ntracts, payment plans, visit charges, and monthly fees. You can 
ter a total contract balance and set up payments to be rolled in 
nthly, quarterly, semi-annually, or annually until treatment is 
mpleted. Production is updated as each charge is rolled in. 

yment plans function the same as contracts, but production 
ures are not updated each month. Payment plans are used for 
rvices that are produced in a single visit or to refinance 
linquent accounts without duplicating production. The patient is 
le to spread payments over a period of time. 

etting Up Contracts

 set up a contract:

In a patient chart, click the Financial Functions button. The 
Financial Functions—Charges and Payments window is 
displayed.

Click the Contracts and Payment Plans button. The Financial 
Functions—Contracts and Payment Plans window is 
displayed.

3 In the Description field, select a contra
drop-down menu or add a new descrip

4 In the Contract Total field, type the full
before discounts, which includes the re
portion and insurance carrier portion, if

The total contract amount is displayed
responsible party listed in the Respons
section. If the first responsible party is 
contract amount, press Tab again. 

5 In the Initial Fee field, type the amount
due on the initial fee due date. Press T



k the Post Transactions button. If you have 
ding date, the Contract message is 

g date, click the calendar next to the Start 
ect a date, or type the date in the field.

ted completion date, click the calendar next 
field and select a date, or type the date in the 

tracts with Insurance or 
nsible Parties

ith insurance or multiple responsible parties: 

rt, click the Financial Functions button. The 
ns—Charges and Payments window is 

ts and Payment Plans button. The Financial 
acts and Payment Plans window is 

 field, select a contract description from the 
 or add a new description. Press Tab.

otal field, type the full contract amount 
 which includes the responsible party 
nce carrier portion, if applicable. Press Tab.

ction, type the portion of the contract the 
arty is paying. Press Tab.

nal responsible parties/insurance carriers 
hould be divided between, type the amount 

til the total contract amount is disbursed. 
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6 In the Payment Amount field, type the payment amount to be 
paid monthly, quarterly, semi-annually, or annually. Press Tab.

The software calculates the payment amount if you leave this 
field blank and enter the total number of payments in the 
Num. of Payments field.

7 In the Num. of Payments field, type the number of payments. 
Press Tab.

8 In the Init. Fee Due Date field, type the date the initial fee is 
due. Press Tab.

The initial fee due date determines when a contract becomes 
active. If you use the current date, the contract is activated, 
and the initial fee amount is applied to the current balance 
when you post the contract. If you use a date in the future, the 
status of the contract is Pending. 

9 In the Start Date field, type the date that the first contract 
charge should be applied. In a single-due-date system, the 
date defaults to the roll date for the next month. In a 
multi-due-date system, the date defaults to one month from 
the initial fee due date.

To use the default payment term of Allow only 1 Charge per 
Month, press Tab. The Spread button is selected. Press Tab. 
The Post Transactions button is selected.

OR

To use a different payment term for the contract, select a new 
payment term. Press Tab. The cursor immediately moves to 
the Post Transactions button. 

10 Type a description.

11 Press Enter or clic
not entered a ban
displayed.

12 To enter a bandin
Date field and sel

13 To enter an estima
to the Est Comp 
field.

Setting Up Con
Multiple Respo
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Post Transactions
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If a particular responsible party should not be included in the 
contract disbursement, type 0 and press Enter to skip the 
responsible party and to continue disbursing money to the 
next responsible party. Press Tab. 

6 Select whether this is a Contract or Payment Plan. Press Tab.

7 In the Initial Fee field, type the amount of the contract that is 
due on the initial fee due date. Press Tab.

8 In the Payment Amount field, type the payment amount to be 
paid monthly, quarterly, semi-annually, or annually. Press Tab.

The software calculates the payment amount if you leave this 
field blank and enter the total number of payments in the 
Num. of Payments field. 

9 In the Num. of Payments field, type the number of payments. 
Press Tab.

10 In the Init. Fee Due Date field, type the date the initial fee is 
due. Press Tab.

The initial fee due date determines when a contract becomes 
active. If you use the current date, the contract is activated, 
and the initial fee amount is applied to the current balance 
when you post the contract. If you use a date in the future, the 
status of the contract is Pending. 

11 In the Cont. Start Date field, type the date that the first 
contract charge should be applied. In a single-due-date 
system, the date defaults to the roll date for the next month. In 
a multi-due-date system, the date defaults to one month from 
the initial fee due date. 

To use the default payment term of Monthly, press Tab. The 
Spread button is selected. Press Tab. The Next button is 
selected.

OR

To use a different payment term for the
payment term. Press Tab. The Next bu

12 Click Next or press Tab to continue set
the next responsible party/insurance ca

Continue completing contract informat
parties/insurance carriers on the list. If
listed but does not require a contract, 
contract fields until the software displa
acknowledging that the responsible pa
not have a financial contract. 

13 After completing the payment informat
responsible party/insurance carrier in t
Responsible/Insurance section, the P
button is selected. Click the Post Tran
press Tab. If you have not entered a ba
Contract message is displayed.

14 To enter a banding date, click the cale
Date field and select a date. 

To enter an estimated completion date,
to the Est Comp field and select a date



m the following sections:

 Party—This section displays responsible 
tion as assigned in the Patient Information 
 chart. Although the Financial Estimator 
w only includes fields for RP1 and RP2, you 
y responsible party that is associated with 

s from the following fields:

e the drop-down list to select a responsible 
the contract payments.

e the drop-down list to select a second 
ble party for the contract payments. If the 
has multiple responsible parties, but makes 
s only on the contract, select None. If the 
only has one responsible party assigned, this 
accessible.

 Finance Duration (Months)—Use the 
n list to select how many months the 

lasts.

nter or update the entire amount due for the 
 field is required.

his section displays discounts that can be 
 total amount. You can rename these 
appropriate for your practice. 

s from the following fields:

y Discount—Enter or update a discount 
 for this contract.

ff Discount—Enter or update a discount 
 for this contract.
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Using the Financial Estimator Setup 
Window

You can present contract proposals to responsible parties to 
increase same day starts and signed contracts. Click the 
Financial Estimator Setup button to view an interactive display of 
fee presentation and contract information. Enter financial data and 
use slider controls to instantly update contract details. 

To access the Financial Estimator Setup window:

1 From the patient chart, click the Financial Functions button. 
The Financial Functions window is displayed. 

2 Click the Financial Estimator Setup button. The Financial 
Estimator Setup window is displayed. 

3 Select options fro

• Responsible
party informa
section of the
Setup windo
can select an
the account.

Select option

• RP1—Us
party for 

• RP2—Us
responsi
account 
payment
account 
field is in

• Maximum
drop-dow
contract 

• Total Cost—E
contract. This

• Discounts—T
applied to the
discounts as 

Select option

• Courtes
approved

• Prof/Sta
approved

Financial Estimator
Setup
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• Student Discount—Enter or update a discount 
approved for this contract.

• Family Discount—Enter or update a discount 
approved for this contract.

• Insurance Coverage—This section displays insurance 
information that is associated with RP1 and, optionally, 
RP2, as assigned in the Patient Information section of 
the chart.

Select options from the following fields:

• Insurance RP1—Enter or update the amount that the 
insurance associated with RP1 will pay on the 
contract.

• Insurance RP2—Enter or update the amount that the 
insurance associated with RP2 will pay on the 
contract. If the account only has one responsible 
party assigned, this field is not displayed.

After selecting options in these sections, the amount for the 
Patient's Total Responsibility is displayed. This amount 
updates dynamically when changes are made to other 
financial fields in the window.

• RP Payment—Select options from the following fields:

• RP1 Total—Displays the total amount that the 
responsible party selected as RP1 will pay. You can 
type a new amount in this field to update the total. 

• Existing Balance—If a balance is present on the 
account, this field displays the current amount for 
which RP1 is responsible. You can type a new 
amount in this field to update the balance. If you 
attempt to increase the existing balance, a message 

indicates that the amount ente
than the existing balance.

• Preferred Down Payment—D
the responsible party selected
as a down payment on the tot
amount in this field to update 

• Minimum Down Payment—D
amount that the responsible p
must submit as a down payme
type a new amount in this field
payment.

• RP2 Total—Displays the total 
responsible party selected as 
type a new amount in this field
the account only has one resp
is not visible. 

• Existing Balance—If a balance
account, this field displays the
which RP2 is responsible. You
amount in this field to update 
attempt to increase the existin
indicates that the amount ente
than the existing balance. If the
responsible party, this field is 

• Preferred Down Payment—D
the responsible party selected
as a down payment on the tot
amount in this field to update 
the account only has one resp
is not visible.



 adjust the following:

nt—The top of the Down Payment slider 
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he bottom of the slider. Use the slider to 
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ment—The top of the Monthly Payment 
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—The top of the # of Months slider displays 
the contract. The slider adjusts the number 
ill take to pay off the remaining balance. The 
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Use the slider to update this value.

owing amounts are correct:

ent Cost—The total amount of the contract is 

 line item for each discount approved by 
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surance Coverage—The total estimate of 
e is expected to pay is displayed.

 Responsibility—If an additional 
arty is selected, the amount that will be paid 
nsible party is displayed.
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• Minimum Down Payment—Displays the minimum 
amount that the responsible party selected as RP2 
must submit as a down payment on the total. You can 
type a new amount in this field to update the down 
payment. If the account only has one responsible 
party, this field is not visible.

4 You can select one of the following:

• Cancel—Exits the Financial Estimator Setup window 
without retaining changes.

• Reset—Restores the default amounts for the account to 
the Financial Estimator Setup window.

• Save—Confirms the information and exits the Financial 
Estimator Setup window.

OR

5 To visualize and adjust financial details, click Financial 
Estimator. The Financial Estimator window for the selected 
responsible party is displayed. 

6 Use the sliders to

• Down Payme
displays the t
responsible p
payment amo
displayed at t
update this v

• Monthly Pay
slider display
payment. The
needs to rem
balance. The
the bottom o
value. 

• # of Months
the length of 
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minimum leng
of the slider. 

7 Verify that the foll

• Total Treatm
displayed.

• Discounts—A
your practice

• Estimated In
what insuranc

• Other Party's
responsible p
by that respo
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• Total Responsibility—The total amount due for the 
contract from the selected responsible party is displayed.

• Existing Balance—If a balance is present on the account, 
the amount the selected responsible party has agreed to 
pay is displayed.

• Final Responsibility—The total amount the selected 
responsible party has agreed to pay is displayed.

• RP Down Payment—The amount the selected 
responsible party has agreed to pay is displayed. Use the 
Down Payment slider to adjust this amount.

• Estimated Fee Schedule—The monthly payment amount, 
length of the contract, and final payment amount are 
displayed. Use the sliders to adjust these variables.

8 To select the day that payments are due, click the Payments 
due on day of the month drop-down list.

9 After confirming the amounts, select one of the following:

• Print—Select an option. Click OK or Cancel.

• Cancel—Closes the Financial Estimator RP window. 

• Save—Saves the contract information. The Financial 
Estimator Accepted Amounts window is displayed. 
Close the window or click Print. 

The Financial Functions window is displayed.
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Skill Sharpeners

Exercise 1—Set Up a Contract

Patti Patient is ready to begin treatment. She is self-responsible 
and does not have insurance. How do you set up her contract?

To set up a contract:

1 In the patient chart, click the Financial Functions button. The 
Financial Functions—Charges and Payments window is 
displayed.

2 Click the Contracts and Payment Plans button. The Financial 
Functions—Contracts and Payment Plans window is 
displayed.

3 In the Description field, select a contract description from the 
drop-down menu or add a new description. Press Tab.

4 In the Contract Total field, enter the full contract amount 
before discounts. Press Tab.

5 The total contract amount is displayed next to the first 
responsible party listed in the Responsible/Insurance 
section. Since the first responsible party is paying the entire 
contract amount, press Tab. 

6 In the Initial Fee field, enter the amount of the contract that is 
due on the initial fee due date. Press Tab.

7 In the Payment Amount field, enter the payment amount to be 
paid monthly, quarterly, semi-annually, or annually. Press Tab.

The software calculates the payment amount if you leave this 
field blank and enter the total number of payments in the 
Num. of Payments field. 

8 In the Num. of Payments field, type the number of payments. 
Press Tab. If you entered a payment amount, the software 
calculates the number of payments.

9 In the Init. Fee Du
due to be paid. P

10 In the Cont. Start
contract charge s
system, the date d
a multi-due-date s
the initial fee due

If you want to acc
press Tab. The S
Post Transaction

OR

If you need to sele
while still in the C
term. Press Tab. T
Transactions but

11 Click the Post Tra
not entered a ban
displayed.

12 To enter a bandin
field. To enter an 
type the date in th

13 Click the Close b
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Exercise 2—Set Up a Split Contract

John Doe is starting treatment, and part of the cost will be paid by 
his father’s insurance. How do you set up his contract so the total 
amount is split between the insurance company and the 
responsible party?

To enter a contract with insurance or with multiple responsible 
parties: 

1 In the patient chart, click the Financial Functions button. The 
Financial Functions—Charges and Payments window is 
displayed.

2 Click the Contracts and Payment Plans button. The Financial 
Functions—Contracts and Payment Plans window is 
displayed.

3 In the Description field, select a contract description from the 
drop-down menu or add a new description. Press Tab.

4 In the Contract Total field, enter the full contract amount 
before discounts (includes the responsible party portion and 
insurance carrier portion, if applicable). Press Tab.

5 Type the portion of the contract the first responsible party is 
paying. Press Tab.

The remaining portion of the contract is displayed on the next 
line of the Responsible/Insurance Amount section, and an 
arrow points to the next name in the Responsible/Insurance 
section. Press Tab.

6 In the Initial Fee field, enter the amount of the contract that is 
due on the initial fee due date. Press Tab.

7 In the Payment Amount field, enter the payment amount to be 
paid monthly, quarterly, semi-annually, or annually. Press Tab.

The software calculates the payment a
field blank and enter the total number o
Num. of Payments field. 

8 In the Num. of Payments field, enter th
Press Tab.

If you entered a payment amount, the s
number of payments.

9 In the Init. Fee Due Date field, type the
due to be paid. Press Tab.

10 In the Cont. Start Date field, type the d
contract charge should be applied. In a
system, the date defaults to the roll dat
a multi-due-date system, the date defa
the initial fee due date. 

To accept the default payment term of
The Spread button is selected. Press T
selected.

OR

To select a different payment term for t
Cont. Start Date field select a new pay
The Next button is selected.

11 Click Next or press Tab to continue set
the next responsible party/insurance ca
information for all responsible parties/in
the list. If a responsible party is listed b
contract, press Tab to move through th
the software displays a message, ackn
responsible party being skipped does 
contract. 
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12 After completing the payment information for the last 
responsible party/insurance carrier in the 
Responsible/Insurance section, the Post Transactions 
button is selected. Click the Post Transactions button or 
press Tab. If you have not entered a banding date, the 
Contract message is displayed.

13 To enter a banding date, click Yes and type the date in the 
field. 

To enter an estimated completion date, click Yes and type the 
date in the field.

Exercise 3—Set Up a Contract with Varying Monthly Charge 
Amounts

A patient without insurance is starting treatment for a total of 
$3,500. The patient wants to make an initial payment of $500, 
monthly payments of $100.00 for the first six months, $125.00 for 
the next six months, $150.00 for the next six months, and a final 
balloon payment for the remaining balance. How do you set up 
this contract?

To set up a contract with varying charge amounts:

1 In the patient chart, click the Financial Functions button. The 
Financial Functions—Charges and Payments window is 
displayed.

2 Click the Contracts and Payment Plans button. The Financial 
Functions—Contracts and Payment Plans window is 
displayed.

3 In the Description field, type a contract description. Press 
Tab.

4 In the Contract Total field, type $3,500. Press Tab.

5 An arrow is displa
Responsible/Ins
contract is displa
Press Tab.

6 In the Initial Fee 

7 In the Payment A
Disregard the Nu
calculates the num
the contract using

8 Press Tab and re

9 Deselect the Spr

10 In the payment gr
contract, click in t
Tab.

11 Click Spread.

12 In the payment gr
contract, click in t
Tab.

13 Click Spread.

14 In the payment gr
contract, click in t
Tab.

15 Click Spread.

16 Click the Post Tra
not entered a ban
displayed.
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17 To enter a banding date, click Yes and type the date in the 
field. To enter an estimated completion date, click Yes and 
type the date in the field.

18 Click the Close button.

Exercise 4—Print a Coupon Book

A patient tells you that he has lost his coupon book. How can you 
print a new one for him?

To reprint an entire coupon book:

1 In the patient’s chart, click the Financial Functions button. 
The Financial Functions—Charges and Payments window 
is displayed.

2 On the menu bar, select Reports > Contracts and Payment 
Plans > Coupons. The Print Setup window is displayed. 

3 Select the printer on which to print the coupon book, if 
necessary.

4 Click OK. 

To reprint a coupon book for future payments only:

1 On the main menu, select Reports > Financial > Coupon 
Books. The Coupon Books window is displayed.

2 Select Reprint coupon books, Reprint for future payments, 
and click OK. The Select Patient to Print Coupons window 
is displayed.

3 Select the patient name and click OK. The Print Setup 
window is displayed.

4 Select the printer on which to print the coupon book, if 
necessary.

5 Click OK.

6 Deselect the Spread Evenly option.

7 In the payment grid, scroll to the seven
contract, click in the Amount field, and
Tab.

8 Click Spread.

9 In the payment grid, scroll to the thirtee
contract, click in the Amount field, and
Tab.

10 Click Spread.

11 In the payment grid, scroll to the ninete
contract, click in the Amount field, and
Tab.

12 Click Spread.

13 Click the Post Transactions button or 
not entered a banding date, the Contra
displayed.

14 To enter a banding date, click Yes and
field.

To enter an estimated completion date
date in the field.

15 Click the Close button.
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Before you can 
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payment reports.

Financial Functions

Auto Payments
OrthoTrac Practice Management Software 

sson 11
orking with Auto Payments

is lesson includes:

• Setting Up Auto Payments 

• Editing Auto Payment Records 

e automatic payments feature enables you to enter credit card 
afts, electronic bank drafts, or post-dated cheques to be posted 
regular intervals in the future. After you set up the auto payment 
ormation in the patients’ financial charts, the software can 
tomatically post these payments to their financial ledgers on a 
ily basis. 

etting Up Auto Payments

 set up automatic payments:

In the patient chart, click the Financial Functions button. The 
Financial Functions—Charges and Payments window is 
displayed.

Click the Auto Payments button. The Financial Functions—
Auto Payments window is displayed.

3 Click a tab to select the type of automa
Type additional information in the blank

The following fields require explanation

• Starting Pmt Mth—This is the trea
the payment is allocated. This is us
Canada for insurance receipt purp
payment can be a month ahead or
Otherwise, enter the same month 
previous field, First Payment Due



 the account has a previously authorized 
 file, click Last Card to populate the Acct #, 
d Reference fields.

 complete the following fields:

e—Enter the bank account type.

 the bank account number or the name of the 
tution. 

the fields on the tab, click the Post 
ton. 

 is automatically calculated exceeds the total 
ge is displayed, asking if you want to do this. 
n edit the last payment to match the 
 spread.

ayment Records

unctions—Auto Payments window, you can 
 a payment, insert additional payments 
ment schedule, and add payments to the 
yments.

ayments

to payment information:

ayment you want to change in the Amount 
o payment grid.

yment amount and press Tab or Enter. A 
yed, asking if you want to make this change 
ents. 
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• Reminder Date—This is used when the entire contract 
amount is not covered by the auto payments. The 
reminder date defaults to the month and year after the last 
payment entered. This is useful when a credit card 
expires before the end of the payments, so the 
responsible party must be contacted for the current credit 
card information.

• Receipts—If the patient/responsible party needs more 
than one receipt per payment, enter the number of 
receipts needed here. Receipts can be printed after the 
payment is posted on the appropriate date.

On the Cheque tab, complete the following fields:

• Starting Cheque #—Type the number of the first cheque.

• Acct #—Type the bank account number or the name of the 
financial institution.

On the Credit Card tab, complete the following fields:

• Type of Card—Type the name of the credit card.

• Acct #—Type the entire credit card account number. If you 
use the credit card service, the OrthoTrac Software 
Credit Card Processing Capture Credit Card window is 
displayed when you enter this field. If a card reader is 
connected to the computer, swipe the credit card. When 
you save the information, all digits except the last four are 
replaced with an x as a security measure. Click OK.

• Expiration Date—Type the month and year the credit card 
expires. This field is completed in the OrthoTrac 
Software Credit Card Processing Capture Credit Card 
window, if you are using the credit card service.

• Process Online—Select this to have the credit card 
processing module contact the service center to obtain 
authorization when you post auto payments.

• Last Card—If
credit card on
Exp Date, an

On the Draft tab,

• Account Typ

• Acct #—Type
financial insti

4 After completing 
Transactions but

If the amount that
balance, a messa
Click Yes, but the
contract payment

Editing Auto P

Using the Financial F
change the amount of
within the existing pay
end of the existing pa

Changing Auto P

To change existing au

1 Double-click the p
column of the aut

2 Enter the new pa
message is displa
for all future paym

3 Click OK.

Important

The bank account 
number is not a 
required field. Be 
sure to consider 
security and 
confidentiality 
issues when 
entering this data.

Post Transactions
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Important

If you use OrthoTrac 
version 15.2, but do 
not use the 
ePayments feature, 
you might need to 
export account 
information to your 
third-party processing 
service and delete the 
information from 
OrthoTrac to meet the 
current PCI 
compliance standards. 
To run the PDC Export 
Utility, see the 
OrthoTrac, v15.2, 
online help.

Note

Payments that have 
already been posted 
cannot be removed 
individually.
OrthoTrac Practice Management Software 

Inserting Auto Payments in the Schedule

To insert an additional auto payment in the existing payment 
schedule:

1 In the Sequence column, select the auto payment on the list 
that you want to display after the new auto payment and click 
Insert. 

2 Enter the new payment information. As you are changing the 
fields, several messages are displayed, asking you if you want 
to make this change for all future payments.

3 Press Tab or Enter when finished.

Adding Auto Payments to the End of the Schedule

To add an auto payment to the end of existing payments:

1 Click Add New. A window is displayed on top of the grid.

2 Enter the additional payment information and click OK.

Removing Auto Payments

To remove an auto payment:

1 In the Sequence column, click the number of the payment you 
want to remove to select the payment. Payments that have 
already been posted cannot be removed individually.

2 Click Remove. 

A message might be displayed, warning you that the account is 
set up to be debited for a greater amount than what is owed.
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Skill Sharpeners

Exercise 1—Create an Auto Payment

Patti Patient has a treatment plan and asks to set up an auto 
payment plan. How do you set it up for her?

1 In Patti’s chart, click the Financial Functions button. The 
Financial Functions—Charges and Payments window is 
displayed.

2 Click the Auto Payments button. The Financial Functions—
Auto Payments window is displayed.

3 Click a tab to select the type of auto payment you want to set 
up. Type information in the fields.

4 After completing the fields on the tab, click the Post 
Transactions button. 

If the amount that is calculated exceeds the total balance, a 
message is displayed, asking if you want to do this. Click Yes, 
but then manually edit the last payment to match the contract 
payment spread.

Exercise 2—Change an Auto Payment

To change an auto payment:

1 Double-click the payment you want to change in the Amount 
column of the auto payment grid.

2 Enter the new payment amount and press Tab or Enter. A 
message is displayed, asking you if you want to make this 
change for all future payments. 

3 Click OK.
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Note

In version 14.0, set 
your screen resolution 
to 1440 x 900 to fully 
display the Treatment 
Card window.

Tip

When the Charting 
module is open for a 
patient, an i icon is 
displayed on the 
ToothChart, TxPlan, 
Questionnaire, or 
Notes tabs if the tab 
contains patient 
information.

Note

In addition to the 
patient’s birth date, 
the Happy Birthday 
indicator is displayed 
during the month of 
the patient’s birthday.

Charting
OrthoTrac Practice Management Software 

sson 12
orking with the Charting Module

is lesson includes:

• Tx Card Tab 

• ToothChart Tab 

• Questionnaire Tab 

• Notes Tab 

• Imaging Tab 

• TxPlan Tab 

• Searching Treatment Card Histories 

• Printing Reports 

e OrthoTrac Charting module is an electronic chart containing 
atment plans, treatment history information, and questionnaires 
 each patient. When combined with orthodontic imaging 
ftware, the patient’s entire chart is available at chairside.

ing the Charting module, you can:

• Enter or edit any part of today’s treatment history.

• Store and display information about medical alerts, 
progress reviews, and the next appointment for a patient.

• Print treatment card reports.

u can set predefined views within Charting that can apply to all 
rkstations or an individual workstation. You can also use the 
ssic view, if you prefer the original look of the treatment card.

To access a patient’s treatment card:

1 Open a patient’s chart. Patient informa

2 Click the Charting button. 

3 Select Edit Charting. The Charting wi
the Tx Card tab open.

Tx Card Tab

When you open the treatment card, patien
displayed in the top section: 

• Birthday
• Age
• Gender
• Dentist 
• Tx Status



 appointments
rackets

liances

y

ry section includes these column headings:

he sequence number of each entry. 
nd optional Patient Tracking data are not 

te that the treatment card entry was made.

t. This field is automatically populated, 
 staff member logged in, or when you select 
nt Card and assign an assistant. To change 

ick on the field.

This field is automatically updated when you 
eatment Card. To change doctors, click on 

t Coordinator. This field is optional and is 
 populated, based on the TC assigned to the 
en you select Edit Treatment Card and 
To change the TC, click on the field. 

iene. This column enables the office to track 
giene habits throughout treatment. A list of 
odes is provided.

 Displays the procedure codes performed 
atment visit. 
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Patient Insight Panel

On the Treatment Card, below patient information, is a drop-down 
arrow. Click this arrow to display the Patient Insight panel, which 
provides an overview of treatment progress.

The Patient Insight panel includes these tabs:

• Phase I
• Start date
• Estimated completion date
• Completion date
• No Show appointments
• Cancelled appointments
• Changed appointments
• Broken brackets
• Wires
• Lost appliances
• Notes

• Monitoring
• Start date
• End date
• Notes
• Recall appointment
• Recall schedule (3 months, 6 months, 12 months, 

others, and alpha)
• Recall type
• Comments

To add a patient's recall, click Add Recall.

• Full Treatment
• Start date
• Estimated completion date
• Completion date
• No Show appointments
• Cancelled appointments

• Changed
• Broken b
• Wires
• Lost app
• Notes

Treatment Histor

The Treatment Histo

• #—Displays t
Comments a
numbered.

• Date—The da

• AS—Assistan
based on the
Edit Treatme
assistants, cl

• DR—Doctor. 
select Edit Tr
the field.

• TC—Treatmen
automatically
patient, or wh
assign a TC. 

• OH—Oral hyg
a patient’s hy
oral hygiene c

• Procedures—
during this tre

Note

Offices using the 
Zuelke Financial 
Module see only the 
Full Treatment tab so 
that all reports work 
properly.
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• Treatment Notes/Comments—Displays the procedure 
code descriptions. Additional notes or comments are 
displayed after the procedures. 

• MA—Medical alert. After you acknowledge the medical 
alert, this column is displayed.

• Late/Early—Displayed only if you enabled Patient Flow. 

Mechanics/Documents/Events/Aligner Tracking 
Tabs

Below the treatment history are tabs that enable you to view 
details about the treatment, show documents and events, and use 
aligner tracking. 

Mechanics Tab

Click the Mechanics tab to see details about the treatment.

Documents Tab

Click the Documents tab to see a list of documents attached to 
the patient.

Events Tab

Click the Events tab to see the following data from the Patient 
Information window: start date, estimated completion date, 
appointment information, referrals, doctor, model number, and last 
review. 

Aligner Tracking Tab

Click the Aligner Tracker tab to view upper and lower aligner tray 
information for a patient. By default, 80 trays are available. 

The Original Series section of the Aligner Tracking tab estimates 
which tray the patient is using, based on the date and instructions. 
Aligner Tracking calculates when the last aligner tray was started 
and counts days relative to the system date. Each time the 

threshold for wearing the tray is met, the st
that aligner tray.

The tray that the patient is currently using i
After the tray is verified, the label color cha

To edit aligner tracking information:

1 In the Aligner Tracking area, click the 
Aligner window is displayed. 

2 Specify aligner options: 

• Is This a Refinement—Select Yes
whether this aligner tray is a refinem
the Refinement # field becomes a
3 from the drop-down box.

• Start Date—Type the start date for
the calendar icon and select a dat

• # of Aligners—Select the number 
be used from the drop-down box. 

• Brand—Select the brand of the alig
treatment from the drop-down box

• Delivered to Patient—Type the ran
aligner tray will be worn by the pat

• Usage—Select Full Time or Part T
whether the aligner tray will be wo



tment Card Entries

t card data only on the day it is entered. The 
nged include AS, DR, TC, OH, 
TREATMENT NOTES/COMMENTS. 

oday’s treatment data: 

atment card, select Edit > Edit Today’s 
dit Today’s Treatment Card Entries 
ed.

n:

 procedure codes and treatment 
nts in a line, click in the DEL column. 

ividual procedure codes, click once in the 
ES column. The Procedures window is 
the Selected Procedures section, select 
e you want to remove and click the arrow 
OK.

hange the text in the TREATMENT 
MENTS column, select the text and make 

 To add additional text, click in the blank line 
 of the window and type the text. 
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time or for a shorter amount of time designated by the 
doctor. 

• Changing Trays—Select the day interval for changing 
trays from the drop-down box.

• Instructions / Notes—Type additional treatment 
instructions and information.

3 Click Apply.

Appointment Information

On the right of the treatment card, you can view information about 
the current appointment in the Today’s Appointment section.

Using the Next Appointment Section

In the Next Appointment section, you can enter and store 
information about the patient’s next appointment. This information 
is passed to the front desk when a patient is checked out. 

If the patient has an active treatment plan, the next appointment as 
defined in the treatment plan is displayed. 

To enter the next appointment for a patient:

1 In the When field, select when the next appointment should 
be scheduled (Days, Weeks, or Months). Tab to the next field 
and enter the number of days, weeks, or months.

2 Click in the Type field. The Appointment Types window is 
displayed. Select the appointment type for the patient’s next 
appointment and click OK. 

3 In the Comment field, enter a comment, if necessary.

4 Click in the Procedures field or press Enter. The Procedures 
window is displayed. Double-click the procedures to be 
performed at the next appointment. 

5 Click OK.

Editing Today’s Trea

You can edit treatmen
fields that can be cha
PROCEDURES, and 

To make changes to t

1 In the patient’s tre
Treatment. The E
window is display

2 Select your optio

• To delete the
notes/comme

• To delete ind
PROCEDUR
displayed. In 
the procedur
button. Click 

• To delete or c
NOTES/COM
the changes.
at the bottom

3 Click OK.

Important

Add procedure 
codes from the 
main treatment 
card, not in the Edit 
Today's Treatment 
Card Entries 
window. 
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ToothChart Tab

Use the ToothChart tab to enter a list of elastics currently used for 
a patient, as well as a graphic representation of the elastic 
placement. You can designate teeth as primary, permanent, or 
extracted; enter band and bracket history; and track arch wires, 
appliances, and so on.

To display the tooth chart, click the ToothChart tab. 

Using Tooth Numbering

You can select the Palmer, Universal, or FDI Two-Digit 
numbering system when using the tooth chart. This setting is per 
workstation and must be set on each computer.

In the Tooth Numbers section, select the appropriate option. 
When you hover over a tooth with the cursor, the tooth is shaded, 
and the tooth number is displayed at the center of the tooth chart. 
If you select Show On Chart, the description of the tooth is 
displayed with the tooth number.

Changing the Tooth Display

When you open the tooth chart for the first
displayed as permanent. You can right-clic
list of tooth display options. Using the optio
can change a permanent tooth to a primary
tooth was extracted or missing. You can al
tooth has a crown or is an implant.

To change a tooth:

1 Move the cursor over the tooth you wa
right-click on it. A menu is displayed.

2 Select the appropriate option.

Adding Elastics

You can enter information about elastic typ
times elastics should be worn. 

To add elastics for a patient:

1 In the Elastics section, click Predefine
from List window is displayed. 

2 Select an elastic option from the list an
chart is displayed. 



 Instructions and Extraction Instructions

ation about elastic wear and extractions in 
ttom of the tooth chart. 

ns that you type in the Elastic Wear 
re printed on the tooth chart. These 
isplayed in letters when you use the 
ctions>> merge field. 

ype in the Extraction Instructions section 
th chart. These instructions are also 
en you use the 
ions>> merge field.

or extraction instructions:

ic Wear Instructions or Extraction 
ion and type the instructions, or click the 
n to select from a list of predefined 

r extraction, right-click on the tooth and 
e Extraction Instructions are displayed 
n a tooth is marked for extraction
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The software displays a message if you attempt to apply a 
predefined configuration to a patient that is missing a required 
tooth.

3 In the Elastics section, use the drop-down list in the Type 
field to select the elastic type.

4 Select an option button for the times the elastics are to be 
worn.

5 Select the starting tooth and click the left mouse button.

6 Move the cursor to the tooth to which the elastic connects 
and click the left mouse button.

7 Click OK. 

8 Click Apply on the ToothChart tab.

Adding Bands and Brackets

You can enter information about the types and sizes of brackets 
and bands you installed in the Band/Bracket History section.

To add brackets or bands to the tooth chart:

1 Select the tooth to which you want to attach a band or 
bracket.

2 In the Band/Bracket History section, click +. The 
Band/Bracket History window is displayed.

3 Select the band/bracket size and click OK.

4 Click Apply.

Adding Elastic Wear

You can include inform
the sections at the bo

Elastic wear instructio
Instructions section a
instructions are also d
<<ElasticWearInstru

Instructions that you t
are printed on the too
displayed in letters wh
<<ExtractionInstruct

To enter elastic wear 

1 Click in the Elast
Instructions sect
Predefined butto
comments.

2 To mark a tooth fo
select Extract. Th
automatically whe

3 Click OK.
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 to the left of a note. To 
 click the Heart icon 

Tab icon at the bottom 
ach Tab icon again.

Note

To view completed 
questionnaires in 
list format, select 
Maintenance/Set- 
up > Charting 
Maintenance > 
Show Completed 
Questionnaires in 
list format.

Important

Notes are not 
intended for use 
as legal medical 
records.

Note

Deleting a note 
enables the Undo 
function. The note 
is fully deleted 
when you click 
Save and Close. 
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Questionnaire Tab

The Questionnaire tab enables you to access the 
communications questionnaires used in the OrthoTrac 
communications module. 

To use communications questionnaires in the Charting module:

1 In the Treatment Card window, click the Questionnaire tab. 

2 To view previous questionnaires for this patient, use the 
drop-down list in the Completed Questionnaires field.

OR

To execute a new questionnaire, click Execute 
Questionnaire. 

The Execute Questionnaire window is displayed.

3 Select the questionnaire you want to work with and click 
Select. 

Notes Tab

The Notes tab enables you to enter and vie
patient's treatment plan. Each note displays
name of the user who created or edits it, as
date it was added. 

To manipulate the text and change the font
other formatting, use the formatting bar at t
field. There is a 32,000 character limit for e

To save a note, click Save. 

After saving a note, you can:

• Edit the note using the Pencil icon

• Delete the note using the Trash C

• Hide the note using the Eye icon.

Additional notes are added to the display li
order, with the newest note at the top.

You can prioritize an important note by pinn
the Pinned Note area, click the Heart icon
remove a note from the Pinned Note area,
again.

To detach the Notes tab, click the Detach 
of the window. To reattach it, click the Det
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 the orthodontic imaging program, click the 
e functions of orthodontic imaging from the 
rd.

imaging documentation for more 

eries of steps used to define a patient’s 
he TxPlan tab enables you to add an 

n template for a patient or create a new one. 
isting treatment plan template to a patient, 

eps within the template and customize it for 

ltiple treatment plans, but only one plan can 

nt Plan

an template to a patient’s treatment card:

 Card window, select the TxPlan tab. The 
 displayed. 

xPlan. The Add Treatment Plan window is 

 Treatment Plan Template option. 

py Treatment Plan window is displayed.

t plan template in the list and click Copy. 
lan Title window is displayed.
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To save your notes and close the view, click Save and Close. To 
cancel your changes, click Cancel.

You can use shortcuts when entering notes:

• If you type a forward slash (/), a comment code, and 
press the spacebar, the software displays the entire 
comment. 

Example:  Type /T11 and press the spacebar on the 
Notes tab. The software displays Fixed appliance 
therapy in the notes.

• To display a list of predefined comments, type forward 
slash (/), question mark (?), and space. Click the 
Predefined button to display the same list of comments. 
Select a comment and click OK to place the comment in 
the notes.

• Add date, time, and staff member information by using the 
Edit menu or a shortcut key. To add these options to your 
notes, position your cursor where you want to insert the 
option and press the corresponding shortcut key:

• Date—F5
• Date/Time—F6
• Staff Name—F7
• Staff Name/Date—F8

• Change the formatting of note text using these keyboard 
shortcuts.

• Align Left—Ctrl+L
• Align Center—Ctrl+E
• Align Right—Ctrl+R
• Font Name—Ctrl+N
• Font Size—Ctrl+S
• Font Color—Ctrl+F

Imaging Tab

If you purchased Orth
is displayed. To open
tab. You can use all th
patient’s treatment ca

See your orthodontic 
information.

TxPlan Tab

A treatment plan is a s
course of treatment. T
existing treatment pla
After you assign an ex
you can modify the st
the patient. 

A patient can have mu
be active at a time. 

Adding a Treatme

To add a treatment pl

1 In the Treatment
TxPlan window is

2 Click Add New T
displayed.

3 Click the Select a

4 Click OK. The Co

5 Select a treatmen
The Treatment P
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6 Type a new name for this treatment plan template, if 
necessary, and click OK. 

The Charting—TxPlan window is redisplayed with the 
treatment plan template information.

7 Click Activate to activate the treatment plan for this patient.

8 Click the TxCard tab. Enter the procedures or comments 
about the procedures performed today. 

The information about the first treatment plan appointment is 
displayed in the Next TxPlan Appointment section.

9 Click OK.

Checking Out a Patient with an Ac
Plan

To check out a patient with an active treatm

1 After entering procedures and comme
day’s treatment in the treatment card, c
patient chart.

2 Click the Patient Checkout button. Th
Functions—Charges and Payments w

3 Enter the charges and payments in the
Post Transactions button. 

4 Click Close. The Appointment Survey

5 Click Schedule Appt. The View Sche
displayed. 

6 In the TxPlan Detail standard, the proc
the next appointment is displayed. Clic
The View Schedule window displays a
times corresponding to that procedure

7 Select an appointment time. The appo
displayed, including the patient name, 
type, time units, and any comments.



llbar to view all of the time line information. 

Show Descriptions option to display only 
time line.
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d per clinical hour.

ormation to change the information in any of 

reatment Plan

n is assigned to a patient, you can:

ted, scheduled, and remaining steps
ment history for completed steps
k a step as completed
g plan
activate a plan

Scheduled/Remaining Steps

 in a treatment plan by clicking the TxPlan 
lan window is displayed. 

the steps in a treatment plan:

atment plan name to display the time line.

pleted step, in dark green, or a scheduled 
green, to display information about the 
in the Appointment History section.
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8 Select the TxPlan option. The window expands, showing the 
details of the Next Appointment section of the patient’s 
treatment card.

9 Click Paste.

10 Click OK.

11 Click Close.

Using the TxPlan Time Line

After you schedule the first appointment for a treatment plan, you 
can view a time line illustrating the patient’s treatment by clicking 
the TxPlan tab in the patient chart.

The time line displays the appointment types and approximate 
dates the appointments are to be scheduled. 

The appointment types in the time line and the Treatment Plan 
window are color-coded. The colors include:

• Dark green—Completed 
• Light green—Scheduled/on target
• Blue—Targeted future date
• Red—Off target
• Purple—Emergency appointment

To use the time line:

• Click the scro

• Deselect the 
dates on the 

• Click View T
plan; the leng
description; a
per month, an

• Click Edit Inf
the fields.

Working with a T

When a treatment pla

• View comple
• View appoint
• Manually mar
• Edit an existin
• Activate or de

Viewing Completed/

You can view all steps
tab. The Treatment P

To view details about 

• Select the tre

• Select a com
step, in light 
appointment 

Important

When scheduling a 
treatment plan 
appointment, you 
must select Paste 
to attach the 
procedures to the 
appointment and 
keep the 
treatment plan on 
track.
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• Select one of the remaining steps, in blue, to display 
information about the steps in the Step Details section.

• Click the plus sign in front of the bracket icon to display 
the procedures and activities associated with the step.

Manually Marking a Step as Completed

If you complete a step ahead of schedule, you can mark the step 
as completed by selecting the step and clicking Mark as 
Completed. A message is displayed, stating that the change will 
be made when you exit the treatment card.

Editing a Treatment Plan

With the Treatment Plan window displaying a treatment plan, use 
the following buttons to make changes to the patient’s treatment 
plan:

• Edit—Click to change the name of this treatment plan. 

• Delete—If you have not scheduled an appointment for a 
treatment plan, you can delete the treatment plan by 
selecting the treatment plan name and clicking Delete. 

• Add—Click to add steps to the treatment plan for this 
patient. Select whether to add a predefined step or 
create a new step. The step is added to the bottom of the 
list. Use the arrow buttons at the bottom of the window to 
position the step in the appropriate area.

• Insert—Click to insert a step in the treatment plan. Select 
the step you want to be below the new step and click 
Insert. Select whether to add a predefined step or create 
a new step. The step is added above the step you 
selected.

• Change—Click to change a step in the treatment plan. 
Select the step you want to edit and click Change. The 

Change Step window is displayed
step as necessary.

• Remove—Click to remove a step fr
Select the step you want to remov

Activating or Deactivating a Plan

After adding a treatment plan to a patient’s
Activate and schedule the first appointmen
Once a treatment plan is activated, the stat
and cannot be changed.

If you need to deactivate the treatment plan
Patient appointments are no longer pre-po
Appointment section of the treatment card

After you post procedures to a treatment p
cannot be deleted; however, you can add a
as long as you deactivate the existing plan.
active at a time.

When you deactivate a treatment plan, use
the Status field to select a status, indicatin
deactivating the plan. 

Scheduling Future TxPlan Appoin

After scheduling the initial treatment plan a
step in the plan is displayed in the Treatme
window. To schedule the next appointment
available time, which should be within seve
date shown in the window. If the appointme
than seven days from the target date, an O
displayed in the Schedule Appointment w
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tment card, select Edit > Search Tx Card 
rch Tx Card window is displayed.

edure code to search for, click the code in 
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 list.
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e code and click View. 

tment Card History by Date

treatment card history by date:

Card window, select Search by Date. The 
window is displayed.

te field, type the date for which you want to 

 section of the patient’s treatment history 
te you selected is displayed.
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Printing a Treatment Plan

You can print an office copy and a patient copy of a treatment 
plan. The office copy contains the entire plan information except 
the patient description. The patient copy prints the step title and 
the information entered in the Patient Description of the 
treatment plan step.

To print the treatment plan:

1 With the patient’s treatment card open, select one of the 
following:

• File > Print Tx Plan > Patient Copy 

• File > Print Tx Plan > Office Copy

The Treatment Plan Print Options window is displayed.

2 On the Print Options window, select Print Report, Preview 
Report, or Export Contents.

3 Use the drop-down list to select a printer, if necessary, and 
click OK.

Completing a Treatment Plan and Updating the 
Treatment Plan Status

When you type the information for a patient’s last treatment plan 
appointment in the Charting—TxCard Tab window and click OK, a 
message is displayed, asking if you want to deactivate the plan 
and update the status.

To deactivate the plan and update the treatment plan status:

1 In the Treatment Plan message window, click Yes. The 
Select Treatment Plan Status window is displayed. 

2 Highlight the new status and click Select.

Searching Trea

You can perform a se
procedure or by date.

Searching a Trea

To search a patient’s 

1 In a patient’s trea
History. The Sea

2 To select the proc
the Available Pro
Single-arrow but
procedures to the

3 Click Search. A l
criteria is displaye

4 To view the proce
select a procedur

Searching a Trea

To search a patient’s 

1 In the Search Tx 
Search Tx Card 

2 In the Search Da
search.

3 Click Search. The
containing the da
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Printing Reports

Several reports enable you to track a patient’s treatment card 
information. The following treatment card reports are available by 
selecting Reports > Charting from the main menu:

• Bracket Tray Covers
• Patients with Appt on Specific Date
• Patients Scheduled with No History
• History for Range of Dates
• History for Range of Patients

To print a report:

1 From the main menu, select Reports > Charting and one of 
the report options.

2 Depending on the report option you select, an interim window 
is displayed, enabling you to select specific criteria you want 
to include in the report. Click Print. The Print Options 
window for that report type is displayed.

3 On the Print Options window, select Print Report, Preview 
Report, or Export Contents.

4 Click OK.



nt is not in the list, click <Free Form>. The 
pt window is displayed.

ry and click OK. A message asks if you 
this entry to the list for future use. Select No.

layed on teeth that have history information 
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 Activate a Treatment Plan

an to a patient’s treatment card:

 Card window, click the TxPlan tab. The 
 displayed. 
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 Treatment Plan Template option. 
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t plan template in the list and click Copy. 
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Skill Sharpeners

Exercise 1—Add Elastics

You are applying elastics and bands to a new patient. How do you 
chart the procedures?

To add elastics:

1 In the Elastics section, click Predefined. The Select Item 
from List window is displayed.

2 Select an elastic option from the list and click OK. The patient 
chart is displayed.

3 In the Elastics section, use the drop-down list in the Type 
field to select the elastic type.

4 Select an option button for the times the elastics are to be 
worn.

5 Select the starting tooth and click the left mouse button.

6 Move the cursor to the tooth to which the elastic connects 
and click the left mouse button.

7 Click OK.

Exercise 2—Add Brackets and Bands

To add brackets or bands to the tooth chart:

1 Select the tooth to which you want to attach a band or 
bracket.

2 In the Band/Bracket History section, click <Add New 
Entry>. The Band/Bracket History window is displayed.

3 Select the entry you want to display in the Band/Bracket 
History section and click OK. The entry is displayed in the 
section, along with the current date.

If the entry you wa
Free Form Prom

4 Type the new ent
would like to add 

An “i” icon is disp
or comments atta
history or comme

5 Click Apply on th

Exercise 3—Add and

To add a treatment pl

1 In the Treatment
TxPlan window is

2 Click Add New T
displayed.

3 Click the Select a

4 Click OK. The Co

5 Select a treatmen
The Treatment P

6 Type a new name
necessary, and cl
displayed with the

7 Click Activate to 

8 Click the TxCard
about the proced

9 Click OK.
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Note

Your office practices 
determine the 
destinations used in 
your Patient Flow 
setup.

Patient Flow
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sson 13
orking with the Patient Flow Module

is lesson includes:

• Understanding the Patient Flow Window 

• Understanding the Light Bar 

e OrthoTrac Patient Flow module is an electronic patient 
nitoring system that enables you to keep track of the patients in 

ur office.

e basic Patient Flow module sequence is as follows:

You check a patient in for the appointment OR the patient 
checks in using a computer in the lobby.

When your staff is ready for the patient, a staff member moves 
the patient from the Lobby to the In Deck or Operatory. 

When the patient’s treatment is finished, a staff member 
moves the patient from the Operatory to the Out Deck or 
Check Out area. 

When the staff member moves a patient to Check Out, the 
patient is moved to Gone automatically.

r more information about using the Patient Flow module on the 
tient check-in computer, see the online help.

Understanding the Patient Fl

To access the Patient Flow module from th
Patient Flow button. If you are the first use
Flow module for the day, the Preparing to 
window is displayed. Click Yes. 

The Patient Flow window is displayed.

The row of icons at the top of the window i
destinations to which you can move a patie
workstation. The locations include:

• Lobby
• In Deck
• Operatory
• Out Deck
• Check Out
• Gone
• Cancelled



 at the bottom of the window enable you to 
 Flow module display:

—If you configured the Patient Flow module 
y patients within a specified time limit (for 
minutes), click Earlier Appts to display all 
 had appointments more than 60 minutes 

—Click to display the Patient Flow Setup 
ance window, which enables you to change 
tient Flow module settings. 

Click to add a patient to the Patient Flow 
“Adding Patients in the Patient Flow 
age 116 for more information.

to close the Patient Flow module.

If you configured the Patient Flow module 
y patients within a specified time limit (for 
minutes), click Later Appts to display all 
 have appointments more than 60 minutes 
ent time.
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The following fields can be displayed: 

• Patient Name—Name of the patient

• Location—Patient’s current location in the office

• Here—Number of minutes at the current location

• Appt Type/Procedure Type—Type of appointment or 
procedure

• Ch—Assigned chair

• Appt Tm—Scheduled appointment time

• Check In—Patient’s check-in time

• Status—Indicates if the patient is early, late, or a no-show

• Total—Total time spent in the office

• Doctor—Name of the doctor

• Assistant—Name of the assistant

If your office has enabled the Warning Information System, the 
following conditions can exist:

• The Location column flashes if the staff has broken a time 
constraint.

• The Status column flashes if the patient has broken a 
time constraint.

An asterisk (*) or a plus sign (+) beside a patient’s name indicates 
that a comment is attached to the patient’s check-in record. 

If you are using the check-in message feature, an @ before the 
patient name indicates that a check-in message exists for the 
patient.

The following buttons
customize the Patient

• Earlier Appts
to display onl
example, 60 
patients who
ago. 

• Maintenance
and Mainten
any of the Pa

• Add Patient—
module. See 
Module” on p

• Close—Click 

• Later Appts—
to display onl
example, 60 
patients who
from the curr
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rocedure, current 
only.

lds, use the drop-down 
sary.

tient Comment, Staff 
e the message in the 

nation or to a 
ce than the current 
by), the software 
 click Yes, the time 

t location is lost.

r, cancel the check-in 

 location you dropped 
cation section. Click 

g methods, the 
 location; for example, 
u use the In Deck 
 the desired location 

Tip

You can drag a 
patient’s name or 
picture from the grid 
directly to a chair. 

Note

The Change 
Patient’s Location 
window is displayed 
only if you have 
previously enabled it. 
To enable this 
window, select 
Maintenance/
Set-up > Patient 
Flow Options > 
Grid Setup > 
Display Change 
Patient Location.

Note

The patient sees the 
Patient Comment 
as soon as he checks 
in. Enter only the 
comments you want 
the patient to see.
OrthoTrac Practice Management Software 

Changing Patient Locations

When you move a patient from one location to another, the 
software tracks the time the patient spends in the new location. 
Depending on the way their computers are configured, other staff 
members can view the patient’s new location on their monitors.

If you purchased the Charting module, you can configure the 
software to automatically load the Charting module when patients 
are moved to the operatory. You can also set up the software so 
that patient checkout is automatically loaded when patients are 
moved to Check Out. 

To change a patient location:

1 Select one of the following methods of changing a patient’s 
location: 

• Dragging and dropping
• Double-clicking
• Right-clicking

After moving a patient, the Change Patient’s Location 
window is displayed.

The Change Patient’s Location windo
about the patient’s appointment. The p
appointment type, time and length of p
location, and time at location are view-

2 In the Doctor, Assistant, and Chair fie
lists to change the information, if neces

3 To add or change a message in the Pa
Comment, or Check-In Msg fields, typ
appropriate field. 

4 If you move a patient to the same desti
destination that is earlier in the sequen
location (for example, Operatory to Lob
displays a confirmation message. If you
already recorded for that patient in tha

If you have checked in a patient in erro
by changing the location to Not Here.

5 When you drag and drop a patient, the
the patient in is selected in the New Lo
OK. 

With the double-clicking or right-clickin
software automatically selects the next
if the patient was in the Lobby, and yo
option, then In Deck is selected. Click
and click OK.



 the Light Bar

Charting module along with the Patient Flow 
ay a Light Bar to the right of the Patient Flow 
y a stand-alone Light Bar. To choose an 

nance/Set-up > Patient Flow Options > 

ht Bar represents a treatment chair. The 
signed to each chair, the appointment type, 
 or late status are displayed in each block.

t Bar includes a dynamic clock icon, which 
emaining chair time for an appointment. 
ount of appointment time already spent. 
remaining to spend with the appointment. 
he chair beyond the scheduled appointment 

hange colors depending on the action taken 
 are white when vacant and change to light 
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Checking In Patients with Check-In Messages

A patient might receive a message at check-in that the check-in 
process cannot be completed and to see the receptionist. This 
means that a check-in message has been placed in the patient’s 
chart, either automatically by the software or by a staff member. 

To check in a patient with a check-in message:

1 Open the Change Patient’s Location window for the patient, 
using one of the methods described under “Changing Patient 
Locations” on page 115. 

2 In the Check-In Msg section, view the message and take the 
appropriate steps to resolve the condition; for example, 
having the patient sign a form, speaking to a parent about a 
late payment, and so on.

3 In the New Location section, Lobby is selected. Click OK.

Adding Patients in the Patient Flow Module

You can add patients to the day’s schedule from within the Patient 
Flow module; however, the software treats a patient added in the 
Patient Flow module as a walk-in patient.

To add a patient in the Patient Flow module:

1 Click Add Patient at the bottom of the Staff - Text-Based 
display window. The OrthoTrac Software Patient Lookup 
window is displayed.

2 Select the name of the patient to add and click OK. The Add 
Patient to Patient Flow System window is displayed.

3 Use the drop-down list in each field to select the appropriate 
information. To add a staff or patient comment, type the 
comment in the appropriate field.

4 Click OK.

Understanding

If your office uses the 
module, you can displ
grid, or you can displa
option, select Mainte
Light Bar Options. 

Each block on the Lig
name of the patient as
and the patient’s early

Each chair on the Ligh
tracks the amount of r
Blue indicates the am
Green indicates time 
Red indicates time in t
time.

The Light Bar chairs c
for each chair. Chairs
blue when occupied.

Note

On the Patient Flow 
staff displays, an @ 
symbol beside the 
patient name indicates 
that the patient has a 
check-in message 
attached to his chart.

Note

With version 14.0, a 
stand-alone Light Bar 
is the default setting.
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elects Dr. Is Here and 
e color bar stops 

 color bar changes to 

 location you dropped 
cation section. Click 

g methods, the 
xample, if the patient 
eck option, then In 

ation and click OK.

Tip

To move from one 
patient’s treatment 
card to another, 
right-click on an 
occupied chair and 
select Load 
Charting.

Note

Your office may not 
use all Patient Flow 
locations.
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Using the Light Bar Menu

Click on a patient in a chair to display the Light Bar menu. Use this 
menu to call the doctor to a specific chair when a patient is ready 
or when a patient has an emergency.

Table 1 shows the options available on the Light Bar menu.

To use the Light Bar:

1 Click or right-click on an occupied cha
Bar menu.

2 Select Call Dr. (Normal) or Call Dr. (E
pop-up window is displayed. 

3 Select Doctor 1, or select the appropr
from the list, if your office has more tha

4 If you click on another chair and select 
the same doctor or a new one. 

5 If you select Any Doctor, the top portio
not change, while the bottom portion c
to dark green and begins flashing. A tim

When the doctor answers the call and s
his doctor number, the top portion of th
flashing, and the bottom portion of the
teal.

6 When you drag and drop a patient, the
the patient in is selected in the New Lo
OK. 

With the double-clicking or right-clickin
software selects the next location; for e
was in the Lobby, and you use the In D
Deck is selected. Click the desired loc

Table 1 Light Bar Menu Options 

Action Effect on Chair Next Waiting

Call Dr. (Normal)
Dr. color is displayed solid.
Green flashing (time 
counter begins)

None

Call Dr. 
(Emergency)

Dr. color is displayed solid.
Red flashing (time counter 
begins)

None

Doctor is Here
Doctor color is displayed 
solid.
Teal

Automatically 
cancelled in previous 
chair if Doctor Is Here 
is selected in another 
chair. Color changes 
back to light blue.

Cancel Call for 
Doctor Light blue

Load Charting None None

Move Patient to...

Lobby
In-Deck
Out-Deck
Check-Out
Gone

Moving the patient to 
any of these locations 
empties the operatory 
chair.

Cancel None
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Skill Sharpeners

Exercise 1—Add a Patient in the Patient Flow Module

A patient without an appointment comes in and asks if he can 
make an appointment. You can use the Patient Flow module to 
schedule walk-in appointments. 

To add a patient in the Patient Flow module:

1 Click Add Patient at the bottom of the Staff - Text-Based 
display window. The OrthoTrac Software Patient Lookup 
window is displayed.

2 Select the name of the patient to add and click OK. The Add 
Patient to Patient Flow System window is displayed.

3 Use the drop-down list in each field to select the appropriate 
information. To add a staff or patient comment, type the 
comment in the appropriate field.

4 Click OK.

Exercise 2—Move a Patient from One Location to Another

A patient has checked in for his appointment using a computer in 
the lobby. Move the patient from the lobby to the operatory. 

To change a patient’s location:

1 Select the patient.

2 Click the Patient Flow button. If a message is displayed, click 
Yes. The Charting/Patient Flow window is displayed.

3 Click-and-drag the patient to the In Deck or Operatory icon. 
The Change Patient’s Location window is displayed. 

4 Click OK and move the patient to the Out Deck or Check Out 
icon. 
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 the Roll Options 

e Age only (ages 
ctions section is 
ontracts sections are 

uld run the roll a 
nd apply late charges.

Caution

Do NOT exit from the 
roll process once it 
has begun.

Important

In the event of a 
system failure 
during the roll, it is 
critical that you have 
a backup.
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sson 14
unning the Roll and Generating Statements

is lesson includes:

• Running the Financial Roll 

• Generating and Printing Statements 

unning the Financial Roll

e roll enables you to apply contract charges and late charges to 
tient accounts and to age the balance. Before running the roll, 
int and close the current daysheet, and perform a daily backup.

 run the roll:

On the main menu, select Reports > Financial > Roll > Roll 
Accounts. A message is displayed, stating that all other 
workstations must exit the OrthoTrac software and asking if 
you are sure you want to do this.

Click Yes. A message is displayed, asking if you have done a 
daily backup.

If you have not done a backup, click No to return to the main 
menu and perform a backup. If you have performed the 
backup, click Yes. 

Several messages are displayed as the software prepares the 
data for the roll. This process can take several minutes, 
depending on the size of your data. 

When the data is prepared for the roll,
window is displayed.

If this is the first roll after conversion, th
*ALL* accounts) option in the Roll Fun
selected, and the Late Charges and C
inactive.

When the first roll is complete, you sho
second time to activate the contracts a



e roll has not been performed, the current 
in the top field. 

e roll has been performed, the date through 
re rolled is displayed in the top field. In the 
must type the date through which this roll 
harges—usually the current date. 

pply Contract charges, Apply Late 
e accounts option or the Apply Late 
e accounts option in the Roll Functions 
Charges section is active. Do the following:

e of accounts to which late charges should 
elect from the following:

nts Due
 +30 days and older
 +60 days and older
 +90 days and older

m Dollar Amount field, type the minimum 
t.

changes to the Roll Options window that 
 time you run the roll, click Apply and OK. 
lays a message, listing the roll functions to 
 asking if you want to continue.
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4 In the Roll Functions section, select from these options: 

• Apply Contract charges, Apply Late charges, and Age 
accounts—Contracts, pay plans, and monthly fee 
accounts are processed. Based on the account roll day, 
any unrolled contract charges that fall on or before the 
date in the Contracts section “thru date” are applied. Any 
pending contracts with an initial fee date prior to this date 
are activated.

Late charges are applied, provided the account meets 
late charge criteria.

Accounts are aged into due, 30-day, 60-day, or 90-day 
categories.

• Apply Contract charges, and Age accounts—Contracts, 
pay plans, and monthly fee accounts are processed. 
Based on the account roll day, any unrolled contract 
charges that fall on or before the date in the Contracts 
section “thru date” are applied. Any pending contracts 
with an initial fee date prior to this date are activated.

Accounts are aged into due, 30-day, 60-day, or 90-day 
categories.

• Apply Late charges, and Age accounts—Late charges 
are applied if the account meets late charge criteria.

Accounts are aged into due, 30-day, 60-day, or 90-day 
categories.

• Age only (ages *ALL* accounts)—Accounts are aged 
into due, 30-day, 60-day, or 90-day categories.

If either of the first two options in the Roll Functions section 
is selected, the Contracts section is active. 

If a contract charg
date is displayed 

If a contract charg
which charges we
second field, you 
should process c

5 If you select the A
charges, and Ag
charges, and Ag
section, the Late 

• Select the ag
be applied. S

• All Amou
• Amounts
• Amounts
• Amounts

• In the Minimu
dollar amoun

6 If you have made 
you will use each
The software disp
be performed and

7 Click Yes.

Caution

Do not roll ahead. 
Data can be distorted 
and accounts will not 
age properly if you 
attempt to apply 
contract charges and 
late charges for 
dates in the future.



Initial Training Workbook (OR250-15)  121 of 126

ements

enu select Reports > 
menu is displayed. The 
 Exception Report, 
ents, and Individual 

inancial > 
. The Statement 

n. If you select Single 
lect the location from 

Note

Notify your support 
representative if roll 
exceptions or errors 
occur during the roll.

Note

You can print roll 
reports separately, at 
a later time, by 
selecting Reports > 
Financial > Roll > 
Print Roll Reports.
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As the roll processes, the Roll Progress window is displayed.

The selected roll functions and the accounts processed 
determine which boxes display progress. 

After the roll has completed, the Roll Report Options window 
is displayed.

8 Select the report options you want to print. 

9 Click OK.

Generating and Printing Stat

To print account statements, on the main m
Financial > Statements. The Statements 
following options are available: Statement
Generate Statements, Print/View Statem
Statements.

Generating Statements

To generate statement information:

1 On the main menu, select Reports > F
Statements > Generate Statements
Generation window is displayed.

2 In the Location section, select an optio
Location, use the drop-down list to se
the list.



ount balance that you want to receive 

otal Balance—All accounts with a positive 
. In the Minimum Amount field, enter the 
ount balance that you want to receive 

Balance—All accounts with a positive 30+ 
including 60, 90+ day). In the Minimum 
, enter the minimum account balance that 
eceive statements.

Balance—All accounts with a positive 60+ 
including 90+ day). In the Minimum 
, enter the minimum account balance that 
eceive statements.

Balance—All accounts with a positive 90+ 
In the Minimum Amount field, enter the 
ount balance that you want to receive 

th Ledger activity—All accounts with ledger 
e statements. Select the Include Insurance 
etermining ledger activity option to 
nce activity when determining whether the 

ives a statement.

rance balances when calculating age of 
ect this option to include the insurance 
 calculating the balance to determine 
ccount receives a statement.
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3 In the Office (mailing address) section, select the mailing 
address you want to print on the statements. 

4 In the Format section, select the appropriate format:

• Due As Of Format—Statements are printed before 
accounts are rolled and include the next month’s contract 
charges. 

• In the Bill Date field, type the month and year for the 
statements. This should be the next month that the 
Monthly Roll posts contract charges. Select the All Dates 
option to print statements for all due dates, or select Due 
Day(s) and type dates in the from: and to: fields for a 
range of due dates.

• Aging Format—Statements are printed after accounts 
have been rolled.

5 In the Age of Accounts to Print section, select from the 
following options:

• All Accounts—All accounts regardless of the balance.

• All Non-Zero—Accounts with a positive or a credit total 
balance.

• All Non-Zero Due Now—Accounts with a positive or a 
credit current balance. In the Minimum Amount field, 
enter the account balance that you want to receive 
statements.

• All Credit Balance—All accounts with a credit total 
balance. In the Minimum Amount field, enter the 
minimum account balance that you want to receive 
statements.

• All Positive Due Now—All accounts with a positive 
current balance. In the Minimum Amount field, enter the 

minimum acc
statements.

• All Positive T
total balance
minimum acc
statements.

• All 30+ Day 
day balance (
Amount field
you want to r

• All 60+ Day 
day balance (
Amount field
you want to r

• All 90+ Day 
day balance. 
minimum acc
statements. 

• Accounts wi
activity receiv
lines when d
include insura
account rece

• Include Insu
account—Sel
balance when
whether the a
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ptions window is 

gin generating 
s incorrect, click Reset 

ts, if you want to print 
click Yes.

Tip

After generating and 
printing the batch, 
print the exception/ 
error list, make any 
corrections to those 
accounts, and 
generate individual 
statements for 
responsible parties 
who did not receive a 
statement from the 
initial batch generation.
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6 In the Messages section, select the language and the type of 
message: Mandatory, Dunning, General, or Individual 
Responsible Party. 

To enter a message, click the button to the right of the 
appropriate message line. The corresponding message 
window is displayed.

Type your message and click Add, or click Change to edit an 
existing message. You can also click Remove to delete a 
message. Click Close to save the message.

7 In the Ledger Detail to Include section, select from the 
following:

• Since Last Statement
• Since Specific Date

8 In the Statements Generated section, choose whether you 
would like to generate statements Per Responsible Party or 
Per Patient.

9 Click OK. The Selected Statement O
displayed.

10 Review the options and click OK to be
statements. If some of the information i
or Cancel.

11 After the software generates statemen
the Post-Generation Summary report, 



erated Statements

enerated statements:

rated Statements window, click Restart 
Generated Statements. The View 
ments window is displayed, with additional 

ts that were generated prior to the last 
tion, select Generated on and use the 
select the statement run date. 

ents generated since a specific date, select 
, enter the date, and press Enter. 
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Printing/Viewing Statements

To print or view account statements:

1 On the main menu, select Reports > Financial > 
Statements > Print/View Statements. The View Generated 
Statements window is displayed.

The window settings selected are based on the options you 
chose when you last generated statements. The Printable 
field shows the number of statements that will print.

For more information about statement generation, click 
Generation Criteria.

2 Load statement forms in the printer if you are using them, and 
select from the following options:

• Print Statements
• Restart Printing
• View Generated Statements
• Close Program
• ExpressBill 

Working with Gen

To work with a list of g

1 In the View Gene
Printing or View 
Generated State
options.

2 To print statemen
statement genera
drop-down list to 

OR

To print all statem
Generated since

Click Print.

Tip

Remember to put 
plain paper in the 
printer before printing 
the Post-Generation 
Summary report.

Tip

To view details of 
statements 
generated previously, 
double-click the 
responsible party, 
select File > 
Statement History, 
and double-click a 
statement date.
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3 To view statements, select from the following options:

• Printed
• Unprinted
• Errors 
• Removed 

The Status column contains four options: 

• A blank status means the statement was generated.

• A Printer icon indicates the statement has been printed.

• The Remove icon indicates the statement has been 
removed from the print list.

• The Error icon indicates the statement was not generated 
due to errors.

4 Use the buttons at the bottom of the window to perform 
additional functions: 

• Express—Click to begin the ExpressBill transmission 
process.

• Remove—Click to remove a statement from the list and 
prevent it from printing. 

• Print—Click to display the print menu. Select from the 
following print options:

• Print List of Generated Statements

• Print Post-Generation Summary

• Print All Unprinted Statements in List

• Print all Statements from Highlighted Name 
Forward

• Close

Generating an Individual Stateme

To generate an individual statement:

1 On the main menu, select Reports > F
Statements > Individual Statement. 
Software Responsible Party Lookup

2 Search for the responsible party name
Generate a Statement window is disp

3 Select the appropriate office address, 
OK. The View Statement window is d

4 Click Print! 

5 Click Exit!

Correcting Errors After Generatin

If you receive errors after generating statem
steps to correct the accounts:

1 Use the OrthoTrac Software Patient 
search for the responsible party name 
chart.

2 In the Patient Information window, do
responsible party name and correct the
data. Click OK. 

3 In one of the patient’s financial function
Reports > Statements. The Generate
is displayed.

4 Select the appropriate office address, 
OK. The View Statement window is d

5 Click Print! 

6 Click Exit!



he roll has completed, the Roll Report 
is displayed.

options you want to print and click OK.

e a Statement

uplicate statement and you want to print the 
essing the patient's chart. 

ual statement:

u, select Reports > Financial > 
dividual Statement. The OrthoTrac 
nsible Party Lookup window is displayed.

ponsible party name and click OK. The 
ment window is displayed.

riate office address, if necessary, and click 
atement window is displayed.
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Skill Sharpeners

You have closed the daysheet and performed a daily backup. Now 
you are ready to run the roll and generate statements. First, you 
want to apply contract and late charges to patient accounts and to 
age the balance. 

Exercise 1—Run the Roll

To run the roll:

1 On the main menu, select Reports > Financial > Roll > Roll 
Accounts. A message is displayed, stating that all other 
workstations must exit the OrthoTrac software and asking if 
you are sure you want to do this.

2 Click Yes. A message is displayed, asking if you have done a 
daily backup.

3 Click Yes. When all data is prepared for the roll, the Roll 
Options window is displayed.

4 In the Roll Functions section, select Apply Contract 
charges, Apply Late charges, and Age accounts. The Late 
Charges section is activated. 

5 Select All Amounts Due as the age of accounts to which late 
charges should be applied.

6 In the Minimum Dollar Amount field, type the minimum dollar 
amount.

7 If you have made changes to the Roll Options window that 
you will use each time you run the roll, click Apply and OK. 
The software displays a message, listing the roll functions to 
be performed and asking if you want to continue.

8 Click Yes. After t
Options window 

9 Select the report 

Exercise 2—Generat

A patient requests a d
statement without acc

To generate an individ

1 On the main men
Statements > In
Software Respo

2 Search for the res
Generate a State

3 Select the approp
OK. The View St

4 Click Print! 

5 Click Exit!
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Important

Before you can use 
the collections 
module, you must 
convert your 
balances. 

Note

The collections 
module uses the 
patient’s due date and 
the grace period you 
set up in System 
Maintenance. For 
example, assuming 
you have a 10-day 
grace period, selecting 
Accounts with 
Balance Due, Due 
Today and Earlier 
produces a list of 
accounts whose 
balances are due 
today or within the last 
10 days.

Collections Activity
OrthoTrac Practice Management Software 

sson 15
sing the Collections Module

is lesson includes:

• Adding Promises 

• Creating Collections Activities Reports 

• Applying Payments to Promises 

e OrthoTrac collections module helps you control Accounts 
ceivable by creating and tracking promises and printing reports 
accounts with balances due, as well as those that have 
omises due. 

 view a list of accounts with balances due:

On the main menu, click the Collections Activity button. The 
Collections Activity for <Date> window is displayed.

2 Select the accounts you want to view a
Collections Activity window is display

3 In the Responsible Party field, a list o
whose accounts fit the criteria you sele
Select a name in the list to view a party
of the responsible party name, either (D
(P/D) for accounts with a promise and
displayed. (Prm) is displayed in front o
name when you search only for Accou

To the right of the Responsible Party 
selected party’s address, phone numb
patients. 



s—Shows the display options you selected 
tions Activity For <date> window.

buttons at the bottom of the window to 
l financial functions:

enerates a statement for the account.

s an adjustment to the account. 

s the Financial Functions—Totals window 
nt. 

lays ledger information for the account. 

plays the Financial Functions—Contracts 
t Plans window. 

es

ounts and contact the responsible parties, 
 for the payments expected.

 Activity window, click the responsible party 
re than one patient is attached to the 
, and then double-click <Add New 
grid. The Collections Activity—Add New 
 is displayed.

art, open a financial functions window, and 
s/Collections button. 
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The center of the window contains the promise grid, where 
you can view existing promises and add new promises. 
Promises on the grid are color-coded: 

• Gray—Paid promises
• Teal—Changed promises
• Black—Promises due
• Purple—Future promises 
• Burgundy—Deleted promises

Account totals for the patient, including responsible party and 
insurance balances, are displayed on the right side of the 
window. You can add additional comments at the bottom of 
the window in the Comments field.

4 Select View from the menu bar to customize the information 
displayed in the Collections Activity window. Select from 
these options:

• Contacted Parties—Displays accounts previously 
contacted since the last financial roll.

• Promises for Patients—Displays promises for the 
selected patient or for all patients connected to the 
currently displayed responsible party.

• Totals/Overview—Displays account totals or an account 
overview as the current view. 

• Checks/Overdraft—Displays auto-payment information.

• Promise History/Changed Promises/Future 
Promises—Select the types of promises you want to 
display in the promise grid. Future promises are displayed 
by default. Select Promise History to view deleted and 
paid promises. Select Changed Promises to include 
promises that have been changed in the view.

• Show Option
in the Collec

5 Use the function 
perform additiona

• Statement—G

• Adjust—Make

• Totals—Open
for the accou

• Ledger—Disp

• Contract—Dis
and Paymen

6 Click Close.

Adding Promis

As you review the acc
you can add promises

To add a promise:

1 In the Collections
and patient, if mo
responsible party
Promise> in the 
Promise window

OR

Open a patient ch
click the Promise

Tip

You can edit collection 
letters in the 
Collections Activity 
window. Click the 
Letters button at the 
bottom of the window 
to access, post, and 
edit collection letters. 

Promises/Collections
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The Collections Activity—Add New Promise window for that 
patient is displayed. 

The software populates the Name of Contact field with the 
name of the responsible party. The Original Due Date field 
contains the due date from the contract, and the Amount 
Due field shows the current balance on the account. 

2 In the Promise Date field, type the date the promise is due, or 
double-click the field to display a calendar, and select the 
date. 

3 In the Amount Promised field, type the payment amount 
promised.

4 In the Comment field, you can type a comment concerning 
the promise.

5 In the Contacted via: field, use the drop-down list to select 
the method used to contact the responsible party.

6 Click Add New. The Portion of Current Balance that has 
NOT been promised field displays the amount of the 
patient’s current balance that has not been promised to be 
paid. If the entire current balance is not entered for a promise 

amount, the Additional Promises Req
displayed, prompting you to enter anot
to enter another promise.

7 When you are finished adding promise

Changing and Removing Promise

To make changes to a promise or to delete

1 In the Collections Activity window, clic
and patient, if more than one patient is
responsible party, in the Responsible 
promises made by the responsible par
promise grid.

2 Double-click the promise you want to c
Change the data for the promise and c
Remove to delete the promise. 

3 When you are finished working with an
to the left of the responsible party’s nam
from the list. 

4 Click Close.

Creating Collections Activitie

You can run several Collections Activities r
accounts due and the associated promises

The following reports are available:

• Collections Reports—Prints inform
due for all accounts in the collectio
current account.

• Open Promises Report—Prints a 
have not yet been paid and the am



ents to Promises

 a payment, if a promise has been added to 
 Payments to Promises window is 

 a promise:

ent section, select from these options:

 to Newest Promise—Select this option to 
ment to the oldest promise on the list.

 Promises Only—Select this option and 
mise to which the payment is to be applied. 

ayment to no promise, deselect the options. 
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payment for all patients/responsible parties in the 
collections module.

• Paid Promises Report—Prints a list of promises that have 
been paid and the amount of payment for all 
patients/responsible parties in the collections module.

• Changed Promises Report—Prints a list of all changed 
promises for all patients/responsible parties in the 
collections module.

• Deleted Promises Report—Prints a list of all deleted 
promises for all patients/responsible parties in the 
collections module.

To run a Collections Activities report:

1 In the Collections Activity window, select Reports from the 
menu bar. The Collections Activity Reports menu is 
displayed. Select the report you want to run. The 
corresponding report window is displayed.

2 Select the criteria for the report, and type start and end dates 
where appropriate.

3 Click OK. The Print Options window is displayed. 

4 Select to print, preview, or export the report and click OK.

Applying Paym

When you are posting
an account, the Apply
displayed.

To apply a payment to

1 In the Apply Paym

• From Oldest
apply the pay

• To Selected
select the pro

• To apply the p

2 Click OK.
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Skill Sharpeners

Exercise 1—Add a Promise

You are reviewing the account for Betty Braces, and you want to 
add a promise for the payments expected.

To add a promise:

1 Open the chart for Betty Braces, open a financial functions 
window, and click the Promises/Collections button. The 
Collections Activity—Add New Promise window is 
displayed.

The software populates the Name of Contact field with the 
name of the responsible party. The Original Due Date field 
contains the due date from the contract, and the Amount 
Due field shows the current balance on the account. 

2 In the Promise Date field, type the date the promise is due, or 
double-click the field to display a calendar and select a date. 

3 In the Amount Promised field, type the payment amount 
promised.

4 In the Comment field, you can type a comment concerning 
the promise.

5 In the Contacted via: field, use the drop-down list to select 
the method used to contact the responsible party.

6 Click Add New. The Portion of Current Balance that has 
NOT been promised field displays the amount of the current 
balance that has not been promised to be paid. If the entire 
current balance is not entered for a promise amount, the 
Additional Promises Required window is displayed, 
prompting you to enter another promise. Click Yes to enter 
another promise.

7 Click Close.

Exercise 2—Find All Due Balances

To view a list of accounts with balances du

1 On the main menu, click the Collection
Collections Activity for <Date> windo

2 Select the accounts you want to view a
Collections Activity window is display

3 In the Responsible Party field, a list o
whose accounts fit the criteria you sele
Select a name in the list to view a party
of the responsible party name, either (D
(P/D) for accounts with a promise and
displayed. (Prm) is displayed in front o
name when you search only for Accou

4 Select View from the menu bar to cust
displayed in the Collections Activity w
the following options:

• Contacted Parties—Displays acco
contacted since the last financial r

• Promises for Patients—Displays p
selected patient or for all patients 
currently displayed responsible pa

• Totals/Overview—Displays accou
overview as the current view. 

• Checks/Overdraft—Displays auto

• Promise History/Changed Prom
Promises—Select the types of pro
display in the promise grid. Future 
by default. Select Promise Histor
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paid promises. Select Changed Promises to include 
promises that have been changed in the view.

• Show Options—Shows the display options you selected 
in the Collections Activity For <date> window.

5 Use the function buttons at the bottom of the window to 
perform additional financial functions:

• Statement—Generates a statement for the account.

• Adjust—Makes an adjustment to the account. 

• Totals—Opens the Financial Functions—Totals window 
for the account. 

• Ledger—Displays ledger information for the account. 

• Contract—Displays the Financial Functions—Contracts 
and Payment Plans window. 

6 Click Close.
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sson 16 
orking with Insurance Claims 

is lesson includes:

• Understanding Claims 

• Claim Processing 

• Posting Bulk Payments 

ing the insurance functions, you can:

• Create insurance claims, both manually and automatically.

• Print all of your insurance claims at one time.

• Post insurance payments to patient accounts from a 
single bulk reimbursement check.

• You can also use the OrthoTrac electronic claim service 
to transmit claims electronically. If you purchased this 
service, an Electronic Services technician will contact you 
to schedule an appointment for configuring the service 
and training you to use it.

nderstanding Claims

u can enter, edit, and print the following types of insurance 
ims:

• Pre-Authorization
• Actual
• One-Time
• Continuation of Treatment

You can create a claim manually, or the soft
create a claim when you set up a patient co
procedure codes. See the online help for m

Creating Claims Manually

To create an insurance claim manually:

1 In the patient chart or from one of the f
windows, click the Claims button. The
displayed.

2 Click Add New. 

If there is more than one policy holder 
Policy Holders window is displayed. S
and click OK. If the policy holder has m
the Insurance Plans window is displa
and click OK. The Add New Claim win

OR

If there is a single policy holder and on
New Claim window is displayed.

3 Select the type of claim you want to cr
Adding Claim Form window is display



 in these fields:

te—Type the date of the patient’s first visit.

of Services—Type the treatment description, 
uttons:

ne
ine
e

cedures

emaining—Type the number of months left 
’s treatment. This field is often mandatory for 
rocess Continuation of Treatment claims.

t the bottom of the window to add additional 
 claim: 

ation of Treatment Claims

ate Continuation of Treatment claims, you 
r each patient requiring Continuation of 

ion of Treatment claim: 

rt or a financial functions window, click the 
e Claims window is displayed.
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4 Click in the fields to enter information. Many of the fields are 
populated automatically by the software, but you might need 
to fill in these fields:

• Pre-Authorization claims—First Visit Date and 
Description of Services

• Actual claims—First Visit Date, Months Tx. Remaining, 
and Description of Services

• One-Time claims—First Visit Date and Description of 
Services

• Continuation of Treatment claims—First Visit Date and 
Months Tx. Remaining

5 Enter information

• First Visit Da

• Description 
using these b

• Insert Li
• Delete L
• Clear Lin
• Add Pro
• Remarks

• Months Tx. R
in the patient
a carrier to p

6 Use the buttons a
information to the

• Print
• Tooth Chart
• History

7 Click OK.

Creating Continu

Before you can gener
must set up a claim fo
Treatment claims. 

To create a Continuat

1 In the patient cha
Claims button. Th

2 Click Add New.

Note

The insurance carrier 
can reject claims with 
no first visit date.

Claims
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for filing. Press Tab.
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 even if the frequency 

 you entered in the 
his insurance carrier. If 
own list to select a 

Note

Select Remove All 
Printed Claims only if 
you do not want to 
keep copies of your 
printed claims until 
they have been paid.
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If there is more than one policy holder for the patient, the 
Policy Holders window is displayed. Select a policy holder 
and click OK. If the policy holder has more than one carrier, 
the Insurance Plans window is displayed. Select the carrier 
and click OK. The Add New Claim window is displayed. 

OR

If there is a single policy holder and only one carrier, the Add 
New Claim window is displayed.

3 Select AAO Cont of Tx and click OK. The Adding Claim 
Form window is displayed.

4 In the ANCILLARY CLAIM/TREATMENT INFORMATION 
section, complete the information in the following fields, as 
applicable:

• Date Appl. Placed—This field is automatically populated 
with the banding date from the Patient Information 
window, if the date was entered there. 

• First Visit Date—Type the date of the first visit.

• Months Tx. Remaining—Type the number of months of 
treatment remaining.

• Description of Services—Leave this field blank. When 
you generate Continuation of Treatment claims each 
month, the software automatically adds the information 
you set up in the Insurance Claim Options window. 

5 Click History. The Claim History wind

6 Complete the information in the followi

• Last Cont of Tx.—Type the last Co
date. 

If this is a new claim, enter the pat

Press Tab. The software populates
field, depending on the frequency 

• Monthly Charge—Type the amoun

Always enter the monthly amount,
is quarterly.

• Frequency—Defaults to the setting
Carrier Maintenance window for t
None is displayed, use the drop-d
frequency. 

7 Click Close. 

8 Click OK.



ection, print claims for all locations or a 
you choose Single Location, select the 
ion from the drop-down list. This option is 
r practice has only one location.

rint Insurance Claim window is displayed.

nature Lines section, select an option. You 
te, System Date (the current date), or 

abels for Insurance Claims

nsurance claims, you can print mailing labels 

:

Claim Processing window, select Print 
r Claims in the Processing Options 

s section, select the type of claims to print.

tion, select to print labels for all doctors or a 
u choose Single Doctor, select the name of 
e drop-down list. This option is not enabled 
s only one doctor.

ection, select to print labels for all locations 
n. If you choose Single Location, select the 
ion from the drop-down list. This option is 
r practice has only one location.

rint Setup window is displayed.
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Claim Processing

At specified times, you will process insurance claims. 

Printing Paper Claims Manually

To print Pre-Authorization, One-Time, and Actual claims on 
preprinted forms:

1 Click the Insurance Functions button on the main menu. The 
Insurance Functions menu is displayed. 

2 Select Claim Processing. The Insurance Claim Processing 
window is displayed. 

3 In the Processing Options section, select Print All 
Unprinted Claims. 

4 In the Claim Types section, select the type of claims to print. 

5 In the Doctor section, select to print claims for all doctors or a 
single doctor. If you choose Single Doctor, select the name of 
the doctor from the drop-down list. This option is not enabled 
if your practice has only one doctor.

6 In the Location s
single location. If 
name of the locat
not enabled if you

7 Click Print. The P

8 In the Date on Sig
can select No Da
Custom Date. 

9 Click OK.

Printing Mailing L

After printing patient i
for the claims. 

To print mailing labels

1 In the Insurance 
Mailing Labels fo
section.

2 In the Claim Type

3 In the Doctor sec
single doctor. If yo
the doctor from th
if your practice ha

4 In the Location s
or a single locatio
name of the locat
not enabled if you

5 Click Print. The P

6 Click OK.

Tip

Selecting Custom 
Date displays a 
calendar, enabling 
you to enter the date 
of your choice.

Note

Select Delete All 
Printed Claims only if 
you do not want to 
keep copies of printed 
claims.

Insurance Functions
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lect Confirm All 
essage is displayed. 

age is displayed. Click 
rocessing Options 

 the claims, a message 
ing Options section, 
 click Print.

, select Print Mailing 

Note

Be sure to load 
insurance claim forms 
in your printer. The 
software does not 
print the actual form.

Important

Select Confirm All 
Printed Claims only 
one time each 
month. If you 
confirm after 
printing your claims 
for the current 
month, you cannot 
reprint the claims.

Claims/Insurance 
Functions
OrthoTrac Practice Management Software 

Printing Individual Claims

While you typically print claims in batches, it is possible to print 
individual claims. 

To print an individual claim:

1 In the patient chart or from one of the financial functions 
windows, click the Claims button. The Claims window is 
displayed.

2 If there is more than one claim in the window, select the claim 
you want to print and click Print. The Print Insurance Claim 
window is displayed.

3 In the Date on Signature Lines section, select an option. 

4 Click OK.

Processing Continuation of Treatment Claims

Continuation of Treatment claims are generated monthly. When 
you are ready to process the Continuation of Treatment claims for 
the month, process the claims in this order: confirm, generate, and 
print.

You can enter Continuation of Treatment claims at any time during 
the month. Each claim generates only one time per month unless 
changes have been made on the claim. 

To process Continuation of Treatment claim

1 Click the Insurance Functions button 
Insurance Functions menu is displaye

2 Select Continuation of Treatment. Th
Treatment window is displayed.

3 In the Processing Options section, se
Printed Claims and click Confirm. A m
Click Yes.

4 When the claims are confirmed, a mess
Yes. Select Generate Claims in the P
section and click Generate. 

5 When the software finishes generating
is displayed. Click OK. In the Process
select Print All Unprinted Claims and

6 To print mailing labels for these claims
Labels for Claims and click Print.



ayments

 send one bulk reimbursement check with 
akdown by responsible/patient party. You 
ts to the different patient accounts. The bulk 
 you the ability to post payments for all 
specific carrier at one time.

nt:

ce Functions button on the main menu. The 
ions menu is displayed. 

 Payment. The OrthoTrac Software Carrier 
is displayed.

ce company that sent you the check and 
t Bulk Payment window is displayed. All 
 to that carrier, regardless of employer plan, 
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Checking Claims for Incomplete Information

To check for Continuation of Treatment claims with missing 
information after generating your claims:

1 Click the Insurance Functions button on the main menu. The 
Insurance Functions menu is displayed.

2 Select Claim Reports. The Insurance Claim Reports 
window is displayed.

3 In the Report Dates section, select Date Claim Was 
Entered.

4 In the Report Type section, select Continuation of 
Treatment and Missing Information Report. Click OK twice. 

5 Open the chart of a patient with missing insurance information 
and click the Claims button. The Claims window is displayed.

6 Select the claim and click Change to add the missing 
information. Click OK.

7 Return to the Continuation of Treatment window and 
re-generate the claims you have corrected by selecting 
Generate Claims and clicking Generate.

Posting Bulk P

Insurance companies
the payment EOB bre
must post the paymen
payment feature gives
patients insured by a 

To post a bulk payme

1 Click the Insuran
Insurance Funct

2 Select Post Bulk
Lookup window 

3 Select the insuran
click OK. The Pos
patients assigned
are displayed.

Note

Be sure to load 
insurance claim forms 
in your printer. The 
software does not 
print the actual form.

Insurance Functions
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Note

Be sure to allocate all 
of the check. If you exit 
from the Post Bulk 
Payment window 
before you are 
finished, all of your 
entries are removed.

Important

Be sure carrier 
names are 
consistent. Patients 
are selected for the 
bulk payment list 
based on the carrier 
name, regardless of 
employer.

Tip

If all patients have 
been posted and the 
unallocated amount 
is not $0.00, click 
Print, compare the 
printout to the EOB, 
and make corrections 
as needed.
OrthoTrac Practice Management Software 

4 In the Reference field, type the reference number from the 
check. Press Enter.

5 In the Check Amount field, type the amount of the check. 
Press Enter. The Unallocated amount is displayed (the same 
as the Check Amount), and the Allocated amount is $0.00.

6 If the amount displayed matches what is printed on the 
check’s EOB for that patient, press Enter. If the EOB lists a 
different amount, type the new amount and press Enter. A 
window containing Patient and Insurance options is 
displayed.

7 Press Enter or click Apply to apply the check amount to the 
selected account. To apply the payment to the other account 
balance, select the account and click Apply. A checkmark is 
displayed next to the balance paid.

8 Select the next patient on the list. 

If the Assume Insurance Amount option is selected at the 
bottom of the Post Bulk Payment window, the insurance 
current balance for all patients in the list is automatically 
entered as the payment amount. If you need to post a different 
amount, type it in the field.

9 When all payments have been posted and the Unallocated 
amount is $0.00, click OK. 

10 Click Print to print a report. 



e software automatically populates the Next 
eld, depending on the frequency for filing. 

rge—Type the amount charged per month.

efaults to the setting you entered in the 
tenance window for this insurance carrier. If 
layed, use the drop-down list to select a 

K.

 a Continuation of Treatment Claim

ion of Treatment claims:

ce Functions button on the main menu. The 
ions menu is displayed. 

ion of Treatment. The Continuation of 
w is displayed.

 Options section, select Confirm All 
nd click Confirm. A message is displayed. 

are confirmed, a message is displayed. Click 
rate Claims in the Processing Options 
Generate. 

re finishes generating the claims, a message 
 OK. In the Processing Options section, 

nprinted Claims and click Print.

bels for these claims, select Print Mailing 
s and click Print.
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Skill Sharpeners

Exercise 1—Create a Continuation of Treatment Claim

You want to set up a Continuation of Treatment claim for a patient 
before you generate the claim. 

To create a Continuation of Treatment claim: 

1 In a patient’s chart, click the Claims button. The Claims 
window is displayed.

2 Click Add New.

If there is more than one policy holder for the patient, the 
Policy Holders window is displayed. Select a policy holder 
and click OK. If the policy holder has more than one carrier, 
the Insurance Plans window is displayed. Select the carrier 
and click OK. The Add New Claim window is displayed. 

OR

If there is a single policy holder and only one carrier, the Add 
New Claim window is displayed.

3 Select AAO Cont of Tx and click OK. The Adding Claim 
Form window is displayed.

4 In the ANCILLARY CLAIM/TREATMENT INFORMATION 
section, type the number of months of treatment remaining in 
the Remaining Months field. 

5 Click History. The Claim History window is displayed.

6 Complete the information in these fields:

• Last Cont of Tx.—Type the last Continuation of Treatment 
date. 

Press Tab. Th
Cont of Tx. fi
Press Tab.

• Monthly Cha

• Frequency—D
Carrier Main
None is disp
frequency. 

7 Click Close and O

Exercise 2—Process

To process Continuat

1 Click the Insuran
Insurance Funct

2 Select Continuat
Treatment windo

3 In the Processing
Printed Claims a
Click Yes.

4 When the claims 
Yes. Select Gene
section and click 

5 When the softwa
is displayed. Click
select Print All U

6 To print mailing la
Labels for Claim



Initial Training Workbook (OR250-15)  141 of 146

Le
T

Th

Us
ap
pa
ve
fea

To
bu
dis

d the person who 
ation are displayed.

tory window enable 

ng History window:

ant to remove. A 

d.

Note

Display options are saved 
for each workstation 
individually.

Patient Tracking
OrthoTrac Practice Management Software 

sson 17
racking Patients and Correspondence

is lesson includes:

• Creating Patient Tracking Reports 

• Tracking Word Processing and Communications 

e the patient tracking function to view logged records of 
pointments, posted letters, and procedures performed for a 
tient. In addition, if you have orthodontic imaging software, 
rsion 8.0.5 or higher, you can enable the document storage 
ture. 

 display the history of a patient, click the Patient Tracking 
tton on the patient chart menu. The Tracking History window is 
played.

Each item in the patient history is dated, an
posted the entry, assistant, doctor, and loc

Functions

The following functions in the Tracking His
you to perform additional tasks:

• Edit Entries
• Scan Document
• Enter Comment
• Print Tracking History
• Display Options

Removing Entries

To remove an entry displayed in the Tracki

1 Click Edit Entries.

2 Click the red X next to the entry you w
message is displayed.

3 Click Yes. The tracking entry is remove

4 Click Done.



mment:

A Comment. The HIPAA Privacy Comment 
ed. 

f comment you want to add. Valid options 

wledgement
ent
rization

osure
laint

 HIPAA privacy acknowledgement for a 
PAA acknowledgement, type a comment, 

 Histories

 patient tracking history:

istory window, click Print. The Patient 
ptions window is displayed.

rt, Preview Report, or Export Contents.
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If the entry has a document attached, the following message is 
displayed: 

Scanning Documents

To scan a document:

1 Click Scan Document. The Select Type window is displayed.

2 Select the document type from the drop-down list. 

OR

Select New to add a new type to the list.

3 Click Scan to acquire a document from your local scanner.

OR 

Click Browse to acquire a document that is saved to a file.

Entering Comments

To enter comments in the Tracking History window:

1 Click Enter Comment. The Patient Tracking Comment 
window is displayed.

2 Type your comment in the field and click OK.

To create a HIPAA co

1 Click Enter HIPA
window is display

2 Select the type o
are:

• HIPAA ackno
• HIPAA Cons
• HIPAA Autho
• HIPAA Discl
• HIPAA Comp

3 To document the
patient, select HI
and click OK.

Printing Tracking

To print a copy of the

1 In the Tracking H
Tracking Print O

2 Select Print Repo

3 Click OK.

Note

Scanned documents 
can be moved to 
another patient’s 
tracking history by 
clicking the green 
arrow next to the entry. 
The OrthoTrac Patient 
Lookup window is 
displayed. Select the 
appropriate patient, 
and the document is 
moved.
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w Report> and type a 
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whether to view results 
ort, and whether to 
scription. Click Apply.

Note

The display options 
are saved per 
workstation.

Note

Select Code Only to 
produce a shorter 
report.
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Setting Display Options

To select the options you want to display in the Tracking History 
window, click Display Options. The Patient Tracking Options 
window is displayed. 

Creating Patient Tracking Reports

You can set up customized reports—which can be viewed as 
contact experts or in standard report format—that summarize the 
tracking history of all patients.

To create a patient tracking report:

1 On the main menu, select Reports > Pa
Patient Tracking Reports window is dis

2 From the drop-down list, click <Add Ne
name for the new report.

3 Select the patients to include in the rep

4 Select the sorting order for the report, 
as a Contact Expert or a Tracking rep
show procedures by Code Only or De
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ns

rocessing and communication history for a 
 Processing button in the patient chart. The 
dow is displayed. 

 are displayed in the window:

rd—Opens a new word document outside 
.

nt Letters—Opens the Post and Print 
ow.

uestionnaire—Opens the Execute 
re window. 

ionnaire in the history window is dated and 
 the document. 
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5 Click Search. 

• If you selected Tracking Report, the Print Options window 
is displayed. Select Print or Preview.

• If you selected Contact Expert, the search results are 
loaded in the Contact Expert window.

Changing Existing Patient Tracking Reports

When running an existing report, you must change the dates to 
reflect the current date range. You can edit previously saved 
reports to remove or add options. To change patient tracking 
reports:

1 In the Patient Tracking Reports window, select the report 
from the drop-down list.

2 Click Change.

3 Make changes to the options and click Apply.

Tracking Word
Communicatio

To display the word p
patient, click the Word
Word Processing win

The following options

• Microsoft Wo
of OrthoTrac

• Post and Pri
Letters wind

• Complete Q
Questionnai

Each letter and quest
linked to a PDF file of

Note

You must have 
orthodontic imaging 
software, version 8.0.5 
or higher. The 
document storage 
feature must be 
enabled in system 
maintenance to keep 
permanent electronic 
copies of your 
correspondence. 

Word Processing
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Note

Refresh the Word 
Processing window to 
view changes.
OrthoTrac Practice Management Software I

When you complete a questionnaire, the details are displayed in 
the lower sections of the Word Processing window. The last two 
questionnaires completed are also displayed. 

To update a questionnaire displayed in the window, click Update. 

To print a questionnaire displayed in the window, click Print.

Letters must be confirmed to be displayed in the history window. 
Questionnaires are displayed upon completion.
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Skill Sharpener

Exercise 1—Print a Patient History

Your office has performed numerous orthodontic procedures on 
Patti Patient and you want to view and print her appointment and 
procedure history. 

To view and print Patti’s history:

1 Open Patti Patient’s chart and click the Patient Tracking 
button. The Tracking History window is displayed.

2 Review the history in the center of the window.

3 Click Display Options, select the options you want to display 
in the report, and click OK.

4 Click Enter Comment, type a comment, and click OK.

5 Click Print Tracking History. The Patient Tracking print options 
window is displayed.

6 Select Print Report and click OK.
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Note

You must set up 
contact experts before 
they can be linked to 
an office expert report.

Note

You can sort only by 
fields that correspond 
to the type of list you 
are creating; for 
example, lists of 
patients can be sorted 
by patient or 
communications 
fields.

Tip

To change a search 
option, select it and 
click a new field in the 
list, or change the 
criteria you selected 
for that option. 

Contact Experts
OrthoTrac Practice Management Software 

sson 18
sing Contact Experts and Office Expert

is lesson includes:

• Creating Contact Experts 

• Using Office Expert 

• Linking Contact Experts with Office Expert 

ntact experts enable you to use existing or custom reports to 
tain specific information from your database.

fice expert enables you to track and process business activities.

reating Contact Experts

e contact experts to organize and process lists generated from 
tient tracking reports or from office expert items. You can send 
ters and cards, print labels, and print reports for everyone on 
 list or for specific people on the list.

tient Fields

ing the patient fields, you can create lists of patients and search 
 specific patient information.

 access contact experts on the main menu, click the Contact 
perts button. The Contact Expert window is displayed. 

To create a contact expert report of patient

1 In the List of field, select Patients.

2 Click in the Sorted by field and select 
order in which to display the list.

3 Click in the Where field, select a field o
the conditions or criteria to apply to the

4 To save the search options, click Appl
the search. Click OK and Search. 



sults 

indow contains details about the 
arties returned by the search, which are to 

port.

utput fields:

lds, Communications Questions, or 
ty Fields, and select from the corresponding 
m of the window.

 Print Options window is displayed. Select 
xport the report and click OK.
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Responsible Party Fields

You can create lists of responsible parties and search for specific 
responsible party information in patient lists. To create a contact 
expert report of responsible parties, follow the steps in “Creating 
Contact Experts” on page 147, but in the List of field, select 
Responsible Parties. To select from a list of responsible party 
search parameters, click the Responsible Party Fields option and 
select from the fields at the bottom of the window.

Communications Questions

To search for a list of patients or responsible parties who provide 
specific answers to communications questions, follow the steps in 
“Creating Contact Experts” on page 147; however, select 
Communications Questions and select from the options in the 
Category or Questionnaire fields. 

Using Search Re

The Search Results w
patients/responsible p
be displayed in the re

To select additional o

1 Select Patient Fie
Responsible Par
fields at the botto

2 Click Report. The
to print, view, or e
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 Totals window, select 

 of the window to 
mounts to Number of 
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e drop-down list to 
r three-dimensional bar 

totals and the 2D bar 

modifies the current 
correct accounts, click 
pert window and enter 

Tip

If a patient has more 
than one responsible 
party, use the 
drop-down list in the 
Rsp. Parties field to 
view information for 
the other responsible 
parties.
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Additional Search Result Information

You can perform additional tasks with the names the software 
retrieves from the initial search by using the following fields and 
buttons:

• First Name, Last Name—Provides additional information 
about a patient in the search list when selected.

• Remove—Removes a patient from the active search list.

• Restore—Adds a patient to the active search list again.

• Question Mark—Displays the search options used to 
create the list.

• Photos—Displays photographs of the patients on the list, 
if snapshots are available.

• Letters—Posts letters to the patients found by the search.

• Labels—Prints mailing labels.

• Cards—Prints recall cards.

• Report—Prints reports and exports search results and 
.csv files for use in other applications, such as 
spreadsheets.

• Export—Exports the report information for use with 
HouseCalls appointment confirmation software.

• Totals—Displays the Financial Totals window, which 
displays financial information for all patients in the list

.

The balances and aging of accounts a
of the window, along with the dollar am

To change the display of the Financial
from the following options:

• Click the buttons at the bottom
change the view from Dollar A
Accounts or Percent of Accou

• In the Chart Type field, use th
select from two-dimensional o
or pie charts.

• Click Print Graph to print the 
graph for each of the views.

• Restart—Starts another search or 
search. If a search fails to find the 
Restart to return to the Contact Ex
new search parameters.



xpert

u perform daily activities by generating a list 
ed your attention.

 the following information about each item:

nt (pink background), Important (yellow 
 and FYI (green background)

ial, Insurance Claims, Patient/Treatment, 
d Word Processing

Name of the report

Date and the name of the person who 
e task

ifications

e prompts the first staff member who logs in 
the staff member selects Yes, the software 
ert information. If the staff member selects 
pts the next person who logs in to run office 
r clicks the Office Expert button before 

 message is displayed.

rt notifications, select Maintenance/Set-up 
ce. The System Options window is 
ellaneous Options section, select Office 

rt from the main menu, click the Office 
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• Apply—Saves the search. To name the search, type a 
name and click OK. 

• Close—Exits the contact experts function. To save the 
search, click Yes. Type a name for the attribute set and 
click OK.

Loading Previous Searches

To load a search you saved previously:

1 In the initial Contact Expert window, click Load. A list of 
previously saved searches is displayed.

2 Click the search and click OK. The software populates the 
window with the search parameters, which you can edit.

3 Click Search. The Search Database window is displayed, 
asking if you want to use the previous results of the search.

4 Click Yes to use the previous search results. The resulting list 
displays the same results as the last time the search was 
saved.

OR

Click No to search your files with the same options and create 
an updated list of patients who meet the same criteria. 

Using Office E

Office expert helps yo
of items that might ne

Office expert provides

• Priority—Urge
background),

• Area—Financ
Schedule, an

• Description—

• Last Action—
performed th

Office Expert Not

Each day, the softwar
to run office expert. If 
updates the office exp
No, the software prom
expert. If the initial use
anyone else logs in, a

To turn on office expe
> System Maintenan
displayed. In the Misc
Expert Notification.

To access office expe
Expert button. 

Tip

When creating 
contact experts for 
use with office 
expert, use a naming 
convention so the 
search sets are 
grouped together.

Office Expert
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fice Expert window is 

pe of action you want 
. The Office Expert 
w is displayed. Click 

Note

Clicking Action 
indicates to the 
software that the 
action is performed. 
Even if you decide not 
to perform the action, 
the date and your 
name display in the 
Last Action section 
of the Office Experts 
Suggestions 
window.
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The Office Expert Suggestions window is displayed. 

The Office Expert Suggestions window displays items sorted by 
priority in the following order: Urgent, Important, and FYI. Your 
security permissions in the software limit the number and types of 
reports you see.

Select from the following options: 

• To view details about an item, click the item. Information is 
displayed in the Condition field.

• To change the order of items, click the Priority or Area 
headers.

• To perform the action displayed in the Suggested Action 
field, select an item and click Action. 

• To view a list of patients or respon
an item, click Detail. The Office Ex
displayed.

Select from options at the bottom o
additional information about the pa
parties.

• To print a summary of all the repor
to receive, click Print. The Print Of
displayed.

Select the type of items and the ty
to print on the report and click OK
Suggestions Print Options windo
OK.
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Linking Contact Experts with Office Expert

To link a contact expert with office expert:

1 Set up a contact expert with identical parameters as in an 
office expert report.

2 Name the contact expert, using your naming convention. The 
name can be 25 characters in length.

3 In the Office Expert Setup window, select a report and select 
Contact Expert in the Action field.

4 In the Contact Expert field, select the corresponding saved 
search.
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Skill Sharpeners

Exercise 1—Find Missing Information

A woman calls your office and leaves a message on your 
answering machine. She identifies herself as “Barbara, Susan’s 
mother” and wants you to call her back; however, the phone 
number she gave in the message is not understandable. How can 
you find the phone number so you can call Susan’s mother?

To create a contact expert report:

1 On the main menu, click the Contact Experts button. The 
Contact Expert window is displayed. 

2 In the List of field, select Patients.

3 Click in the Sorted by field and select a sort option from the 
fields at the bottom of the window and the order in which to 
display the list.

4 Click in the Where field and select Pt First Name from the 
Patient Fields options at the bottom of the window. From the 
drop-down list in the Where field, select is equal to. In the 
equals field, type Susan and press Enter twice. 

5 Click Responsible Party Fields and select Rsp First Name 
from the options at the bottom of the window. From the 
drop-down list in the Where field, select is equal to. In the 
equals field, type Barbara and press Enter twice.

6 Click Search. The software displays the search results in the 
box at the left side of the window.

7 Click Responsible Party Fields and select Rsp Hm Phone 
and Rsp Wk Phone from the Responsible Party Fields 
options at the bottom of the window. The software displays 
the phone numbers at the right side of the window.

8 To print the information, click Report. T
window is displayed. Select to view, pr
type.

Exercise 2—Find Incorrect Data

You have duplicate zip codes in the databa
are two Atlanta 30339 zip codes. You wan
patient charts that contain each Atlanta zip
charts on the shortest list. How can you fin
responsible parties who have the incorrect
so you can enter the correct code and dele
from the software?

To create a contact expert to find patient c
data:

1 On the main menu, click the Contact E
Contact Expert window is displayed.

2 In the List of field, select Patients.

3 Click in the Sorted by field and select 
fields at the bottom of the window and
display the list.

4 Click in the Where field and select Pt Z
Patient Fields options at the bottom o
drop-down list in the Where field, selec
drop-down list in the equals field, sele
code entry on which you want to repor

5 Click Search. The search results are d
the left of the window.

6 Note the number of patients having thi
In this example, there are three patient
zip code in their charts.



abase Fields Information

ient schools and sports using the database 
e for the Elm Street Middle School 
tart, and the doctor wants to send a letter to 
ay basketball, reminding them that they 
guard. How can you generate a list of 
ketball at Elm Street Middle School?

rt to access database fields information:

u, click the Contact Experts button. The 
indow is displayed.

, select Patients.

d by field and select a sort option from the 
m of the window and the order in which to 

e field and select Schools from the Patient 
the bottom of the window. From the 
the Where field, select is equal to. From the 
the equals field, select Elm Street Middle 

m the Patient Fields options at the bottom 
om the drop-down list in the Where field, 
. From the drop-down list in the equals field, 
l.

 search results are displayed in the box at 
dow.
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7 Repeat the steps listed above, using the second Atlanta zip 
code option. In this example, there are 46 patients with the 
second Atlanta zip code in their charts, so it would be easier 
to change the three charts that use the first zip code. 

8 Repeat the search using the first Atlanta zip code. The three 
patient names are displayed at the left of the window.

9 In the box at the left of the window, double-click on the first 
patient name. A drop-down menu is displayed. Select Open 
Patient Chart. 

10 Click the Patient Information button. The Patient Information 
window is displayed. Double-click on the address field.

11 Change the zip code in the Edit Address window. In this 
example, be sure to select the second Atlanta option.

12 The software prompts you, asking if you want to change this 
address for all others associated with this address. Click Yes.

After you have changed the zip code in the three charts, you 
should delete the unused, incorrect zip code. Follow these 
steps:

• Select Maintenance/Set-up > System Maintenance > 
Zip Codes.

• Select the first Atlanta zip code and click Remove.

• Click Yes when prompted to delete the incorrect zip 
code.

Exercise 3—Use Dat

Your office tracks pat
fields function. It’s tim
basketball season to s
those patients who pl
should wear a mouth 
patients who play bas

To use a contact expe

1 On the main men
Contact Expert w

2 In the List of field

3 Click in the Sorte
fields at the botto
display the list.

4 Click in the Wher
Fields options at 
drop-down list in 
drop-down list in 
School. 

5 Select Sports fro
of the window. Fr
select is equal to
select Basketbal

6 Click Search. The
the left of the win

7 Click an option.
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Multiple Fields
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Orthodontic Imaging

Mail Merge Insert Fill 
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Save and Close

Tip

If your office uses the 
electronic signature 
pad, patients, 
responsible parties, 
and staff members 
can sign documents 
electronically using a 
tablet or signing pad.
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sson 19
sing the Word Processing Module

is lesson includes: 

• Setting Up Letters 

• Managing Word Processing Letters 

• Printing Envelopes 

• E-mailing Letters 

e OrthoTrac word processing module uses Microsoft Word 
ftware to handle its word processing functions. 

e word processing module works with the OrthoTrac 
mmunications module and enables you to merge information 
m communications questionnaires into specialized letters.

addition, if you have orthodontic imaging software, version 8.0.5 
 higher, you can enable the document storage feature in system 
intenance, patient tracking, and Charting. Using the document 
rage feature, you can keep permanent electronic copies of all 
your correspondence.

etting Up Letters

e word processing module contains many letters that you can 
e to correspond with patients and doctors in your practice. 
ing merge fields and different letter styles, you can customize 
se letters. You can also create your own letters.

The electronic signature feature enables pa
parties, and staff members to sign docume
a tablet or signing pad. 

Toolbar Buttons

Table 1 shows you the buttons available in
module. 

Table 1 Word Processing Module Toolb

Merge Field

Response to 
Questionnaire

Responsible Gender

Insert Date

Insert Frame



rs 

 that are customized for your office.

rocessing button on the main menu. The 
 menu is displayed. Select Letter Setup. 
 window is displayed.

etter. The Add Letter window is displayed.

cription field, type a description.

 field, select the addressee type. 

field, select the appropriate salutation. 

ield, select who will sign the letter, Doctor or 
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Using Merge Fields, Addressee Types, and 
Salutation Types

The word processing module contains merge fields that enable 
you to produce customized correspondence. These merge fields 
function in the same way as Microsoft Word merge fields. 

Each letter you add, depending on the type of letter and the 
addressee, can have both a patient version and a responsible 
party version. The addressee types include:

• Standard
• Patient
• Financial
• Responsible Party
• Doctor
• Referring Doctor
• Referring Patient
• Referring Responsible Party

The salutation types include:

• Formal
• Semi-Formal
• Informal

See the online help for additional information about using merge 
fields, addressee types, and salutation types.

Adding New Lette

You can create letters

To add a new letter:

1 Click the Word P
Word Processing
The Letter Setup

2 Click Add New L

3 In the Letter Des

4 In the Addressee

5 In the Salutation 

6 In the Signature f
Staff.

Tip

Use the Import 
Letter button to 
import letter text 
from other Word 
documents.

Word Processing
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window is displayed, 
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nge Letter window is 

r. See “Adding New 
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ically: 

des to post letters 
when procedures are 

functions and 
 performed or when 
rompts you to post the 

Important

The software 
assigns the letter a 
name — do not 
change it. This 
name is different 
from the description 
you gave the letter.

Gender Merge Fields 

Save and Close

Merge Fields
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7 In the Envelopes section, select None or Print Separately. If 
you select Print Separately, the software prompts you to print 
the envelope after the letter is printed.

8 Click Add Responsible to add the text for the responsible 
party version of the letter. The Add New Letter window is 
displayed and defaults to the template for the type of letter 
you are adding. Click OK. The Microsoft Word software 
opens, and the letter is displayed. 

9 Begin typing the letter to delete the highlighted text.

10 To merge patient information into the letter, click an OrthoTrac 
software merge field button. 

11 Select the merge fields you want to include. Click OK. 

12 To merge gender-specific information into the letter, click a 
gender merge field button, select the option next to the 
pronouns you want to insert, and click OK. 

13 When you are setting up a letter and select the pronoun 
option for the patient or responsible party, the pronoun merge 
field in the letter is displayed as “her,” regardless of the gender 
you selected. The software uses the gender entered in the 
Sex field on the patient chart to determine the appropriate 
pronoun to insert for the patient or the responsible party.

To add custom male or female text, select the Custom option 
and type the information in the Male Text or Female Text 
fields in the Custom section.

14 Check your spelling and grammar using the Microsoft Word 
software spell-check program.

15 Click the Save and Close button. The Add Letter window is 
displayed.

16 Click Add Patient Letter to add the tex
of the letter. The Add Letter message 
asking if you would like to copy the exi

17 Click Yes.

18 Edit the letter as necessary.

19 Click the Save and Close button. The 
displayed. 

20 Click OK twice.

Changing Letters

To change a letter:

1 Click the Word Processing button on 
Word Processing menu is displayed. S
The Letter Setup window is displayed

2 In the Existing Letters window, select 
edit and click Change Letter. The Cha
displayed.

3 Follow the steps used to create a lette
Letters” on page 156 for more informa

Assigning Letters

There are two ways to post letters automat

• You can set up your procedure co
automatically to a patient account 
posted.

• You can assign letters to specific 
conditions. When the functions are
the conditions exist, the software p



d Processing Letters

 processing module, there are several 
 frequently, including posting letters 

mation with the letter to produce a 
iewing letters, printing letters, and 

rocessing button on the main menu. The 
 menu is displayed. Select Post and Print 

rocessing button in the patient chart. The 
 menu is displayed. Select Post and Print 
 and Print Letters window is displayed.
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assigned letters. The software can prompt you to post 
letters in the following instances:

• Add New Patient
• Patient Referrals
• ePatient
• No-Show

To assign letters to specific functions and conditions:

1 Click the Word Processing button on the main menu. The 
Word Processing menu is displayed. 

2 Select Letter Setup. The Letter Setup window is displayed.

3 Click Assignment. The Letter Assignments window is 
displayed.

4 Click the option button of the function or condition to which 
you want to assign a letter, and use the drop-down list to 
select the letter.

5 Use the buttons on the side of the window to make changes 
to the letters you assign:

• Select Letter
• Add New Letter
• Change Letter 
• Remove Letter

6 Click Close.

Managing Wor

When using the word
processes you perform
(merging patient infor
customized letter), rev
confirming letters.

Posting Letters

To post a letter:

1 Click the Word P
Word Processing
Letters. 

OR

Click the Word P
Word Processing
Letters. The Post

Tip

To add letters to a 
drop-down list, select 
<Include New 
Letter> from the list 
or click Select 
Letter to open the 
Include New Letter 
window and select 
the letters you want 
to add.

Word Processing
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Important

Microsoft Word 
must be installed 
on your computer 
to print letters.

Tip

Letters may be 
printed from the 
Ready to Review, 
Under Review and 
Ready to Print 
columns.
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2 Select the letters you want to post. To post more than one 
letter type at a time, hold the Ctrl key down and select 
additional letters to post. Click Post Letter.

The software updates the number in the Ready to Review 
column.

Reviewing and Editing Letters

To view a list of patients due to receive a letter, to edit a letter, or to 
delete a letter posted in error:

1 In the Post and Print Letters window, double-click the 
number in the Ready to Review column. The Selected 
Letters window is displayed, and a list contains the names of 
all patients/responsible parties due to receive this letter.

2 Select a name and click Edit Letter.

3 Edit the letter as necessary. 

4 Close the letter. A message is displayed.

5 Click Yes. The Edit Letter window is displayed. 

6 To make additional changes, click No. The software updates 
the number in the Under Review column, and you can make 
changes.

OR

To print the letter, click Yes. The software updates the number 
in the Ready to Print column, and the letter can no longer be 
edited.

Letters that have already been edited, but a
are listed in the Under Review column. To
Under Review column, double-click the nu
preceding steps.

Printing Posted Letters

To print or reprint letters:

1 In the Post and Print Letters window,
number in the Ready to Print column. 
window is displayed, and a list displays
responsible parties due to receive this 

2 Select an option:

• To print, preview, or e-mail letters f
click Select All and click Print Let
window is displayed. Select an op

• To deselect all names on the list, c

• To print or reprint the letter for spe
select the names and click Print L
Options window is displayed. Sele
click OK.

• To delete letters that have been po
individual names and click Remov
Letters message is displayed. Clic

If the letter you are printing is set to pri
letters print first, and then the software
the envelopes.



played, asking if you are sure you want to 
letters.

ftware makes an entry in each patient’s 
oting that the particular letter has been sent.

opes

ow and the Change Letter window contain 
n, where you enable the software to print 
lt is set to None.

nt envelopes, select Print Separately and 
tters print, the software prompts you to print 

lone Envelopes

envelopes:

rocessing button on the main menu. The 
g menu is displayed. Select Print Envelope. 

ssee type. The lookup window is displayed.

ssee and click OK. The envelope prints, and 
w is displayed again. 

dressee and print another envelope, or click 
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Printing Multiple Letters and Multiple Letter Types

You can print multiple letters and multiple letter types at one time 
by using the Print Letter button in the Post and Print Letters 
window.

To print multiple letters and letter types:

1 In the Post and Print Letters window, select each of the letter 
types you want to print, or click Select All.

2 Click Print Letter.

Confirming Printed Letters

Confirming a printed letter makes an entry in a patient’s tracking 
history.

To confirm letters:

1 In the Post and Print Letters window, double-click the 
number in the Printed column for the letter type you want to 
confirm. The Selected Letters window is displayed.

2 Click Select All or select individual names on the list.

3 Click Confirm Letter. A message is displayed. Click Yes.

Confirming Multiple Printed Letters and Multiple Letter Types

You can confirm multiple printed letters and multiple letter types at 
one time by using the Confirm Letter button on the Post and Print 
Letters window.

To confirm multiple printed letters and letter types:

1 In the Post and Print Letters window, select each of the letter 
types you have printed, or click Select All, and then click 
Confirm Letter. 

A message is dis
confirm multiple 

2 Click Yes. The so
tracking history, n

Printing Envel

The Add Letter wind
an Envelopes sectio
envelopes. The defau

If your printer can pri
click OK. After the le
the envelopes.

Printing Stand-A

To print stand-alone 

1 Click the Word P
Word Processin

2 Select the addre

3 Select the addre
the lookup windo

4 Select another ad
Cancel.

Tip

To select multiple 
letter types, press the 
Ctrl key and click 
each type.

Word Processing
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Note

If you select Print 
Preview and print 
from Word, the 
software does not 
prompt you to print 
envelopes.
OrthoTrac Practice Management Software I

E-mailing Letters
Instead of printing a letter, you can send the letter by e-mail, using 
Microsoft Outlook or Microsoft Outlook Express software.

To send a patient, responsible party, or doctor a letter by e-mail, 
you must first add that person’s e-mail address as a phone 
number of type EM (e-mail).

Printing Letters with E-mail Addresses

You have two options when sending letters by e-mail:

• Use Associated E-mail addresses—If the addressee has 
an e-mail address set up in the software, you can send 
the letter as e-mail by selecting Print Letters and Use 
Associated E-mail addresses. 

• E-Mail Letter(s)—If you have several letters to be e-mailed 
to the same e-mail address, select E-Mail Letter(s) and 
use the drop-down list to select an e-mail address.

To send letters as e-mail:

1 In the Post and Print Letters window, select the letter you 
want to print and click Print Letter. The Print Options window 
is displayed.

2 Select an option:

• Click Print Letter(s), select Use Associated E-mail 
addresses, and click OK. The Set E-Mail Message 
window is displayed.

Type the message you want to appear in the body of your 
e-mail and click OK. 

• To print all selected letters to a single e-mail address, 
select E-Mail Letter(s). Select the e-mail address from 
the list or add a new e-mail address and click OK. 
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ng and grammar using the Word spell-check 
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 Letter to add the text for the patient version 
dd Letter message window is displayed, 

ld like to copy the existing letter. Click Yes.

sted above, edit the copied text so that it 

intment, we added headgear to your 

ed you on wearing the headgear. It must 
um of 10-12 hours each day. 

uestions concerning this phase of your 
ee to call us.
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Skill Sharpeners

Exercise 1—Add a Letter

You want to create a letter reminding patients that headgear must 
be worn regularly, and you need both a patient version and a 
responsible party version. How do you create a customized letter 
for your practice?

To add a letter called Wear Headgear:

1 Click the Word Processing button on the main menu. The 
Word Processing menu is displayed. Select Letter Setup. 
The Letter Setup window is displayed.

2 Click Add Letter. The Add Letter window is displayed.

3 In the Letter Description field, type Wear Headgear.

4 In the Addressee field, select Standard, which uses both 
patient and responsible party letters. 

5 In the Salutation field, select Formal “Dear Mr./Ms. <<Last 
Name>>”. 

6 In the Signature field, select Doctor.

7 In the Envelopes section, select None.

8 Click Add Responsible to add the text for the responsible 
party version of the letter. The Add New Letter window is 
displayed and defaults to the template for the type of letter 
you are adding. 

9 Click OK. The Microsoft Word software opens, and the letter 
is displayed with the date, inside name, address, and 
salutation. 

10 Replace the highl
Merge Field and 
fields.

At <<PatientNam
added headgear

We have instruct
headgear and ha
must be worn a m
give <<PatientFi
needed at home
addition to the tr

If you have any q
<<her>> treatm

11 Check your spelli
program.

12 Click the Save an
Word. The softwa

13 Click Add Patient
of the letter. The A
asking if you wou

14 Using the steps li
reads as follows: 

At your last appo
appliance.

We have instruct
be worn a minim

If you have any q
treatment, feel fr
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Exercise 2—Post and Print a Letter

You want to send the headgear letter you created to a patient. 
How do you merge the patient information with the letter and print 
it?

To post and print a letter:

1 Open the chart for the patient to whom you want to send the 
letter.

2 Click the Word Processing button. The Word Processing 
menu is displayed. Select Post and Print Letters. The Post 
and Print Letters window is displayed

3 Select Wear Headgear from the list of available letters. Click 
Post Letter. The software updates the number in the Ready to 
Review column.

4 Click Print Letter. The Print Options window is displayed. 

5 Select an option and click OK.
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sson 20
sing Communications Questionnaires

is lesson includes:

• Changing Existing Questionnaires 

• Adding New Questionnaires 

• Executing Questionnaires 

e communications module enables you to create customized 
ters for patients, responsible parties, or referring doctors by 
sponding to detailed questionnaires for each patient. The 
mmunications module links the answers in a questionnaire to 
rrative phrases or paragraphs, which are inserted in your letters 
 text. 

hanging Existing Questionnaires

e communications module comes with three communications 
estionnaires: Initial Exam, Pre-Exam/Medical History, and 
ogress Review. You can use these questionnaires as they are, or 
u can modify them. 

 change an existing questionnaire:

Click the Word Processing button on the main menu. The 
Word Processing menu is displayed. 

Select Communications Setup. The Select Questionnaire 
window is displayed. 

3 Select the questionnaire type you wan
Change. The Setup Questionnaire w

The questions are displayed in the Sel
section. Any letters linked to this quest
in the Associated Letters section.

When you select a question, all of the 
that question are displayed in the Answ
the question type, whether the answer
letter text is available for that answer. 

For each answer option, you can enter
other text to print in the letters. An x in
and a checkmark indicates that letter t



uestions to Questionnaires

estion to the questionnaire:

stionnaire window, click Add under 
ons. The Select Questions window is 

the database display alphabetically by 
isplay a single category of questions by 

he Category drop-down list.

uestions section, select the question and 
w button. 
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In the Update Progress Review section, you can select from:

• Never update progress review date
• Always update progress review date
• Prompt to update progress review date

In the User Identification section, you can select Require 
user identification when executing to have the software 
prompt the user to select his name before executing the 
questionnaire.

4 Use the function buttons in the Setup Questionnaire window 
to:

• Change the order of questions.

• Add a new question or select a question from the existing 
database. 

• Insert a new question or select a question from the 
existing database.

• Change the selected question and answers.

• Delete a question.

Changing the Question Order on a Questionnaire

To change the order of the questions:

1 In the Setup Questionnaire window, select the question you 
want to move and click the Up or Down arrows.

2 Click OK.

Adding Existing Q

To add an existing qu

1 In the Setup Que
Selected Questi
displayed.

The questions in 
default. You can d
selecting it from t

2 In the Available Q
click the right arro

3 Click OK.

Note

Questions that you 
add are listed at the 
end of the 
questionnaire. To 
reposition a question, 
select the question 
and use the up arrow 
to move it. 
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Important

If you have 
associated letters 
attached to the 
questionnaire, you 
must update the 
letters with 
additional question 
and response 
fields.

Note

A green checkmark is 
displayed in the 
column if you entered 
patient, doctor, or 
other text. A red x is 
displayed if you have 
not entered text.
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Inserting Questions Within Questionnaires

To insert a question in the questionnaire:

1 In the Setup Questionnaire window, select the area on the 
list in which you want to insert the question and click Insert. 
The Communications Maintenance message is displayed. 

2 Click Yes. The Select Questions window is displayed. 

3 Select the question and click the right arrow button. 

4 Click OK. 

Adding Answers to Questions

To add an answer to a question:

1 In the Setup Questionnaire window, select the question for 
which you want to add an answer and click Change under 
Selected Questions. The Change Question window is 
displayed.

2 Click Add. A blank line is selected in the Answers section.

3 In the Answer Text column, type the answer.

4 If you need to quantify this answer, in t
click <No> (the default) to change the
Quantify Prompt window is displayed

5 In the Quantify Prompt window, enter
use as a prompt for this answer. Click 
Text window is displayed.

6 Type the information about the patient’
diagnosis in laymen’s terms for the pat
party. 

• If the text should include a quantifi
<<quantify>> where the amount 
example, overjet is <<quantify>> 

• You can include patient informatio
the merge field surrounded by << 
<<PatientFirstName>> in the let
patient’s first name print in the lett

• Repeat the steps for each answer

• Click OK. The Set Doctor Text wi

7 Type the information about the patient’
diagnosis in clinical terms for a referrin

• If the text should include a quantifi
<<quantify>> where the amount 

• You can include patient informatio
the merge field surrounded by << 

• Repeat the steps for each answer

• Click OK. The Set Other Text win



e answer text—Select the answer, retype the 
nd click OK.

it the letter text—In the Pat, Doc, or Oth 
k the x or the checkmark to display the 
g text box, type the new text, and click OK.

rom Questionnaires

rom the questionnaire:

stionnaire window, select the question you 
om the questionnaire and click Remove 
uestions. The Communications 
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uestionnaires

e:

rocessing button on the main menu. The 
 menu is displayed. 
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ed. 

he Add Questionnaire window is displayed.
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8 Add other text, if appropriate.

• If the text should include a quantified amount, type 
<<quantify>> where the amount should print. 

• You can include patient information in letter text by typing 
the merge field surrounded by << >>. 

• Repeat the steps for each answer to the question.

9 Click OK.

Changing or Deleting Answers to Questions

To change or delete an answer:

1 In the Setup Questionnaire window, select the question you 
want to change and click Change under Selected 
Questions. The Change Question window is displayed.

2 Use the function buttons to make the following changes:

• To reposition an answer—Select the answer you want to 
move, click the Up or Down arrows, and click OK.

• To add an answer—Click Add. See “Adding Answers to 
Questions” on page 167 for more information.

• To insert an answer—Select the area above where you 
want to insert the answer and click Insert. Type your 
answer and follow the steps under “Adding Answers to 
Questions” on page 167.

• To delete an answer—Select the answer you want to 
delete and click Remove. The Communications 
Maintenance message is displayed. Click Yes.

• To change th
answer text, a

• To add or ed
columns, clic
correspondin

Deleting Questions f

To delete a question f

1 In the Setup Que
want to remove fr
under Selected Q
Maintenance me

2 Click Yes.

Adding New Q

To add a questionnair

1 Click the Word P
Word Processing

2 Select Communi
window is display

3 Click Add New. T
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4 Select Add A New Questionnaire and click OK. The Setup 
Questionnaire window is displayed.

5 In the Questionnaire Title field, type a title. Press Tab or click 
Add or Insert. The Select Questions window is displayed.

6 In the Available Questions section, select the questions you 
want to add and click the right arrow button. Click OK.

7 Check the order of your questions in the Selected Questions 
list and reposition them, if necessary, by using the arrow 
buttons.

8 Click Print. Use this printout when you assign letters to this 
questionnaire. See “Assigning Letters to Questionnaires” on 
page 170 for more information.

Adding Headers to Questionnaire

To add headers:

1 In the Setup Questionnaire window, s
below the area in which you want to in
click Insert. The Communications Ma
displayed. 

2 Click Yes. The Select Questions wind

3 In the Category field, select Headers f
Select the header you want to insert an
button.

4 Click OK. 

Adding New Questions to Existing

You can customize an existing questionnai
your practice by adding your own question
question, you have several answer types fro
Following is a description of the available a

• Multiple Answer—Gives you sever
you to choose one or more answe

• Single Answer—Gives you severa
select only one answer. 

• Answer Prompt—Prompts you to e
answer.

• Tooth Chart—Enables you to answ
specific teeth by clicking on the co
the chart. 

• Narratives—Enables you to enter a
A narrative question can include u
narratives.



ers to Questionnaires

questionnaire:

stionnaire window, in the Associated 
lick Add. The Select Letter window is 

tion, select the letter you want to assign.

 section, indicate which letter text should 
Patient, Doctor, or Other.

t an existing letter. 

 a new letter. The Add Letter window is 
dding New Letters” on page 156 for more 

 letter, click the merge field buttons to insert 
e letter. Select the Response to 
utton to display the Communications 
esponses window, which lets you insert a 
s into the letter.

uestion # field, type the number of the first 
t to display in the letter. In the End with 
 type the number of the last question you 
 the letter. Click OK.

ders, type the header from your 
tout directly into the letter.
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• Header—Used only on the questionnaire to subdivide the 
questions into groups. 

• Procedure—Enables you to list the procedures performed 
during the appointment. When you click or press Tab in 
the question box, the Procedures window is displayed, 
enabling you to select from the list of procedures. 

• Patient Field—Supplies patient information and is 
automatically populated with information from the patient 
chart. If the information is incorrect or does not exist, you 
can type the answer in the questionnaire, and the 
information is updated in the patient chart. 

• Dated Narratives—Enables you to enter a narrative 
description, which the software dates.

To add a new question to an existing questionnaire:

1 In the Select Questions window, click Add. The Add 
Question window is displayed.

2 In the Question field, enter the question text.

3 In the Type field, select the question type from the drop-down 
list.

4 In the Category field, select the category type from the 
drop-down list. To add a new category, click the arrow button 
and select <Add Category> from the drop-down list.

5 Click OK.

Assigning Lett

To assign letters to a 

1 In the Setup Que
Letters section, c
displayed.

2 In the Letters sec

3 In the Letter Text
print in the letter—

4 Click OK to selec

OR

Click Add to add
displayed. See “A
information.

5 In the body of the
responses into th
Questionnaire b
Questionnaire R
block of response

In the Start with Q
question you wan
Question # field,
want to display in

6 To set up the hea
questionnaire prin

Tip

If you have added 
questions to a 
questionnaire or 
made changes to the 
order in which 
questions are 
displayed, verify that 
the merge fields in 
any letters assigned 
to the questionnaire 
are in the order that 
you want them to 
appear.
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Tip

To remove a response 
to a single-answer 
question, select it and 
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Executing Questionnaires

To execute a questionnaire:

1 Click the Word Processing button in the patient chart. The 
Word Processing menu is displayed.

2 Select Execute Questionnaire. The Execute Questionnaire 
window is displayed.

3 Select the questionnaire you want to execute and click 
Select. The questionnaire is displayed.

4 Each question type is displayed in a di
following options are available:

• Single Answer—Click on the answ
the arrow keys to select the answe
Tab to go to the next question. Afte
the software prompts you with the

• Answer Prompt—The type of answ
question is displayed to the right o
Press Enter to go to the next ques

• Tooth Chart—The tooth chart is dis
to click on the teeth that correspon
Click OK to go to the next questio

• Multi-Answer—Click the box next 
Enter to go to the next question.

• Narrative—Type the answer in the 
narrative has been set up with pre
on the answer at the top of the win
can edit the answer, or you can typ

• Header—To move to the section o
a particular header, click on the he
scrolls to that section of the quest

• Procedure—Click or press Tab in 
display the Procedures window. S
that were performed and click OK
display on the questionnaire on the
depending on the style you selecte
was created.
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• Patient Field—Automatically populated when the 
information exists in the patient chart. If the information 
does not exist or is incorrect, type the answer in the 
questionnaire, and the information is updated in the 
patient chart. 

• Dated Narratives—Type the answer in the window. When 
you save the answer, the software dates the narrative 
entry. If the narrative has been set up with predefined 
answers, you can click on the answer at the top of the 
window to display it. You can edit the answer. 

5 Click Print to print a questionnaire summary report for the 
patient. 

6 Click OK to complete the questionnaire. If letters are assigned 
to this questionnaire, the Assigned Letters window is 
displayed.

7 Click in the Action column next to each letter to select Post, 
Print, or None and click OK. 
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Skill Sharpener

Exercise 1—Add an answer to a questionnaire.

When using a questionnaire, you want to answer a question with 
an answer type that is not available. You want to add an answer 
with a quantifying prompt. How do you do this?

To add an answer to a question:

1 Click the Word Processing button on the main menu. The 
Word Processing menu is displayed. Select 
Communications Setup. The Select Questionnaire window 
is displayed.

2 Select the questionnaire type you want to change and click 
Change. The Setup Questionnaire window is displayed.

3 Select the question for which you want to add an answer and 
click Change. The Change Question window is displayed.

4 Click Add. A blank line is selected in the Answers section.

5 In the Answer Text column, type the answer.

6 In the Quantify column, click <No> (the default) to set the 
field to Yes. The Quantify Prompt window is displayed.

7 In the Quantify Prompt window, enter the text you want to 
use as a quantifying prompt for this answer. 

Click OK. The Set Patient Text window is displayed.

8 Type the information about the patient’s treatment or 
diagnosis for the patient or responsible party. 

• If the text should include a quantified amount, type 
<<quantify>> where the amount should print. For 
example, overjet is <<quantify>> mm. 

• You can include patient informatio
the merge field surrounded by << 
<<PatientFirstName>> in the let
patient’s first name print in the lett

• Repeat the above steps, when app
possible answer to the question.

When you are finished entering patient
Doctor Text window is displayed.

9 Type the information about the patient’
diagnosis in clinical terms for the referr
to whom you are referring the patient. 

• If the text should include a quantifi
<<quantify>> where the amount 

• You can include patient informatio
the merge field surrounded by << 

• Repeat the above steps, when app
possible answer to the question.

When you are finished entering doctor
Other Text window is displayed.

10 In the Set Other Text window, add oth

• If the text should include a quantifi
<<quantify>> where the amount 

• You can include patient informatio
the merge field surrounded by << 

• Repeat the above steps, when app
possible answer to the question.

11 Click OK.
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sson 21
sing the Checklist Function

is lesson includes: 

• Marking Tasks as Completed 

• Maintaining Checklists 

e the checklist function to view and maintain a list of 
ministrative tasks. You can perform many of the items in the 
ecklist window automatically, including the following:

After performing a task, mark the task as co
software records your name, the date, and t
task. 

You can also add your own tasks to the list
needs of your office and staff. 

To access the checklist function from the m
Checklist button. The Checklist window fo
displayed.

• Aged Receivable 
Reports

• Bulk Insurance 
Payments

• Collections System • Coupon Books

• Database Searches • Daysheet

• Word Processing 
Letters

• Ledger Scan Reports

• Miscellaneous 
Reports

• Patient Labels - New 
Patients

• Patient Tracking 
Reports

• Referral Reports

• Roll • Schedule Reports

• Statements • Timeclock

• Insurance Claim 
Processing

• Treatment Card 
History

• Schedule 
Maintenance - Add 
Days



ecklists

n of tasks in the list, to add a new task to the 
ting task, or to insert a task, use the function 
e of the Checklist window. The buttons 

er of Tasks

n of a task in the list:

indow, select the task description you want 
 the Up or Down arrows.

the List

indow, click Add New. The Add Checklist 
isplayed.

n for the new task in the first field.

ons for carrying out the task in the second 

nd to run to complete this task, if applicable. 
select a command from the list.
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The window displays the current day and date, a description of 
tasks to be completed, a calendar, instructions on how to 
complete the tasks, and function buttons. 

• To view additional tasks in the list, use the vertical scroll 
bar in the center of the window. To view the names of the 
staff members who completed the tasks and the dates 
the tasks were completed, use the horizontal scroll bar at 
the bottom.

• To view the checklist for a different day, click the day on 
the calendar. 

• To view the weekly or monthly checklist, select the 
corresponding option at the top of the window.

When you select a task, instructions on how to complete that task 
are displayed in the Instructions section of the Checklist window. 
For items that are set to run OrthoTrac functions, the message 
**Click RUN to perform this task.** is displayed.

Marking Tasks as Completed

To mark tasks as completed:

1 Select the description for the task in the Description section 
and click Done. 

When you select an uncompleted task that is set to run an 
OrthoTrac software function, the Run button is enabled. To 
complete the task and mark the task as completed, click Run.

2 Click Print to print the checklist. 

3 Click Close.

Maintaining Ch

To change the positio
list, to change an exis
buttons on the left sid
include:

• Up Arrow
• Down Arrow
• Add New
• Change
• Remove
• Insert

Changing the Ord

To change the positio

1 In the Checklist w
to move and click

2 Click OK.

Adding Tasks to 

To add a task:

1 In the Checklist w
Entry window is d

2 Type a descriptio

3 Type the instructi
field.

4 Enter the comma
Click Browse to 

5 Click OK.

Note

The Run button is not 
enabled if a task set to 
run a function is 
already marked as 
completed.

Tip

If you complete an 
item in error, select the 
item and click Undo.
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Note

To attach commands to 
checklist options using 
the Browse button, 
contact a Support 
representative.
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Changing Existing Tasks

To make a change to an existing task description or instructions:

1 In the Checklist window, select the task you want to change 
and click Change. The Change Checklist Entry window is 
displayed.

2 Make changes to the task description, instructions, or 
command fields. 

3 Click OK.

Removing Tasks from the List

To remove a task from the list:

1 In the Checklist window, select the task you want to remove 
and click Remove. A message is displayed.

2 Click Yes. The Remove Checklist Entry window is displayed.

3 Click OK.

Inserting Tasks in the List

To insert a new task in the list:

1 In the Checklist window, select the task on the list that you 
want to display after the new task and click Insert. The Insert 
Checklist Entry window is displayed.

2 Type a description for the new task in the first field.

3 Type the instructions for carrying out the task in the second 
field.

4 Enter the command to run to complete this task, if applicable. 
Click Browse to select a command from the list.

5 Click OK.
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Skill Sharpener

Exercise 1—Familiarize yourself with the Checklist feature.

To delete, add, and mark a task complete:

1 In the Checklist window, select Print Coupon Books for 
new contracts entered and click Remove. A message is 
displayed.

2 Click Yes. The Remove Checklist Entry window is displayed.

3 Click OK.

4 Click Add New. The Add Checklist Entry window is 
displayed.

5 In the first field, type Print Coupon Books for new contracts 
entered and click OK.

6 Select the task at the bottom of the list and click the up arrow 
to move the task up in the list.

7 To mark the task complete, click Done.

8 Click Close.
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ppendix A

igrating Your Software to OrthoTrac Software

u can migrate to OrthoTrac from any of the following software 
ckages.

• OrthoTrac Classic software

• OrthoSoft software

• OPMS software

• Orthoware software

is appendix contains information to help you familiarize yourself 
th the main functions of the OrthoTrac software and their 
ations. Several tables list important functions in the software 
m which you are migrating and their corresponding locations in 
 OrthoTrac software.

ain Menu Functions

ter you open the OrthoTrac software and log in, the main menu 
displayed.

Table 1 shows the main menu buttons that

Table 1 Main Menu Buttons 

Open Patient Chart

Schedule 
Appointment

Financial Functions

Word Processing

Contact Experts

Patient Flow

Maintenance/ 
Set-up



tabase Files—When prompted to exit the 
after making a change, select Copy 
e Files to update the information for that 
r.

ent—Enables you to configure a single 
on for multiple databases, set paths for 
nd select settings for several areas of the 

les you to select from a list of all patient 
tly open. Close All—Enables you to close all 

c Help—Accesses the online help.

ew Video–Enables you to view a video of 
res to the software.

orks Web Training–Accesses the online 
ebsite, which offers courses for the software.

Us–Accesses the Carestream Dental 
which provides ways for you to contact us.

or Updates—Enables you to obtain updates 
rthoTrac software.

esource Center—Accesses the Online 
 Center website, where you can search for 
opics involving the day-to-day use of your 

c on the Web—Accesses the OrthoTrac 
website.
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Selecting any of the options from the menu bar at the top of the 
screen displays a list of features. Some of these features are also 
available by using the function buttons. 

The following options are available:

• File

• Prepare Backup–Prepares the database files for 
backing up.

• Satellite Extraction

• Printer Setup—Enables you to select the default 
printer for your Windows operating system.

• Exit—Closes the OrthoTrac software.

• Functions—Enables you to access the same features 
available when using the main menu buttons.

• Reports—Enables you to access all of the reports available 
in the software in the following categories: Patient, 
Responsible Party, Schedule, Financial, Miscellaneous, 
Charting, Patient Tracking, Patient Flow.

• Options

• Copy Da
software 
Databas
compute

• Environm
workstati
folders, a
software.

• Charts—Enab
charts curren
open charts.

• Help

• OrthoTra

• What’s N
new featu

• MasterW
training w

• Contact 
website, 

• Check F
for the O

• Online R
Resource
specific t
software.

• OrthoTra
software 

Checklist Timeclock

Staff
Login

TeleVox T.LINK

Staff Mail Personal ToDo Items

Table 1 Main Menu Buttons  (Continued)
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le in the patient chart.

atient Information

Financial Functions

ord Processing

harting

atabase Fields

OrthoTrac Software
OrthoTrac Practice Management Software I

• System Requirements on the Web—Accesses the 
system requirements for the OrthoTrac software.

• Install Adobe Acrobat Reader—Installs the Adobe 
Acrobat Reader so you can read the online 
documentation.

• About OrthoTrac—Enables you to access your 
software version number and important system data.

Patient Chart Function Buttons

You can access the patient chart from several areas within the 
software: 

• After finding a patient using the OrthoTrac Software 
Patient Lookup window

• After adding a new patient

• From the Patient Flow module

• From the Charting module

Table 2 shows the functions that are availab

Table 2 Patient Chart Buttons 

Patient Checkout P

Schedule 
Appointment

Claims
 
W

Snapshot C

Patient Tracking D

Orthodontic Imaging

Patient Lookup



ting
ic Software

Accounting
OrthoTrac Software

Patient Checkout

R/ Open Patient Chart > Financial 
Functions

Open Patient Chart > Financial 
Functions

S Open Patient Chart > Financial 
Functions > Adjustments

CARD Open Patient Chart > Financial 
Functions > Ledger

ce
ic Software

Insurance
OrthoTrac Software

CE Maintenance/Set-up > Carrier 
Maintenance

Open Patient Chart > Claims

T Insurance Functions

LANCES Open Patient Chart > Financial 
Functions > Adjustments

DGER Open Patient Chart > Financial 
Functions > Ledger

eferrals
ic Software

Dr. File and Referrals
OrthoTrac Software

ANCE Maintenance/Set-up > Outside 
Doctor Information

ENANCE
Referral Tracking or 
Maintenance/Set-up > Other 
Referrals

rom OrthoTrac Classic Software to 
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Migrating from OrthoTrac Classic Software 
to OrthoTrac Software

Table 3 shows the codes for commonly used functions in 
OrthoTrac classic software and gives the corresponding paths for 
the equivalent functions in OrthoTrac software.

Table 3 Migrating from OrthoTrac Classic Software to 
OrthoTrac Software 

Patient Information
OrthoTrac Classic Software

Patient Information
OrthoTrac Software

01 NAME-NUMBER INQUIRY Open Patient Chart

02 ADD NEW PATIENT Quick Add or Open Patient Chart 
> Add New

03 SHOW/CHANGE PATIENT Open Patient Chart > Patient 
Information

04 PURGE PATIENT Open Patient Chart > Remove

05 DATABASE OPERATIONS Contact Experts

06 PATIENT FLOW Patient Flow

07 TREATMENT CARD Open Patient Chart > Charting

08 COMMUNICATIONS Open Patient Chart > Word 
Processing

Appointments
OrthoTrac Classic Software

Appointments
OrthoTrac Software

11 FIND PATIENT’S APPT Open Patient Chart > Appts

12 SCH/CHGE/CANCEL APPT Open Patient Chart > Schedule 
Appointment

14 DISPLAY SPECIFIC DAY Schedule Appointment

15 NEXT AVAILABLE APPT Schedule Appointment > Search

17 RECALLS
Open Patient Chart > Schedule 
Appointment > Sched Appt > 
Recall

Accoun
OrthoTrac Class

21 PATIENT LEAVING

22 POST CHGS/CONT
COMNT

23 POST PAYMENTS

24 ADJUST BALANCE

25 DISPLAY LEDGER 

Insuran
OrthoTrac Class

31 PLAN MAINTENAN

32 ENTER CLAIM

33 CLAIM MAINT/PRIN

34 ADJUST INSUR BA

35 DISPLAY INSUR LE

Dr. File and R
OrthoTrac Class

41 DOCTOR MAINTEN

42 REFERRAL MAINT

Table 3 Migrating f
OrthoTrac 
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d reports in OrthoTrac 
ng paths for the 

sic Software to 

atient Reports
thoTrac Software

 > Patient > Patient 

 > Patient > Patient 

 > Patient > Patient 

 > Miscellaneous > 
esponsible Party Xref

 > Miscellaneous > 
Labels

 > Patient > Patients By... 
e

 > Patient > Patient 
s

 > Patient > Patients 
 Comments

 > Patient > Patient 
al Profile

 > Patient > Chart Labels

 > Patient > Patient 
ion Form

ools > Envelopes and 

 > Patient > Missing 
ata
OrthoTrac Practice Management Software 

Table 4 shows the codes for commonly use
classic software and gives the correspondi
equivalent reports in OrthoTrac software.System Maintenance

OrthoTrac Classic Software
System Maintenance
OrthoTrac Software

50 PATIENT TRACKING

Reports > Patient Tracking
or
Open Patient Chart > Patient 
Tracking

51 PROCEDURE MAINTENANCE Maintenance/Set-up > Procedure 
Code Maintenance

52 SCHEDULE MAINTENANCE Maintenance/Set-up > Schedule 
Maintenance 

53 MONTHLY ROLL Reports > Financial > Roll > 
Roll Accounts

54 MESSAGE FILE Maintenance/Set-up > Ticket 
Message Maintenance

55 PRINT REPORTS See Table 4.

56 PRINT SCHEDULE See Table 5.

57 WORD PROCESSING Word Processing

58 ROLADDRESS Roladdress

59 CALENDAR/CLOCK/
MAILTRAC Timeclock

60 SYSTEM OPTIONS Not Applicable

Table 3 Migrating from OrthoTrac Classic Software to 
OrthoTrac Software  (Continued)

Table 4 Migrating from OrthoTrac Clas
OrthoTrac Software—Reports 

Patient Reports
OrthoTrac Classic Software

P
Or

01 NAME/ADDRESS Reports
Listing

02 ALPHA NAME/ADDRESS Reports
Listing

03 ALPHA CROSS-REFERENCE Reports
Listing

04 RESP PARTY CROSS 
REFERENCE

Reports
Patient/R

05 MAILING LABELS Reports
Mailing 

06 ZIP CODE ORDER Reports
> ZipCod

07 BIRTHDAYS THIS MONTH Reports
Birthday

08 PATIENTS WITH COMMENTS Reports
With... >

09 STATISTICAL PROFILE Reports
Statistic

10 NEW PATIENT LABELS Reports

19 PATIENT INFORMATION FORM Reports
Informat

27 LASER RETURN ADDRESS 
LABELS

Word > T
Labels

51 MISSING PATIENT INFO Reports
Patient D



eports
ic Software

Financial Reports
OrthoTrac Software

IT SLIP
Reports > Financial > Daysheet > 
View Daysheet or Process 
Daysheet

NT CARDS Reports > Financial > Coupon 
Books

ES Reports > Financial > Aged 
Receivables by...

Reports > Financial > Statements

NCES Reports > Financial > Suspicious 
Balances

Reports > Financial > Ledger 
Scan

Y Reports > Financial > Daysheet > 
MTD Daysheet Report

EET Not Applicable

rom OrthoTrac Classic Software to 
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Utilities Reports
OrthoTrac Classic Software

Utilities Reports
OrthoTrac Software

30 SET COMPRESSED PRINT Not Applicable

31 SET STANDARD PRINT Not Applicable

41 PURGE FILE MAINTENANCE Reports > Patient > Deleted 
Patients

42 FREE STANDING RECEIPT
Open Patient Chart > Financial 
Functions > Reports > Receipt > 
Payment Receipt

50 NEW PATIENT TRACKING Reports > Patient Tracking

Miscellaneous Reports
OrthoTrac Classic Software

Miscellaneous Reports
OrthoTrac Software

11 SELECTED BILLING TYPES Reports > Financial > Selected 
Billing Types

12 STATEMENTS OR INTEREST 
CODE 

Reports > Financial > Statement 
Code/Late Charge

13 PATIENTS BY STATUS Reports > Patient > Patients By... 
> Status

14 ALL PATIENTS OF ONE TYPE 
CODE

Reports > Patient > Patients By... 
> Type

15 PATIENTS IN SATELLITES Reports > Patient > Patients By... 
> Location

16 DELETION CANDIDATES Reports > Patient > Patient 
Completion Report

17 COMPLETION DATE Reports > Patient > Patient 
Completion Report

18 REVIEW CODE REPORT Contact Experts

Table 4 Migrating from OrthoTrac Classic Software to 
OrthoTrac Software—Reports  (Continued)

Financial R
OrthoTrac Class

21 DAYSHEET/DEPOS

22 CONTRACT PAYME

23 AGED RECEIVABL

24 STATEMENTS

26 SUSPICIOUS BALA

43 LEDGER REPORT

45 DEPOSIT SUMMAR

62 ARCHIVED DAYSH

Table 4 Migrating f
OrthoTrac 
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e Appointment > 
s

 > Patient > Patient 
s Review

licable

sic Software to 
g Reports 
OrthoTrac Practice Management Software 

Table 5 shows the codes for commonly used schedule reports in 
OrthoTrac classic software and gives the corresponding paths for 
the equivalent reports in OrthoTrac software.

Table 5 Migrating from OrthoTrac Classic Software to 
OrthoTrac Software—Scheduling Reports 

Scheduling Reports
OrthoTrac Classic Software

Scheduling Reports
OrthoTrac Software

01 NAMES FOR A DAY Reports > Schedule > Daily 
Schedule > Schedule Format

02 NUMBERS FOR A DAY Reports > Schedule > Daily 
Schedule > List Format

03 RANGE OF DAYS
Reports > Schedule > Daily 
Schedule > List Format or 
Schedule Format

04 NOSHOW REPORT Reports > Schedule > NoShow 
Report

05 COLLECTIONS REPORT Reports > Schedule > Daily 
Collections

06 NAMES AND PHONES Reports > Schedule > Daily 
Schedule > List Format

07 PROCEDURE REPORT Reports > Schedule > Future 
Procedures

08 BUCK SHEETS FOR A DAY Not Applicable

09 LABELS FOR A DAY Contact Experts

10 SCHEDULING EXCEPTIONS Contact Experts

15 SEARCH BLOCK REPORT Reports > Schedule > Available 
Appointments

16 APPOINTMENT STATISTICS Not Applicable

81 APPOINTMENT CARD Open Patient Chart > Reports > 
Ticket

82 SCHOOL/WORK EXCUSE Open Patient Chart > Reports > 
Ticket

83 FREESTANDING BIRTHDAY Not Applicable

84 SCHEDULE AT A GLANCE Schedul
Statistic

85 PROGRESS REVIEW SYSTEM Reports
Progres

86 COMPLETION DATE 
EXCEPTIONS Not App

Table 5 Migrating from OrthoTrac Clas
OrthoTrac Software—Schedulin
 (Continued)



 Desk
oftware

Diagnosis
OrthoTrac Software

Open Patient Chart > Word 
Processing > Execute 
Questionnaire

nt Plan Open Patient Chart > Charting > 
Edit Charting

esk
oftware

Financial
OrthoTrac Software

act
Open Patient Chart > Financial 
Functions > Contracts and 
Payment Plans

Open Patient Chart > Financial 
Functions

djustments Open Patient Chart > Financial 
Functions > Adjustments

t’s Ledger Open Patient Chart > Financial 
Functions > Ledger

 Desk
oftware

Insurance
OrthoTrac Software

im Forms Open Patient Chart > Claims

eatment Insurance Functions > 
Continuation of Treatment

iguration
oftware

Maintenance/Set-up
OrthoTrac Software

urs In Office Maintenance/Set-up > Schedule 
Maintenance

ed
Maintenance/Set-up > Procedure 
Code Maintenance
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Migrating from OrthoSoft to OrthoTrac 
Software

Table 6 shows the commonly used functions in OrthoSoft 
software and gives the corresponding paths for the equivalent 
functions in OrthoTrac software.

Table 6 Migrating from OrthoSoft Software to OrthoTrac 
Software

Appointment Desk
OrthoSoft Software

Appointments
OrthoTrac Software

Scheduling, Rescheduling, And 
Canceling Appointments

Open Patient Chart > Schedule 
Appointment

Viewing Days In The 
Appointment Desk Schedule Appointment

5 & 
9 Placing Patients In Recall

Open Patient Chart > Schedule 
Appointment > Sched Appt > 
Recall

Finding A Patient’s Appointment Open Patient Chart > Appts

F6 Adding A New Patient
Open Patient Chart > Add New
or
Quick Add

Correspondence Desk
OrthoSoft Software

Correspondence
OrthoTrac Software

Correspondence Editor Word Processing > Letter Setup

Print Letters Word Processing > Post and 
Print Letters

Diagnosis
OrthoSoft S

Diagnosis

Diagnosis/Treatme

Finance D
OrthoSoft S

F3 Setting Up A Contr

Posting Payments

Making Contract A

F8 Viewing The Patien

Insurance
OrthoSoft S

Insurance Desk Cla

Continuation Of Tr
Forms

System Conf
OrthoSoft S

System Config./Ho

System Config./
Procedures Perform

Table 6 Migrating f
Software (
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 > Schedule > Recall List

 > Schedule > Daily 
ns

inancial Reports
thoTrac Software

 > Financial > Aged 
bles by...

 > Financial > Ledger 

 > Financial > Statement 
te Charge

 > Financial > Contract 
y

 > Financial > Statements

ocessing > Post and 
tters

 > Financial > Coupon 

 > Financial > Daysheet > 
ysheet Report

ellaneous Reports
thoTrac Software

 > Miscellaneous > 
 and Associated Patients

 > Miscellaneous > 
isting

s

are to OrthoTrac 
)
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Table 7 shows the commonly used reports in OrthoSoft software 
and gives the corresponding paths for the equivalent reports in 
OrthoTrac software.

Master Chart
OrthoSoft Software

Patient Chart
OrthoTrac Software

Master Chart Open Patient Chart > Patient 
Information

Time Clock
OrthoSoft Software

Time Clock
OrthoTrac Software

Time Clock Timeclock

Table 7 Migrating from OrthoSoft Software to OrthoTrac 
Software—Reports

Appointment Reports
OrthoSoft Software

Appointment Reports
OrthoTrac Software

Appointments On Screen

Reports > Schedule > Daily 
Schedule > Schedule Format
or 
Click Print from inside a 
specific day on the calendar.

Daily Schedule Reports > Schedule > Daily 
Schedule > List Format

Future Appointment Totals Reports > Schedule > Future 
Procedures

List Of Patients W/o Appt Status
Reports > Patient > Patients 
Without... > Valid Appointments 
Or Recalls

No Show List Reports > Schedule > NoShow 
Report

Past Appointment Totals Reports > Miscellaneous > 
Procedures > Totals

Table 6 Migrating from OrthoSoft Software to OrthoTrac 
Software (Continued)

Recall List Reports

View Aging For Daily Schedule Reports
Collectio

Financial Reports
OrthoSoft Software

F
Or

Aging Report Reports
Receiva

Financial Transactions Reports
Scan

Historical Late Charges/Interest Reports
Code/La

Query Open Ended And Per Visit 
Fees

Reports
Summar

Statements Reports

Truth In Lending Word Pr
Print Le

Payment Book Reports
Books

Monthly Production Report Reports
MTD Da

Quick Search Reports
OrthoSoft Software

Misc
Or

Insurance Reports Reports
Carriers

Dentist Reports Reports
Doctor L

Referral Sources Reports Referral

Table 7 Migrating from OrthoSoft Softw
Software—Reports (Continued



 > Maintain 

Open Patient Chart > Patient 
Information > Comment
Open Patient Chart > Patient 
Information > Medical Alert
Open Patient Chart > Treatment 
Card > Medical Alert

ts
re

Appointments
OrthoTrac Software

 > View 
ecific Open Patient Chart > Appts

Open Patient Chart > Schedule 
Appointment

tion > 
ecall

Open Patient Chart > Schedule 
Appointment > Sched Appt > 
Recall

 > Search Schedule Appointment > Search

 > View Schedule Appointment > Week

ce
re

Correspondence
OrthoTrac Software

Word Processing > Letter Setup

Word Processing > Post and Print 
Letters

iagnosis 
re

Questionnaires and Diagnosis
OrthoTrac Software

nce
Open Patient Chart > Word 
Processing > Execute 
Questionnaire

tion > 
b

Open Patient Chart > Charting > 
Edit Charting
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Migrating from OPMS Software to 
OrthoTrac Software

Table 8 shows the commonly used functions in OPMS software 
and gives the corresponding paths for the equivalent functions in 
OrthoTrac software.

Time Clock and Staff Reports
OrthoSoft Software

Time Clock and Staff Reports
OrthoTrac Software

List Of Staff Members Reports > Miscellaneous > Staff 
Listing

Individual Time Clock Reports Timeclock > Reports

Labels
OrthoSoft Software

 Labels
OrthoTrac Software

Labels Reports > Miscellaneous > 
Mailing Labels

Table 8 Migrating from OPMS Software to OrthoTrac 
Software

Patient Information 
OPMS Software

Patient Information
OrthoTrac Software

Add A Patient
Open Patient Chart > Add New
or
Quick Add

Change Patient Information Open Patient Chart > Patient 
Information

Datamaster Contact Experts

Practice-Wide > Patients > Delete A 
Patient Open Patient Chart > Remove

Charting Module Open Patient Chart > Charting

Patient Flow Patient Flow

Table 7 Migrating from OrthoSoft Software to OrthoTrac 
Software—Reports (Continued)

Practice-Wide > Patients
Patient Flags

Appointmen
OPMS Softwa

Schedule Appointments
Appointments For A Sp
Patient

Schedule Appointments

Change Patient Informa
Appointments > Make R

Schedule Appointments
For A Reservation

Schedule Appointments
Week

Corresponden
OPMS Softwa

Word Processing

Word Processing

Questionnaires and D
OPMS Softwa

Advanced Corresponde

Change Patient Informa
Diagnosis/Treatment Ta

Table 8 Migrating f
Software (
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Insurance
oTrac Software

nt Chart > Claims

unctions > 
n of Treatment

unctions

aintenance
oTrac Software

e/Set-up > Schedule 
e

e/Set-up > Procedure 
enance

e/Set-up > Staff 
e
e/Set-up > System 
e > Locations

e/Set-up > Staff 
e

e/Set-up > System 
e > System Options

e/Set-up > Carrier 
e

e/Set-up > Employer 
e

e/Set-up > System 
e > Locations

e/Set-up > System 
e > Patient Status

e/Set-up > Schedule 
e

e/Set-up > System 
e > Patient Types

e/Set-up > System 
e > Patient Status

e/Set-up > System 
e

 to OrthoTrac 
OrthoTrac Practice Management Software 

Referral Information
OPMS Software

Referral Information
OrthoTrac Software

Practice-Wide > Referrals Maintenance/Set-up > Outside 
Doctor Information

Practice-Wide > Referral Types

Referral Tracking
or
Maintenance/Set-up > Other 
Referrals

Financial
OPMS Software

Financial
OrthoTrac Software

Change Patient Information > 
Contract Tab

Open Patient Chart > Financial 
Functions > Contracts and 
Payment Plans

Post Payments Open Patient Chart > Financial 
Functions

Post Charges Open Patient Chart > Financial 
Functions

Patient Ledgers > Make 
Adjustment

Open Patient Chart > Financial 
Functions > Adjustments

Change Patient Information > 
Contract Tab

Open Patient Chart > Financial 
Functions > Adjustments

Patient Ledgers Open Patient Chart > Financial 
Functions > Ledger

Scheduled Payments Open Patient Chart > Financial 
Functions > Auto Payments

Daily > End The Financial Day
Reports > Financial > Daysheet > 
View Daysheet or Process 
Daysheet

Monthly > End-of-month Reports > Financial > Roll > Roll 
Accounts

Daily > Collections Module Collections Activity

Table 8 Migrating from OPMS Software to OrthoTrac 
Software (Continued)

Insurance
OPMS Software Orth

Printing > Insurance Forms Open Patie

Printing > Insurance Forms Insurance F
Continuatio

Post Insurance Payments Insurance F

Maintenance
OPMS Software

M
Orth

Practice-Wide > Locations Maintenanc
Maintenanc

Practice-Wide > Procedures Maintenanc
Code Maint

Practice-Wide > Orthodontists
Maintenanc
Maintenanc
Maintenanc
Maintenanc

Practice-Wide Staff > Members Maintenanc
Maintenanc

Practice-Wide Late Charge Setup Maintenanc
Maintenanc

Practice-Wide > Carriers Maintenanc
Maintenanc

Practice-Wide > Employers Maintenanc
Maintenanc

Practice-Wide > Practice 
Information

Maintenanc
Maintenanc

Practice-Wide > Activity Codes Maintenanc
Maintenanc

Practice-Wide > Procedure Classes Maintenanc
Maintenanc

Practice-Wide > Diagnosis And 
Treatment Codes

Maintenanc
Maintenanc

Practice-Wide > Patient Milestones Maintenanc
Maintenanc

Miscellaneous > System Options Maintenanc
Maintenanc

Table 8 Migrating from OPMS Software
Software (Continued)



y Totals Reports > Financial > Daysheet > 
Process Daysheet

uction Reports > Financial > Roll > Roll 
Accounts

) Word Processing > Post and Print 
Letters

Reports > Financial > Coupon 
Books

 > Reports > Financial > Daysheet > 
MTD Daysheet Report

rksheet Reports > Financial > Balancing 
Worksheet

Reports > Financial > Statements > 
Individual Statement
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Table 9 shows the commonly used reports in OPMS software and 
gives the corresponding paths for the equivalent reports in 
OrthoTrac software.

Table 9 Migrating from OPMS Software to OrthoTrac 
Software—Reports

Appointment Reports
OPMS Software

Appointment Reports
OrthoTrac Software

Daily > Print Appointment 
Schedules

Reports > Schedule > Daily 
Schedule > Schedule Format
or 
Click Print from inside a specific 
day on the calendar.

Planned Procedures By Date Or By 
Procedure

Reports > Schedule > Future 
Procedures

Unresolved Appointments
Reports > Patient > Patients 
Without... > Valid Appointments Or 
Recalls

Dm-20 No-shows By Date Reports > Schedule > NoShow 
Report

Selected Procedure Frequency Reports > Miscellaneous > 
Procedures > Totals

Recall Listing Reports > Schedule > Recall List

Financial Reports
OPMS Software

Financial Reports
OrthoTrac Software

Demand Aged Receivables Report Reports > Financial > Aged 
Receivables by...

Demand Transaction Summary Reports > Financial > Ledger Scan

Late Charges Reports > Financial > Statement 
Code/Late Charge

Printing > Reports > Patients > 
Dm-08
Printing > Reports > Patients > 
Dm-21

Reports > Financial > Contract 
Summary

Monthly > End-of-month 
Statements Reports > Financial > Statements

Monthly > Demand Practice 
Statistics Report

Reports > Financial > Daysheet > 
Process Daysheet

Monthly > Demand Dail
Report

Monthly > Demand Prod
Report

Tl.doc (Truth In Lending

Printing > Coupons

Monthly > End-of-month
Production Report

Monthly > Balancing Wo

Superbill

Table 9 Migrating f
Software—
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nt Chart > Add New

nt Chart > Patient 

nt Chart > Remove

nt Chart > Comment 
t Charting

w

nt Chart > Patient 
 > Comment
nt Chart > Patient 
 > Medical Alert

nt Chart > Treatment 
ical Alert
nt Chart > Financial 
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oTrac Software

nt Chart > Schedule 
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nt > Recall
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nt > Search
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Migrating from Orthoware So
OrthoTrac Software

Table 10 shows the commonly used functio
software and gives the corresponding path
functions in OrthoTrac software.

Insurance Reports
OPMS Software

Insurance Reports
OrthoTrac Software

Printing > Reports > Insurance Tab Reports > Miscellaneous > Carriers 
and Associated Patients

Referral Reports
OPMS Software

Referral Reports
OrthoTrac Software

Printing > Reports > Referrals Tab Reports > Miscellaneous > Doctor 
Listing

Printing > Reports > Referrals Tab Referrals

 Labels
OPMS Software

 Labels
OrthoTrac Software

Printing > Labels Reports > Miscellaneous > Mailing 
Labels

Task Organizer
OPMS Software

Task Organizer
OrthoTrac Software

Practice-Wide > Reminders Personal ToDo Items

Table 9 Migrating from OPMS Software to OrthoTrac 
Software—Reports (Continued)

Table 10 Migrating from Orthoware Soft
Software

Patient Information 
Orthoware Software

Pati
Orth

Add Patient, Lightning Quick, Add 
New, or Quick Add

Open Patie
or
Quick Add

Change Patient Information Open Patie
Information

Delete Patient Open Patie

Charting Open Patie
only or Edi

On deck Patient Flo

Notes, Financials, and Alerts

Open Patie
Information
Open Patie
Information
Open Patie
Card > Med
Open Patie
Functions 
Collections

Appointments
Orthoware Software

A
Orth

Schedule Appointments > View 
Appointments for a Specific 
Patient > Open Patient Chart

Open Patie
Appointme

Schedule Recall Open Patie
Appointme

Schedule Appointments > 
Appointment Search

Open Patie
Appointme



Open Patient Chart > Financial 
Functions >Contract and Payment 
Plans > Reports > Contract and 
Payment Plan > Coupons

Financial Functions

Open Patient Chart > Financial 
Functions > Ledger

Open Patient Chart > Financial 
Functions > Auto Payments

Reports > Financial > Daysheet > 
View Daysheet or Process 
Daysheet

nts Open Patient Chart > Financial 
Functions > Adjustments

Open Patient Chart > Financial 
Functions > Reports > Statement > 
Statement for Today

Reports > Financial > Roll > Roll 
Accounts

Reports > Financial > Roll > Include 
Late Charge

Reports > Financial > Generate 
Statements > Print/View 
Statements

ware
Insurance

OrthoTrac Software

Open Patient Chart > Claims > 
Create Claim

Insurance Functions > Claim 
Processing > Print all Un-printed 
Claims

Insurance Functions > 
Continuation of Treatment > 
Confirm All Printed Claims > 
Generate Claims > Print All 
Unprinted Claims

rance Claims > Post Bulk Insurance 
Payment

rom Orthoware Software to OrthoTrac 
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Schedule Appointments > View 
Week

Open Patient Chart > Schedule 
Appointment > Week

Correspondence
Orthoware Software

Correspondence
OrthoTrac Software

Create or Edit Letters > Letter 
Setup Word Processing > Letter Setup

Request a Letter Word Processing > Post and Print 
Letters

Quictation and Diagnosis 
Orthoware Software

Questionnaires and Diagnosis
OrthoTrac Software

Quictation
Open Patient Chart > Word 
Processing > Execute 
Questionnaire

Diagnosis Open Patient Chart > Charting > 
Edit Charting

Referral Information
Orthoware Software

Referral Information
OrthoTrac Software

Add Professionals Maintenance/Set-up > Outside 
Doctor Information

Track Referrals > Printing > 
Reports > Tracking Referrals Referrals

Financial
Orthoware Software

Financial
OrthoTrac Software

Piggy Bank > Payment Entry
Open Patient Chart > Financial 
Functions > Charges and Payment 
> Post Payments

Piggy Bank > Treatment Entry
Open Patient Chart > Financial 
Functions > Charges and Payment 
> Post Charge

Set Up Budget > Piggy Bank > Set 
Up Budget

Open Patient Chart > Financial 
Functions > Contract and Payment 
Plan

Table 10 Migrating from Orthoware Software to OrthoTrac 
Software (Continued)

Coupons

Q-Pay

Patient Ledgers

Auto Payment

Daysheet

Piggy Bank > Adjustme

Walk-Away Statements

Assess and Age

Apply Late Charges

Monthly Statements

Insurance
Orthoware Soft

Insurance Forms

Print Claims

Print COT Forms

Piggy Bank > Post Insu
Payments

Table 10 Migrating f
Software (
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chedule > Recall 
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inancial > Quick View or 
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Table 11 shows the commonly used report
software and gives the corresponding path
reports in OrthoTrac software.Maintenance

Orthoware Software
Maintenance

OrthoTrac Software

Default Setup Maintenance/Set-up

Program Essentials > Doctors and 
Staff

Maintenance/Set-up > Staff 
Maintenance

Program Essentials > Offices Maintenance/Set-up > System 
Maintenance > Locations

Program Essentials > Access 
Control Maintenance/Set-up > Security

Program Essentials > Lookup Maintenance/Set-up > System 
Maintenance 

Program Essentials > Custom 
Fields

Maintenance/Set-up > Additional 
Database

Program Essentials > Professional Maintenance/Set-up > Outside 
Doctors

Program Essentials > Treatment 
Groups

Maintenance/Set-up > System 
Maintenance > Patient Status

Program Essentials > Treatment 
Procedures

Maintenance/Set-up > Procedure 
Codes

Program Essentials > Quictation Word Processing > 
Communication Setup

Contacts > Insurance Company
Maintenance/Set-up > Carrier 
Maintenance > Add Carrier or Edit 
Carrier

Default Setup > Financial Tab Maintenance/Set-up > System 
Options

Default Setup > Schedule Tab Maintenance/Set-up > Schedule

Add on > SAM Setup > Perfect Day
Maintenance/Set-up > Schedule 
Maintenance > Add or Change 
Standards

Add on > SAM > Create > Quick 
Calendar Setup

Maintenance/Set-up >Schedule 
Maintenance > Add Days

Add on > SAM > Add/Remove Days Maintenance/Set-up > Schedule 
Maintenance > Remove Days

Table 10 Migrating from Orthoware Software to OrthoTrac 
Software (Continued)

Table 11 Migrating from Orthoware Soft
Software—Reports

Appointment Reports
Orthoware Software

Appo
Orth

Printing > Appointment > 
Appointment Page

Reports > S
Schedule >
Schedule A
Day > Print

Printing > Appointment > 
Appointment List

Reports > S
> List Form

Printing > Appointment > 
Appointment List w/Financials

Reports > S
Collection

Printing > Appointment > Recall 
List

Reports > S
List/Recall 

Printing > Appointment > Needs 
Appointment List

Reports > S
Open Reca

Printing > Appointment > Perfect 
Days

Maintenanc
Maintenanc
Print

Printing > Appointment > Time 
Management Report Reports > P

Financial Reports
Orthoware Software

Fin
Orth

Printing > Financial > Daysheet Reports > F
Process Da

Printing > Financial >Aging Report
Reports > F
Receivable
> Insurance

Printing > Financial > Auto 
Payment Report

Reports > F
Payment Li

Printing > Financial > Monthly 
Journal

Reports > F
MTD Repor

Printing > Financial >Monthly 
Production

Reports > F
Monitor Pa



orts
ware

Insurance Reports
OrthoTrac Software

OT List Insurance Functions > Claim 
Reports > COT List

surance Reports > Financial > Accounts 
Receivable > By Insurance

rts
ware

Referral Reports
OrthoTrac Software

Referrals > Reports

ysis
Referrals > Date Range or 
Miscellaneous > Marketing 
Analysis

rds
ware

 Labels
OrthoTrac Software

ent Labels Reports > Miscellaneous > Mailing 
Labels 

ards > Reports > Schedule > Recall 
Labels/Recall Cards

er
ware

Task Organizer
OrthoTrac Software

Personal ToDo Items or Checklist
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Printing > Financial > Insurance 
Not Paid

Reports > Accounts Receivable > 
Daysheet > Insurance Only

Printing > Credit Card 
Reconciliation

Reports > Financial > Ledger Scan 
> Credit Card

Patient Chart > Walkaway 
Statement

Reports > Financial > Statements > 
Individual Statement or Open 
Patient Chart > Financial Functions 
> Reports > Statement > Statement 
for Today

Printing > Financial > Financial 
History

Reports > Financial > Daysheet > 
Financial Analysis

Payment Coupons

Reports > Financial > Coupon 
Books or Open Patient Chart > 
Financial Functions > Contracts 
and Payment Plans > Reports > 
Contracts and Payment Plans > 
Coupons

Table 11 Migrating from Orthoware Software to OrthoTrac 
Software—Reports (Continued)

Insurance Rep
Orthoware Soft

Printing > Financial > C

Printing > Financial > In
Not Paid

Referral Repo
Orthoware Soft

Printing > Referral List

Printing > Referral Anal

 Labels and Ca
Orthoware Soft

Printing > Labels > Pati

Printing > Labels and C
Recall

Task Organiz
Orthoware Soft

Message Board
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dex

count information 60
ding an employer 10
ding days to the schedule 15
justments

balances 63
charge 63
discount 70
payment 64, 70
returned check, charge for 64
transactions 63
transfers 63
types 62

swers
adding to a questionnaire 167
editing a questionnaire 168

pointment Details window, understanding 56
pointment Summary window, understanding 57
pointments

canceling 38
confirming 57
quick add 25
rescheduling 41
scheduling for another patient 56
scheduling from the patient chart 48
searching for 48
summary 57
summary window 57
transferring information from a missed appointment 40
transferring information from a treatment card 40
transferring information from a treatment plan 41
verifying from the main menu 6

hived daysheets
report 79
viewing 79

auto payments
adding a payment 97
editing 96
inserting a payment 97
removing 97
setting up 95

B
bands, adding 104
brackets, adding 104
bulk payment checks 69, 138

C
calendar

Schedule Appt 51
view mode 53
week 52

calendar days, adding 15
cards, recall 45
carriers

adding 7
setting up coverage 9

Cassidy 2, 3
charges

adjustments 63
posting 61
posting outside of checkout

Charges and Payments window
posting charges 61
posting charges and payme
posting mailed-in checks 68
posting payments 62
splitting a charge amount 61
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arting module
checkout procedures 75
patient checkout with active treatment plan 107
Questionnaire tab 105
ToothChart tab 103
treatment card 99
TxCard tab 99
TxPlan tab 106

arting/Patient Flow window
adding a patient 116
changing patient location 115
understanding 113

ecklist
adding a task 176
changing a task 177
description 175
inserting a task 177
marking tasks completed 176
order of tasks 176
removing a task 177

eckout
active treatment plan, with 107
cut and paste scheduling 75
family 73
from the charting module 75
posting procedures and payments 71
printing tickets, excuses, or labels 72
procedure code prompts 72
procedures 71
scheduling next appointment or recall 72
using the charting module 75

eque 61, 95, 96
ims

adding information 8
checking for missing information 138
continuation of treatment 134
creating manually 133
posting bulk payments 69, 138
printing individual 137
printing labels 136

printing paper claims 136
processing continuation of treatm
working with 133

closing software 1
collections module

adding a promise 128
applying payments to promises 1
changing and removing promise
reports 129
selecting accounts 127

comments, adding 9
communications module. See questi
contact experts

communications questions 148
creating 147
database fields 154
linking with office expert 152
Patient fields 147
Responsible Party fields 148
search results 148
using to find incorrect data 153
using to find missing information
using with database fields inform

continuation of treatment claims 134
contracts

setting up 83
setting up with insurance or mult
split 91
with insurance or multiple respon
with varying monthly charge amo

conversion, data ix
cut and paste scheduling 40, 75

D
Daily Schedule, printing 47
database fields

contact experts 154
quick add 23



nitial Training Workbook (OR250-15) Index–197

38
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Daysheet
archived 79
multi-month 79
printing and closing 78
processing 77
reports 77
viewing 79

discounts, applying 86
doctors, adding outside 11
document storage 155
documents

scanning 142
storage 141

down payments 87

E
elastics, adding 103
electronic data conversion ix
employers, adding 10
envelopes, printing 160
errors

after generating statements 125
finding incorrect data 153
finding missing information 153
patient information 24
roll exceptions 121

excuses, printing 72

F
families, adding 22
family checkout 73
family tree button, using 24
Financial Estimator

setting up 10
using 86

financial functions windows
Adjustments window 62
function buttons 59
menu bar 59
viewing the ledger 65
viewing totals 64

Financial Roll, running the 119
Future Procedures report 46

H
HIPAA comments, tracking 142

I
Imaging tab 106
individual claims 137
insurance

adding carriers 7
claim reports 138
posting bulk payments 69, 1

L
labels, printing 4, 44, 72
Ledger Scan report 80
ledger, viewing 65
letters

adding 156, 162
addressee types 156
assigning 157
changing 157
confirming printed 160
merge fields 157, 162
posting 158, 163
printing envelopes 160
printing posted 163
salutation types 156
setting up 155

light bar, menu 116
location, changing patient 115
lookup window 3

M
main menu

function buttons 1
menu bar 1

medical alerts 22
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des
view 53
week 52
zoom 54

nth-to-Date reports, printing 80
lti-Month Daysheet 79

Show report 43
tes tab 105
tes, shortcuts 106

ice 49
ice expert

linking with contact experts 152
notifications 150
using 150

ening software 1
her referral sources, adding 11
tside doctors, adding 11

tient chart
accessing 4
function buttons 5

tient checkout
active treatment plan 107
family checkout 73
posting procedures and payments 71
printing tickets, excuses, or labels 72
procedure code prompts 72
scheduling next appointment or recall 72
using the charting module 75

tient flow
module 113
setting options 12

tient Insight panel 100

patient tracking
adding comments 142
additional functions 141
display options 143
editing entries 141
feature 141
printing history 142
reports 143
scanning a document 142

patients
adding 21, 116
adding a relative 31
adding families 22
adding responsible party informa
adding with quick add 25
changing location 115
checking out 71
finding last viewed 6
history 146
interests 23
printing tracking reports 143
ranking responsible parties 29
referral information 32
tracking 141

payment receipt, printing 76
payments

adjustments 64, 70
automatic 95
bulk insurance check 69, 138
posting 62, 68, 69, 138
posting mailed-in 68
posting outside of checkout 68
printing receipts 76
returned check adjustment 64

posting bulk payments 138
printing

cards 45
claims 136
envelopes 160
labels 4
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payment receipts 76
restarting after a jam 46
schedule in two formats 47

procedure codes
in Appointment Summary window 57
prompts 72

processing claims 136
promises

adding 128
applying payments 130
editing 129

Q
Questionnaire tab 105
questionnaires

adding 168
adding a new question 169
adding an answer 167, 173
adding an existing question 166
adding headers 169
assigning letters 170
changing 165
changing answers 168
changing the order of questions 166
deleting answers 168
deleting questions 168
executing 171
inserting questions 167
question types 171

quick add 25
Quick View Daysheet report 79

R
recalls

creating a card message 45
printing a list 44
printing cards 45
printing labels 44
printing reports 44
restarting recall card printing after jam 46
scheduling 41

receipts, printing 76
records, methods of accessing 3
referral sources, adding 17
referrals

adding 11, 17
patient information 32
source of 22

relatives
adding 31
editing 32

reports
Archived Daysheets 79
collections activities 129
customizing 147, 150
Daily Schedule 47
Daysheet 77
financial 77
Future Procedures 46
insurance claim 138
Ledger Scan 80
Month-To-Date 80
Multi-Month Daysheet 79
NoShow 43
patient tracking 143
printing 111
Quick View Daysheet 79
Recall Cards 45
Recall Labels 44
Roll 119
statements 121
Trial Balance 79

responsible parties
adding 24, 29
editing 32, 34
linking relatives 30, 31
ranking 29

roladdress, adding a vendor 6
Roll, running the Financial 119
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lutations 31
hedule

view 53
zoom 54

hedule Appointment calendar 51
hedule maintenance, adding calendar days 15
hedule views

understanding 52
view mode 53

hedules
printing as list 47
printing schedule 47

heduling module
Appointment Details window 56
Appointment Summary window 57

heduling patient appointments
cut and paste method 40
sibling appointments 38

heduling reports
Daily Schedule 47
Future Procedures 46
NoShow 42
recall cards 45
recall labels 44
recall list 44

ortcuts for notes 106
lings, scheduling 38
ftware, opening and closing 1
lit contracts, setting up 91
tements
correcting errors 125
generating 121, 125
printing 124
viewing 124
working with generated 124

rage, documents 141

T
tasks, in checklist 176
tickets, printing appointment 72
time line 108
ToothChart tab

bands and brackets 104
changing tooth display 103
combo boxes 103
elastics 103
tooth display 103
tooth numbering 103

totals, viewing 64
tracking patients 141
treatment card

searching history by date 110
searching history by procedure 1
transferring information from 40
understanding 99

treatment plans
activation/deactivation 109
adding 106
checking out a patient with activ
editing 109
marking step as completed 109
printing 110
time line 108
updating status 110
viewing steps 108

Trial Balance report, printing 79
TxCard tab

editing entries 102
Events field 101
Next Appointment section 102

TxPlan tab 106
adding a treatment plan 106, 11
completing a treatment plan 110
printing a treatment plan 110
scheduling future treatment plan
time line 108
working with 108
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V
vendors, adding to roladdress 6
views

view 53
week 52
zoom 54

virtual agent 2, 3

W
week view 52
word processing module

adding a letter 156, 162
addressee types in letters 156
assigning letters 157
changing letters 157
confirming printed letters 160
merge fields in letters 157, 162
posting letters 158, 163
printing envelopes 160
printing posted letters 163
salutation types in letters 156
setting up letters 155

Z
zoom view 54
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